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Welcome to

There’s no better way to express your creativity than through 
fantasy art. If you’re tired of airbrushing, retouching, or being bound 
by reality, it can be great to let your imagination run wild, and in this 

book we will show you some of the best tips and techniques to help you take 
your art to the next level. Whether you use Photoshop, Painter, ZBrush, MAYA 
or any other number of creative programs, we have something for you within 

these pages. From designing a steampunk-inspired portrait and creating 
fantastical animals to painting matte landscapes and building fantasy 
architecture, you’ll discover plenty of inspiration to help you with your 

projects. We begin the book with essential fantasy art tips from industry 
professionals, and include expert advice throughout every tutorial across key 
fantasy genres. So put your creative hat on and delve into the magical world 

of fantasy art.

®





®

Imagine Publishing Ltd
Richmond House
33 Richmond Hill

Bournemouth
Dorset BH2 6EZ

 +44 (0) 1202 586200
Website: www.imagine-publishing.co.uk

Publishing Director
Aaron Asadi

Head of Design
Ross Andrews

Production Editor
Hannah Kelly

Senior Art Editor
Greg Whitaker

Designer
Katie Mapes

Photographer
James Sheppard 

Printed by
William Gibbons, 26 Planetary Road, Willenhall, West Midlands, WV13 3XT 

Distributed in the UK, Eire & the Rest of the World by  
Marketforce, Blue Fin Building, 110 Southwark Street, London, SE1 0SU

Tel 0203 148 3300 
www.marketforce.co.uk

 
Distributed in Australia by: 

Network Services (a division of Bauer Media Group), Level 21 Civic Tower, 66-68 Goulburn Street, 
Sydney, New South Wales 2000, Australia 

Tel +61 2 8667 5288

Disclaimer
The publisher cannot accept responsibility for any unsolicited material lost or damaged in the 

post. All text and layout is the copyright of Imagine Publishing Ltd. Nothing in this bookazine may 
be reproduced in whole or part without the written permission of the publisher. All copyrights are 

recognised and used specifically for the purpose of criticism and review. Although the bookazine has 
endeavoured to ensure all information is correct at time of print, prices and availability may change. 

This bookazine is fully independent and not affiliated in any way with the companies mentioned herein. 

Fantasy Art Genius Guide Volume 2 © 2014 Imagine Publishing Ltd

ISBN 978-1910155356

bookazine series

Part of the 



6  Fantasy Art Genius Guide

18 Create a magical witch
24  Norse character design
30 Paint a vampire pin-up
36  Paint a steampunk-inspired 

portrait
40 Create an ice queen heroine
46  Sculpt fabrics for fantasy 

characters
52  Paint a colourful comicbook 

character
58 Design a Weta character
64 Design a magical character

70  Master the art of creature 
creation

78 Design & model sci-fi  creatures
84 Design a 3D alien
90 Develop fantastical animals
98  Master expert creature renders 

using mental ray

Creatures

Character

Contents

22 fantasy 
art tips & 

tricks

8

46 90
84



Fantasy Art Genius Guide  7

Fantasy Art

108 Paint a colourful terrain
112 Paint a fantasy snowscape
118  Compose a magical 

mountainscape
124 Create space art

152 Build fantasy architecture
158  Concept art for a heroine 

character
164 Create dramatic lighting effects

170  Sci-fi  concept art
176 Build videogame concept art
182 Build matte paintings
188 Design robot mechs

Concept

Landscapes
130  Create a fantasy matte desert 

landscape painting
138  Sculpt an epic sci-fi  terrain
144  Create fantasy landscapes from 

photos in Photoshop

Genius Guide
Fantasy Art

188

112

182



22
FANTASY
TIPS & TRICKS
WE GUIDE YOU FROM CONCEPTION 

TO COMPLETION WITH 22 TOP TIPS 

FROM FANTASY ART EXPERTS

© Jack Zhang

8  Fantasy Art Genius Guide



Genius Guide
Fantasy Art

Genius Guide
Fantasy Art

Jack Zhang
http://jackzhang.deviantart.com

This artwork was created as part of an 
online challenge. The brief was to make 
a steampunk character, so I combined 
two legendary characters from two 
different cultures: King Kong and the 
Monkey King. 

Software To make this legendary 
character I used Softimage XSI and 
Photoshop. Working on it in daily four-
hour shifts, it took me around a month to 
fi nally complete.

Juxtaposition This piece is 
all about contrast, so it was my aim 
to attract the viewer’s attention to the 
factors that clashed in the image: big 
versus small, west versus east, brute 
strength versus intelligence, and hot 
versus cold in the form of the cold metal 
body of King Kong contrasting against 
his fl aming eyes and mouth.

Composition The composition 
of the image is quite simple; it features 
a big main character that fi lls up most 
of the space and a small supportive 
character in the foreground. Both are set 
against a forest backdrop. The centre 
of the image, which grabs your initial 
attention, is the fl aming eyes and mouth 
of King Kong.

References Most people will 
know who King Kong is, but the Monkey 
King is the iconic character from the 
upcoming Hong Kong and Chinese fi lm 
of the same name, which tells the story 
of how the eponymous character rebels 
against the Jade Emperor of heaven. 
The struggle and rebellious natures of 
these two subjects is something I’ve 
tried to re-create in this image.  

Colour combinations Colour 
was very important in creating a sense of 
impact, so I decided to give the smaller 
character a bit of gold and red to make 
him contrast with King Kong’s bigger, 
cooler and blue-tinted body.

Imagination I engineered the 
aggressive pose of Kong to give the 
impression that something was about 
to happen, especially when contrasted 
against the defensive pose of the 
smaller subject. This allows the viewer to 
use their imagination to determine what 
will happen next.

1. Contrast & Colour
Alex Kintner
www.alexkintner.com

I fi nd that the most important thing 
to have when you’re starting an 
image is a reason to be excited 
by it. There’s nothing worse than 
creating a painting that you don’t 
care about, or that you suddenly 
lose steam with halfway through 
because it lacks the challenge or 
interest that you hoped it would 
have. One of the ways I avoid 
this is by sketching constantly. 
Clichéd, I know, but people say it 
for a reason. Sketching is the best 
way for visual people to dump 
ideas out of their head and into 
the real world. So, when I was 
prompted to create a monstrosity 
that was 100 storeys tall, and 
impossibly diffi cult to defeat, I 
eventually arrived at the idea of 
tidal fl ooding and how dangerous rushing water can be in an urban setting. Then I kept revising the design to 
express the idea that another civilisation shared the same fear, and that they were somehow able to harness and 
restrain the water spirit that fl ooded their cities. However, the catch had to be that once it was no longer shapeless 
and free, it actually turned into something far worse. By this point, I was really jazzed about the design I had on 
paper and, because I was so excited to begin with, the whole process from then on went nice and smoothly.

2. Get Excited

Billy Christian
http://billcreative.deviantart.com

I believe that every fantasy artist has their own style of dragons, so I painted a personal piece about an aquatic 
dragon chasing dragon-riders. The fi rst thing I did was make a few paper sketches to work out the strongest 
composition. Once I had established the design I painted my illustration in Photoshop using a graphics tablet. 
Even though I use tools like layers and blend modes, the process is the same as in most traditional paintings; I 
paint from darker to lighter colours using round and chalk brushes, which help to make it look more realistic. 
The hardest part of any digital artwork is the texture, and here I found the textures of the waves and the dragons’ 
scales particularly tough to make. My advice for those in a similar position is this: don’t be afraid of using 
references. Referencing is a good way for you to achieve a realistic-looking and believable painting. You can 
study and mimic how waves react and what scales look like, and then apply this to your artwork. Try not to 
over-texture your piece, as it will make your painting look fl at and you’ll lose points of interest. You can also create 
texture by using colour and light to separate your focal points from the background; in my painting, the waves are 
less saturated and I have painted rim lights around the dragons’ and riders’ bodies to create depth.

3. Create realistic-looking textures

© Alex Kintner

© Billy Christian
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Alex Ruiz
http://conceptmonster.net

I made ‘Procession’ entirely in Photoshop CS3, using custom 

brushes and matte techniques such as painting over the top of 

the photography.

4. Build a fantasy landscape Irene Zeleskou
www.zeleskou.com

Aurora, goddess of the morning, is usually depicted as a golden, beautiful female with wings, 
and was a great subject to experiment with as there are lots of curves in her pose, body 
and wings to play with. Curves are the basic and most prominent feature of female beauty, 
and suggestively create familiarity and comfort. Moreover, curves are very easy on the eye, 
interesting for the viewer to follow, and associated with nature because of their organic feel. The 
Golden Spiral is a fantastic composition guide because it embraces and follows this theory, so it 
was natural that I should use it to compose this image of Aurora. The stars of the fading night sky 
seen in the top-left corner slowly introduce interest in the spiral, which gradually curves around 
to the main area of interest – Aurora – and, later still, the main point of focus: her arm and neck.

5. Composition: Work with curves

Sabine Rich
http://sabinerich.deviantart.com

The character in this 
fantasy art creation 
was designed to be 
some type of warrior 
pixie. When I began the 
process of creating it, 
I decided I wanted to 
give it a natural feel; very 
earthy and somewhat 
tribal. As for how I created 
this image: I fi rst drew a 
sketch on paper, then I 
scanned it in and put it 
on the computer, where 
I worked out all the lines 
and got the design, size 
and everything else right. 
After that I shaded the 
whole picture in black and 
white, then added colours 
on separate layers set to 
the Color blend mode – 
this turns your black and 
white shades into colours. 
This is kind of nice, 
especially when you want to change around any of the colour combinations, and it also helps 
you to get your values and lighting sorted without having to commit to your fi nal colours. 

6. Colour considerations

Create the background Using custom brushes, I 
chaotically threw down a lot of abstract shapes in a sepia tone, 
then I placed a dominant shape in the right third of the image 
using both basic and custom brushes. I introduced a weakly 
saturated green to red/orange colour gradient for a moody-
looking scene.

Add details and texture Sketching freely, I 
added some secondary areas of interest to the background 
and indicated ‘people’ with blobs of dark paint. A rule of 
environment design is to use lighter things at the back and 
the darkest ones in front. The textures were Lassoed out from 
photographs of trains and machinery.

Finish with fi gures Flags imply civilisation without 
you having to detail the crowd, while large creatures push the 
fantasy element. The fi reworks are from photos, their layers set 
to Screen to remove backgrounds. The fl ying ships, confetti 
and fl ags add movement to the piece, and a Gaussian Blur on 
foreground characters adds focus.

FINAL IMAGE

© Alex Ruiz

© Irene Zeleskou

© Sabine Rich
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Edli Akolli
http://edli.deviantart.com

Peter Oedekoven
www.oedekoven-illustration.com

Kristen Buckner
www.nightwinggalleries.com

Ken Barthelmey
http://theartofken.com

One of my favourite images, Lady in the Forest is a 

great example of one of the ways in which you can 

create the illusion of natural light. While it’s easier, in 

some respects, to nail down forms in a forest, I feel that 

the chaotic nature of light can be harder to pull off in this 

setting as the light passes through countless leaves, 

dispersing or bouncing from surface to surface and 

creating all kinds of nuances in colour. In this case I 

created the leaves using a square brush with the 

scattering set to maximum, then played around with 

the brush settings to re-create the effect of sunlight 

bursting through a canopy. The rays are reflected 

gradients with some light colours set to Overlay or 

Colour Dodge. The figure was brought in at the very end 

to add scale and contrasting colours to the composition.

With most of my digital pieces, I create a grid to help 

me with perspective and distance scaling. This creates 

a better sense of depth and serves to pull the viewer 

into the painting. Another good piece of advice is to set 

your background lighting and colours before doing any 

real work to the main subject. This helps to create the 

mood of the piece, so set your light sources and define 

where your shadows and highlights will be. In this 

image the feathers were painted by blocking in the 

main colours, including the shadows, and then using 

the Smudge tool at 90% strength to draw the lighter 

colour over the darker and give the impression of 

feathers. The fur was painted in much the same way, 

working from dark to light and using the Smudge tool 

at 40% to create the look of the guard hairs on the tails. 

I love the oil paintings of the old masters so I always try 

to bring as much as possible of this look into my 

paintings. The first thing I do is sketch with pencil and 

paper before I start to work in Photoshop. To me, the 

design of my creatures is more important than the 

painting itself, so I spend most of my time sketching to 

come up with ideas. Here, I used references from 

dinosaurs, insects and other animals. 

Afterwards, I scan the sketches into my computer 

for colouring. The pencil gives my paintings a nice 

texture and a classic look, so they don’t appear too 

digital. When you look closely at some of my works you 

can see hatchings from the pencil – it’s a subtle, tell-tale 

trademark. The other thing I like to do is use different 

custom brushes to re-create that traditional, oil 

painting-esque style. 

7. A lesson in lighting

10. Establish workflow

9. Perspective grids8. Re-creating oil paintings

© Edli Akolli © Kristen Buckner© Ken Barthelmey

© Peter Oedekoven

If you use a logical process from start to fi nish, 
the rest is easy. I always start with a good 
idea, then create a strong, clean composition 
that displays it in the best way. I do this with 
greyscale sketches. 

After fi nalising the composition, I decide 
on the colour palette and start to block in 
the colours. When adding texture, I am a big 
believer in using your own brushes rather than 
being tempted to cheat. Some artists use 
photo referencing to make the painting easier, 
but in my experience the more you reference 
the less soul and originality your illustration will 
have. So I build the picture little by little, and 
gently go into more detail using my hand-made 
brushes. Always use separate layers for each 
foreground element so you can make accurate 
adjustments and easily correct mistakes.

 After the painting is done I adjust the colours 
and the lighting to ensure the mood is right. 
In my experience, I’ve found you can’t save 
a badly-lit and miscoloured image just by 
switching the tone.

Genius Guide
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Susan Schroder
www.susanschroder.com

Alex Kintner
www.alexkintner.com

Martin Faragasso
http://cargocollective.com/faragassomartin

Kate Redesiuk
www.redesiuk.com

The best way to achieve this watercolour effect is to paint in blend 
modes like Overlay, Soft Light, Hard Light or Vivid Light.

From girl to fairy To turn the young girl into a fairy, I made the 
skin greener and the hair redder using the Overlay blend mode.

A question of clothing The fairy is dressed in photos of 
individual blades of grass and leaves that I transformed to her body. 
To create the fairy’s clothing, I used the Transform tool to mould 
some ginkgo leaves and form the base of her dress, then added 
single blades of grass to complete the look.

Build a backdrop Next, I added background elements 
using a separate rock layer and water photos, and then incorporated 
a variety of plants and fl owers to set the scene. To complete the 
image I painted in some translucent fairy wings.

Depth of fi eld To create the illusion of depth of fi eld I blurred 
the elements in the background, which increased the focus on the 
fairy in the foreground. I later included some blurred dandelions in 
the near-foreground to take this notion one step further.

Creating the watercolour effect I softened the overall 
tone using the Overlay blend mode. Later, I painted in shadows and 
highlights on and around the fairy to convey the sense of sunlight.

Say no to stock art I like to compose a fantastical setting of 
my own creation by using dozens of different photos that I’ve taken 
myself. Personally, I get the most joy out of being the originator of all 
the elements in my art, rather than using stock photos or art.

One of the challenges of narrative work is leading the 
eye. We do this using tools like composition, value, 
colour intensity, characters and thematic tension. 
Since the brightest object is the torch, that is where 
the viewer should naturally ‘start’. After that, the eye 
is led to the woman’s face, as we naturally gravitate 
towards faces. Then we follow the orange glow down 
the length of the arm, bringing our attention to the 
closest wolf which, shockingly, is next to where we 
started – this is the big reveal. I gave this scene more 
tension by placing the torch in the Huntress’s line of 
sight on the wolf, and having the dagger at the same 
height as the wolf yet the Huntress looking away.

This image was made using Zbrush, Cinema 4D and 
Photoshop. Time is precious to artists, and adjusting 
lighting and colours in 3D renders can be really time-
consuming. This is where Photoshop is a real treat, 
since I just render once. Using an additive process, 
I experiment in Photoshop with adjustments and 
blend modes. I render a fi rst pass; not too dark or too 
bright, and in black and white. Then I render several 
passes and add these on top of the render. I also 
experiment with a 3D pass – adjusting opacity and 
Brightness/Contrast or Exposure adjustments – to 
play with light intensity or the hue and saturation That 
way, it becomes a non-destructive process.

You can convey realism in many ways, but a lot of 
them come down to making studies from nature and 
applying them to your art. If you nail at least one or 
two aspects of your artwork, such as proportions, 
colours, lighting or anatomy, your illustrations will be 
more convincing and compelling. Achieving realism 
is easier in digital paintings with fewer layers, which 
are merged down for natural mixing. Here, I ended 
up with just fi ve background layers, three for the 
character and ghosts, and three adjustments. That’s 
enough to apply corrections without excessive work 
while still keeping the fi le easy to handle. Try using 
groups and clipping masks for fast, simple editing.

11. Watercolour effects

12. Creating thematic tension 13. Rendering is a virtue 14. Achieving realism

© Susan Schroder

© Alex Kintner © Martin Faragasso © Kate Redesiuk
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Archan Nair
http://archann.net

I began Planquadrath with dark neon strokes, using a 
soft dual brush on the hair and outer edges. I created 
interesting shapes using the Lasso and a soft brush, 
then shaded them in with three colour tones. I used 
harder brush strokes to add bolder tones for a 
dramatic effect.

15. Utilising Photoshop’s toolkit

This represents a wormhole at the centre of the 
heart. Starting with an image of a human male body, 
I reduced its opacity and set it to Hard Light, then 
added circular shapes with gradients. Using a dual 
brush setting and by adding pen pressure, I spiralled 
outwards to create a vortex.

© Archan Nair

Ken Barthelmey
http://theartofken.com

Before I start to even think about painting my 
fantasy creatures, the fi rst thing I always like to 
do is envisage a background story for them. I 
always push myself to make my creations as 
realistic and believable as possible, so having a 
background story in my mind helps me to reach 
that goal.

I consider where they live, what they like to 
eat and what they need to survive. So in this 
image, for example, which I created as personal 
project, I have designed a hybrid-like creature 
that is somewhere between a reptile and a 
monkey. It is called the Cantoris and it lives in 
a tropical-style environment, high in the trees, 
and feeds on insects. These creatures make 
beautiful sounds and so they are known as ‘the 
singers of the forest’. 

To bring my creations to life I begin with pencil 
sketches that show the subject in an interesting 
pose, which I later scan into my computer. I 
know a lot about anatomy and sub-surface 
scattering but it is always a huge challenge to 
paint colourful skin that looks believable.

So, because I wanted to blend the visual 
characteristics of a chameleon and a monkey, 
I found several reference images from these 
animals as a guide to help me get started. My 
technique is very similar to classic oil painting in 
that I apply colour through the shades from dark 
to light. Also, by painting a suggestive depth of 
fi eld, I was able to accentuate the subject in all 
its glory. 

16. Bring your 
imagination to life

© Ken Barthelmey

I started with a monochromatic approach but soon introduced red and beige tones to add depth to the 
landscape. I used the Pen tool to create a dynamic shape (though a Lasso works just as well), then used 
soft brushes to make an interesting colour gradient. I duplicated the shapes several times, adjusting the size 
and rotation to create the motifs and patterns that make the fi nal structure and shape of the image.

Genius Guide
Fantasy Art
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Alex Ruiz
http://conceptmonster.net

17. Blending photography

I start a sketch with simple, abstract shapes, for an 
understanding of depth, lighting and composition, 
before I introduce the photography.

I try to infl uence the viewer to focus on various parts 
of my image, so that the eye fl ows through it and 
then back around to really take it in. Photographers 
call this compositional tactic the ‘eye dance’, and if 
you combine the lighting with the movement of the 
composition you can really bring out the story of the 
characters. Next time you create a piece of art, think 
about how all the elements fl ow together and ensure 
that the lighting brings your main characters and 
the key parts of your design into focus. I started this 
image in black and white so I could concentrate on 
the general objects, light and shading fi rst.

This is my fantasy art depiction of the Jackalope. Since fantasy art is often connected with unnatural or 
exaggerated lighting, I used it to my advantage to make my illustration vibrate with colours.

Sky I added a photographic sky texture to the 
background, as the sky colour has a huge impact on 
the scene’s colours and you want to get it right early. I 
also added the suggestion of a sun between the two 
structures on the left, done on a Screen layer.

Focus your attention 
Always roughly sketch out your 
idea fi rst. It’s tempting to just 
start painting and see what will 
happen, but this often leads to 
you concentrating on pointless 
details or a lack of focus. Mark 
your composition and key 
elements with simple shapes.

Masks Painting light and 
shadows onto objects or adding 
adjustment layers is much easier 
with clipping masks. Layer masks 
are perfect for non-destructively 
refi ning shapes, while group 
masks let you modify whole sets of 
objects and their visibility.

Custom brushes Use 
dynamic brushes to quickly 
create busy backgrounds. 
Scattering and dual brush 
options let you paint foliage 
without having to spend time 
on each leaf. Depending on the 
image style, create a custom 
brush with, for example, a photo 
of a twig.

Perspective I created a two-point perspective 
grid to help me design the structures. I used the Pen 
tool to create these grids as it allows me to go off 
my canvas to easily fi nd my vanishing points. I set 
them to different colours using Hue/Saturation and 
Colorize to help distinguish right from left.

Photography I cut out cathedrals and temples 
with the Lasso to create fantasy-esque castles, using 
clipping masks to ensure the photography adhered 
to my blocked-in value sketches. I then tweaked the 
perspective of the photography according to my 
grids and added photos for the foliage and bridge.

© Alex Ruiz

© Kate Redesiuk

Sabine Rich
http://sabinerich.deviantart.com

Kate Redesiuk
www.redesiuk.com

18.Be eye catching 19. Creature creation

14 

© Sabine Rich



Genius Guide
Fantasy Art

I wanted the pale skin of the character to stand 
out, so I came up with these dark backgrounds. 
Different colours elicit different emotions in every 
viewer. The teal conveys calmness, matches the 
character’s eyes and makes her stand out because 
of the warm/cold scheme. Technically, this is a split 
complementary palette. The black provides the 
most contrast and would fi t brilliantly if the character 
was more serious or dramatic. The purple connotes 
mystery, adding a haze to the image and a faded 
look to the character. The orange would be apt as it 
resembles the sunset, but the golden hues of the girl 
and dragon are lost.

I’ve found that one way of creating a magical atmosphere is to add 
effects in new layers over the initial image. Here’s how this particular 
magical image began.

© Irene Zeleskou

© EverdreamSoft

Irene Zeleskou
www.zeleskou.com

Irene Zeleskou
www.zeleskou.com

To allow for different viewing angles of the same 
library, I used a 3D rendition of the background.

Viewing angle I didn’t worry too much 
about texture and lighting at the beginning of 
this piece – all I was concerned with was getting 
the perspective right. After choosing the viewing 
angle I wanted, I then started populating the 
shelves with books, which was fairly simple 
since many books can be represented just using 
rectangular solid colours.

Transparent layer This initial 
sketch was created digitally in a new 
transparent layer in Photoshop. If the 
composition is not right then I cut 
elements from the lineart and start 
altering their position and scale to fi nd 
the best place for them.

Composition I wanted to create 
a dramatic look and emphasise the 
relations between the three characters 
on the scene; the centaur, the lady 
and the dryad. This was achieved by 
creating a big contrast between the 
light in the forms and by experimenting 
with composition.

3D perspective If I want to fl esh out my 
image more, or I don’t have a photo reference, I fi nd 
that 3DS Max or Poser models act as a helpful guide. 
They help you get the basic perspective, lighting and 
anatomy right, which also speeds up the procedure.

One-point perspective To make the 
books, I created a single group and duplicated 
it over and over again, changing the colours 
slightly each time using Hue/Saturation. I used 
a simple one-point perspective grid to get 
the perspective on point, and then aligned 
the individual groups of books by using 
Edit>Transform>Distort and then following the 
perspective lines.

Light and details After laying down the 
objects I added life to the bland 3D rendering, 
introducing light and atmosphere as well as the 
character. I put a radial gradient at the top with 
a light blue colour set to Pin Light to emulate the 
light of the sky coming through the windows. 

Edli Akolli
http://edli.deviantart.com

21. Work in 3D

20. Colour connotations

22. The importance of layers

© Irene Zeleskou
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Character

Sketch the 
concept With the 

concept in mind, sketch it all 
out to place everything before 
starting the painting process. 
Start with the background 
and perspective so you 
know where it’s best to place 
your character for maximum 
impact. When you are ready to 
start painting, add a new layer 
underneath the sketch. 

The Prey Photoshop

Jennifer Healy Digital painter

Jennifer Healy shows how to 
paint a non-traditional witch and 
her surroundings

The painting
Sketch, tweak and colour your scene

01

Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Jennifer Healy

Personal portfolio site
www.beautifulburden.com
Country USA
Software used Photoshop
I have been painting digitally 
since May 2009. I used to 
be a pencil artist before that. 
My art usually infuses the 
beautiful and the ugly in a 
single painting. Each is also 
laced with a sense of 
wonder and mystique.

Create a  
magical 
witch

When you think of a witch you tend to think of the 
traditional character with a long pointy hat, a long 
nose, warts, broomsticks and cauldrons. But in 

fantasy, witches are so much more than that stereotype and 
can hold a great deal of magic and beauty. A fantasy witch is a 
woman practising magic; sometimes black, but she can also 
be aligned with good magic. Her practice involves varying 
degrees of magic, shamanism, folk medicine and spiritual 
healing, calling on elements and spirits, veneration of ancient 
deities and the many forces of nature. This kind of witch can 
have any appearance, but more often than not they are quite 
attractive. Being tuned to nature can also mean they look a bit 
unkempt, too, but in a pretty way. 

You can have a world of fun when designing your witch’s 
apparel, keeping her sexy but also strong. Her expression 
should be cool with a hit of mischief and you can add in natural 
elements to her clothing to show that she uses nature in her 
craft, further developing her character. 

With fantasy images, you don’t really have to be practical 
when designing your armour or clothing; it all depends on your 
personal preference. If you want your witch to be wearing a big 

heavy armour, go right ahead. She’s a magical character, after 
all, so mortal concerns like tripping over a hem just don’t apply 
to her!

Portraying the character and the narrative should be your 
primary objective, so make sure that you add in elements to 
indicate she is a witch and attuned to nature. This can include a 
range of details like acorns, pine needles, berries, leaves and 
so on, and techniques and effects such as lighting, blur and 
varying levels of detail to give a strong sense of the occult. We 
will take you through the steps to paint this beautiful and 
unconventional witch.

Character
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Begin with 
lighting 

Decide where you 
want the lighting to 
be and what colours 
you want to use for the 
overall piece. Use a 
different layer for the 
trees in case you need 
to change something 
later on. Start blocking 
in the front trees and 
work your way back, 
gradually getting 
lighter the further back 
you go. 

Source files
available

Start off your witch’s spell 
with the sketch on the 
disc provided

02
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Layer for detail 
Even though her clothes 

will cover some parts, you 
can still paint all of the skin 
underneath. This helps a great 
deal if you need to move some 
clothing or decide to redesign 
a part of her costume along the 
way. Keep adding more layers of 

look, as sticking to one colour is 
likely to render it lifeless.

Body 
outline 

Now it is time to 
start on the witch. 
Use a single colour 
(we recommend 
something pale if 
your background is 
dark) for the base 
and a Hard Round 
brush. Be careful and 
clean when colouring 
in your lines because 
you want things to 
be as smooth as 
possible. It is best to 
pick a dark shade for 
the base so you can 
work your way up to 
the highlights. It helps 
to keep your original 
sketch showing at 
this stage so you 
know where things 
are as you paint.

Start the skin Now you need to duplicate the layer. Ctrl/
right-click and select Duplicate, then select Create Clipping 

Mask to help you stay in the lines. Now select a Soft Round brush 
at 12% Opacity. This helps even things out as you paint. Pick a 
midtone skin colour and begin to shade in her body. 

 Now you can add some sparkle 

glowing berries. You can create a custom brush for 
these by opening the Brush palette, checking Shape 
Dynamics, Scattering and Transfer. You can go back 
into the options to set how far apart you want the 
scatter. You can also edit within the Brush Tip Shape 
menu to set how far apart the dots will be.
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Liquify You can add a little more detail to your trees if need be. Open the Filter menu and select 
Liquify to move and distort your shapes easily for more intricate branches and limbs. Another good 

method is to select the Lasso tool, Ctrl/right-click on the image and then select Transform. It’s not as free as the 

03

04

07

05

06

Quick 
Tip

It’s okay if you decide to 
change something from 
your original sketch. A 
good example is if you 
don’t like the way 
something looks or you 
decide something else 
will look better in its 
place. As you go along, 
many things may be 
moved or switched 
around. 
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Blocking in Go ahead and pick out the colours you 
want for the clothing, hair and hair accessories. Now create 

a base for each just like you did with the skin, as this will help with 
applying the shadows later on. Use a Hard Round brush at 100% 
Opacity. Use a different layer for each different element.

Shading Now that you have all your colours 
blocked in you can start shading the skin 

more. It’s easier now since you can see where all the 
shadows will be from the clothing. Keep adding tones 

back later on and put in the details.

Skin colours If you still think the skin is a 

coloured paint over the shaded area, there is an easy 

and set it to the Color blend mode. Use a low-opacity 
brush and gently paint in the colours of your choice. 

Paint the stockings When you get to painting the stockings, create a clipping 
mask on top of the skin layer. This helps keep the stocking perfectly within the shape of 

Light mode if it helps.
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10

11
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Quick 
Tip

Don’t forget to check 

another new layer, select 
the Paint Bucket tool with 

canvas and then click on 

now set this to the Color 
blend mode and this will 
make changes easier. 
Leave this layer so you 
can toggle it on and off.
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Character

Lips 

Final 
features 

For the eyes you 

Set the brush 

Round brush and 

eyelids. 

Work on 
the face 

while and requires 

Shape the nose 

12

13

15

14

Quick 
Tip

your layers as you create 

labelled you will end up 
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Build tones For the hair, start out with 
the darkest tones. Once you have the base 

down you will have a better idea of where the bigger 
strands will be. Pick a lighter tone and work in the 

even the tiniest parts.

Robe and accessories Pick a colour 
that is two shades lighter than the base of your 

robe. Use a low-opacity brush and start blending 
in the tonal values to create some highlights and a 
sense of movement in the fabric. Do the same for the 
rest of the clothing then start adding some patterning 
and detail on her garments. Use a low-opacity eraser 
to remove areas and make it look more realistic. You 
can also set this layer to Soft Light or Overlay. 

16

17

19 20

Highlights 
Now you can 

start applying your 
highlights to the skin. 
You don’t have to go 
into too much detail 
just yet, just enough 
to get the general 
mapping together. 
Try to match the 
highlight colours to 
the background’s 
highlight. You can 
add more hues to 
make the skin seem 
more alive as well. 

Cat and sprites Use a base colour for the cat and then go through 
the same process as you did for the clothing. The hair is also rendered in 

the same way but using smaller strokes. For the sprites, use a soft brush with a 
lighter colour and build up strokes to make them glow.

Colour and detail Go back and double-check your image. If a 
certain area is lacking colour, use another layer set to Color mode to 

18
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Rich and fascinating, Norse mythology 

 Norse mythology has a lot of iconic 
gods and goddesses who are well known thanks to 
modern interpretations of the characters. There has 
been a particular resurgence of interest recently with the 

Thor and The Avengers.  
One of the better-known goddesses from these 

stories, Freyja, is the goddess of love, beauty, fertility, 
war and death, and rules over the Fólkvangr, the 
meadow where half of all soldiers slain in battle go after 

death. Freyja is often depicted wearing a cloak of falcon 
feathers with her necklace Brisingamen hanging around 
her neck. Freyja is also often seen next to her boar 
Hildisvíni (literally translated to battle swine) and the two 
cats who pull her chariot. 

The illustration in this step-by-step tutorial depicts 
Freyja with most of her iconic items. Her design is also 

psychopomps, and sometimes Freyja is depicted as a 
valkyrie herself. The scene in the illustration is a war 
scene, where an army moves across a landscape with 
Freyja watching over them, waiting to collect their souls.

 It helps to sketch out your ideas on paper before 
taking it into Photoshop. Keep this stage loose and, when 

you have found the idea and composition you want to, bring it into 
the program. Set your sketch to Multiply and roughly throw down 
some greys on a layer beneath to get an idea of space. 

 In 
a background-heavy piece like this, I 

recommend getting this part done before the 
character. Start blocking it out by playing around with 
dark and light values. 
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Freyja  2011 

 Illustrator

Lili Ibrahim takes you step by step through how to paint 
an army going to war and the Norse goddess watching 
over them  

Painting Freyja
Prepare your canvas for the goddess of beauty and war

01

Digital artists explain the 
techniques behind their 
amazing artwork
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Personal portfolio site
www.liliibrahim.com
Country UK
Software used Photoshop, 
Zbrush, Maya, 3DS Max
Lili Ibrahim is a freelance 
concept artist and illustrator 
working from and living in 
her London apartment. She 

enthusiast with a degree in 
illustration and animation, 
hoping to bring something 
exciting to the industry.

Study the sketch on 
the disc to help pose 
your character

Norse character 
design 

02
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03

Paint the sky Switch off the silhouette of the character and start painting the sky. By 
keeping the sketch of the character still visible, you can plan out the details in your clouds 

and lighting to make sure they don’t clash with the shape of the character. The sky immediately 
surrounding the character’s face and upper body has been left a bit less detailed than the rest. 

Paint the ground When you are starting to feel good 
about the sky, move down to the ground. The colours of 

the hills are fading into the colour of the sky the further back into 
the picture they are to show perspective. The closer ground is kept 
bright red and the contrast here is stronger as well.   

Character values Switch on the character silhouette again and, on an new layer set 
to the Overlay mode, start adding values to it. By darkening and brightening areas, you 

can start chiselling out the character. Remember that different surfaces will react differently to 
light. Metal will have very sharp highlights and shadows, while hair and feathers will have a softer 

Character silhouette With a neutral grey and using 

character on a new layer under the sketch. On a layer set to Color, 
you can introduce some more distinct tones to the background. 
These colours will help you convey atmosphere for your piece. At 
this stage, try to keep to a limited colour palette for simplicity.

04

05 06
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Quick 
Tip

Your visual memory can act 
like a library to store 
information about what things 
look like. Depending on what 
you have seen and done in 
your life, your visual memory 
will contain different 
information that you can call 
upon in your art. Nobody’s 
visual library contains 
information about every 
single thing that exists, 
though, and when you have 
to illustrate something you 
might not know much about, 
research is vital!

07

08

09 10
11

More colours Colours can also be added by painting onto a layer set to Color. Play around with 

painting the initial colours. Use a fuzzy brush and make the colours bleed into the surrounding areas. Also add 
a little bit of red blush to the skin. This is especially effective when added to legs, arms and faces.  

Colour the skin On a new layer set to 
Overlay you can introduce skin tones. The skin 

tone can then be adjusted by tweaking the colour 
balance (Cmd/Ctrl+B) or the hue (Cmd/Ctrl+U).

 When something looks 

on exactly what it is that isn’t working it’s time for a 
research session. A bit of Liquify magic and some 

Colour correction If the colours look 
strange against the background, the colour 

balance might be wrong. Merge the character layers 
and open the Color Balance dialog (Cmd/Ctrl+B). 
This adjustment helped to pull the shadows in a 
colder (bluer) direction to even things out. 

Contrast and colour You can use the 
Color Balance adjustment at any point to 

further tweak the colours into a bluer tone. You can 
also add more shading to a layer set to the Multiply 
mode if needed.
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Keep 
painting 

Paint details by 
picking colours that 
are already present on 
your canvas with the 
Eyedropper tool (using 
the keyboard shortcut 
I and clicking). At this 
stage you should avoid 
introducing completely 
new hues unless 
you actually want to 
recolour something 
or add emphasis to 

tiny braids in her hair 
this way with highlights 
and shadow, and 
design a spear with a 
decorative feel to give 
the impression of a 
powerful and important 
character.

12

13

14

15

Cut the skirt If you haven’t 100% decided 
on your character’s costume at the sketching 

stage, don’t be afraid to adapt it. The skirt in this 
design was made shorter, which revealed that the 
legs were slightly disproportionate. Sometimes last-
minute changes can be advantageous!

Shield design When 
designing an emblem, 

it helps to do so in a separate 
document and then transfer 
it into your image – especially 
if the plan is to distort the 
perspective of the emblem. 
You can easily distort images 
with the different transformation 
options available. In this case the 
perspective transformation tool 
(Edit>Transform>Perspective) 
was used. 

Feather detail Detail the feathers on the 
character’s shoulder, using reference images 

to get the look right. When working with small details 
like these, it is important not to forget to continually 
zoom out to get a good view of what you are actually 
doing in the image.

Quick 
Tip

instant inspiration can be the 
least expected. Take some 
time browsing the internet 

visual material you never 
would have thought about 

these things can and will 

are, the more dynamic your 
art will be.
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Start on the army Beneath the cliff, start sketching out the basic 16

18

19

20

17

Smoke 

mountains to give a 

of some warriors to 
give the piece more 

the army from their 

back into the painting 

give the impression 

up as the army 

Final 
tweaks 

If you think it 

composition, enlarge 
the character to make 

Adaptation
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Vampires and their legends have a long and 
detailed history, making them a joy to research with 
plenty of information to inspire your artwork. 

Paint a 
vampire 
pin-up

Build a spooky 
vampire image

Working

Step 04: Values

Step 08: Composition 
changes

Progress

Step 17: Chisel the 
gravestones

Source files
available

Character

The Last Meal  Photoshop

Lili Ibrahim Illustrator
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Digital artists explain the 
techniques behind their 
amazing artwork
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Lili Ibrahim

Personal portfolio site
www.liliibrahim.com
Country UK
Software used Photoshop
Lili Ibrahim is a freelance 
concept artist and illustrator 
working and living in her 
London apartment. She is a 

who has recently graduated 
with a degree in illustration 
and animation, hoping to 
bring something exciting to 
the industry.

Fantasy Art
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Values By 
working in 

greyscale you take 
control of the values at 
an early stage in your 
painting process. When 
doing your value study, 
keep in mind that they are 
affected by perspective 
and atmosphere. This 
means that things close 
to you have stronger 
contrast, while things 
further away from you 
normally have less. The 
thicker or foggier the 
air is, the quicker the 
contrast fades into the 
background.

04

Colour palette 
Choose a colour 

palette for your piece 
based on your research 
and the kind of media that 
you have been inspired 
by. Instead of a typical 
nighttime colour scheme 
of blues and blacks, for 
example, you might want to 
go for warmer tones to give 
a dreamy, alluring feel. 

05

Rough ideas No good painting starts 
without some planning. Get those ideas 

down quickly and create a selection of thumbnail 
compositions and ideas to choose from before you 
throw yourself into creating the proper artwork.

01

Sketched composition When you 
have settled on a good idea you can start 

sketching it out on a bigger scale. This lays the base 

crop further down the line, it is wise to start working in 

02

Clean it up Depending on how 
loose your sketch is, you may or may 

not want to clean it up a little for crisper lines. 
Lower the opacity of the original sketch and 
draw on top of it on a new layer. Doing this will 
enable you to look over the lines one more 
time to make further tweaks and changes.

03

Sketch the scene
Create atmosphere with gruesome details 

Quick 
Tip

It can be very useful to keep a mirror on 
your desk. Sometimes, it is simply 
easier to pose yourself rather than 

internet with the exact stance or angle 
that you want. Keeping a camera ready 
is also useful for poses that you can’t 
model and paint at the same time!
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Tweak the base By now the base for the painting is almost prepared. Spend some time tweaking 

problems with the tone of her hair – the dark colour was weak. Other details such as the cross necklace and 

06

 Start painting Now you can start 
painting details. Merge all of your layers into 07

Repetition is a good tool to make something 

complicated and realistic without stealing the 

Quick 
Tip

Composition 
changes 

compositional ones. 
Adjust the posture of your 

if you feel it isn’t working. 
By making the changes 

can always compare 

toggling it on and off. It 

you see that your choice 
to change it paid off.

08

Render the 
character Where you 

start rendering your painting is up 

good place to start. Warm up your 

by painting some warmer colours 
on a layer set to Hue. Changing 
colour is tricky when the palette is 

making too big a change.

09

 Using pictures of 

with the red placeholders and start painting the 

unreal or is incorrect.

10
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Details on the ground Next to the cat 
in this composition is a selection of items. 

When painting little objects on a big canvas, it is 
easy to get carried away with minor details. Make 
it a habit to zoom out every once in a while just to 
remind yourself of how much will actually be seen in 

something that won’t be visible! 

13

 Design the hair
stretched across the scene. Making her hair white is therefore an important aspect. Start painting little 

webs connecting your vampire lady to the surrounding gravestones. 

12

The cat 

a thinner brush and working on the vampire’s arm. 
Render the silhouette of the cat more solidly with 
a watercolour brush or one set to Wet Edges for a 
nice effect.

11

More red details Add more poppies to 
the background to balance out the ones in 

the foreground. Add in subtle elements to unite the 
piece, for example stains of blood on both the cross 

small so as not to distract or overpower.   

14 Add to the background
background has been left very minimal in this 

detracting from the focal point, add a couple of trees. 

secluded from the outside world. 

15
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We all have favourite things to paint, but there is a risk 
involved with lingering too long on the same part of your 
painting. Try to continuously move around the painting 
and paint a little bit of everything at each stage. Zoom 
out and you will spot something that needs to be 

Quick 
Tip

Chisel the gravestones To make the gravestones more readable, 
add plaques at the base and some words behind her. Give the two graves 

closest to the viewer inscriptions for that added touch of detail. Paint shadows 
onto the graves in the background as well to show the direction of the moonlight.

Final 
touches         

Go over the painting 

adjust any other little 
things that have been 
bothering you or have 
now noticed. Add some 

wind to make the scene 
feel alive and to give it a 
more dynamic edge.

and you are happy with your details, you can 

painterly. This is also an opportunity for some very 

hues with a Color Balance adjustment layer and the 
values with Levels. 

The stake Place the stake into your scene. Keep the colours fairly 
saturated, as it is a foreground object, and use strong highlights on the 

dark tones, and draws the eye.

16

17

18

19

Fangs for the memory One of the most iconic features of vampires is, of course, their fangs. If 
you have ever worn a brace you’ll know that larger-than-normal canines sit in awkward positions in the 

jaw, much higher and further apart than normal teeth. Use this to emphasise your vamp’s grin! 

20
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Source files
available

Included on the disc, you 
will fi nd the Photoshop fi le 
of the illustration as well 
as corresponding texture 
and pattern fi les to help 
you replicate the steps 
listed in the tutorial

Digital artists explain the 
techniques behind their 
amazing artwork
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Ashley Walters

Personal portfolio site
www.ashleywalters.net
Country US
Software used Photoshop
Ashley Walters is an 
illustrator with a love of all 
things fantasy and sci-fi . 
She currently works as a 
freelance artist and spends 
her spare time being a mum 
to three kids and watching 
Doctor Who.
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The following tutorial is for those who wish to learn 
the basics of digital painting and discover tips and 
tricks to add texture, luminescence and mystery to 

illustrations with simple Photoshop methods. 
Learn to sketch non-existent objects using basic perspective 

and visualise lighting so that you can add any element to your 
painting regardless of reference. Discover the difference 
between form shadow and cast shadow and how to effectively 
render both. 

Once you understand how light interacts with your subject 
matter, the possibilities are limitless. 

Learn how to pick compelling colours to establish mood, to 
paint different materials such as cloth, metal, and skin, including 
how to apply textures and patterns realistically using fi lters. 
Finally, discover the secret to creating glow effects and glares 
using various layer blending modes. From start to fi nish, you will 
learn how to employ Photoshop effectively to create a 
compelling painting.

Paint a Steampunk-
inspired portrait

From start to fi nish

Working

Progress 1: Sketch the 
outline

Progress 2: Paint the image

Progress

Progress 3: Add effects

Steampunk portrait  Photoshop

Ashley Walters Illustrator

Once you understand how light interacts with your subject 
matter, the possibilities are limitless

Back to basics
Decide the aim of the piece and choose your reference

Visualise your image Before starting, 
visualise what you want to accomplish. In this case, 

the goal is to paint a Steampunk piece which integrates 
portraiture with mechanical elements. It’s meant to be 
a dark, atmospheric image with lush colours to invoke 
mystery and interest. Remember to download the 
resources before you start.

01

Gather reference Paintings should be 
unrecognisable from reference unless the material belongs 

to you, so take liberties in deviating from online sources. The 
easiest way to obtain reference is to take photos yourself, but 
be sure that all of your images have the same light source or be 
prepared to paint them differently to how they appear.

02

Start a new document  Begin by creating a new document (Cmd/Ctrl+N). Set the image dimensions to 4800px by 
6400px at 300ppi. Decide between RGB or CMYK for your colour mode (RGB can achieve richer colours while CMYK is 

useful for printing). Fill it with a warm green tone in the middle-range of value (not too light and not too dark).

03



38  Fantasy Art Genius Guide

Character

Sketch the outline Create a new layer named ‘Sketch’ (Layer>New>Layer). When sketching 
your outline, think about the focal point to keep the eye moving within the image. Use your reference 

as a rough guide as you freehand the sketch using a dark burgundy colour. Keep in mind perspective as you 
draw objects without a reference as a guide, like the dragon and goggles. It helps to sometimes draw boxes 
in perspective with the rest of the piece and then chisel away at the objects inside to create angular shapes 
before fi nally rounding off the details. 

04
Quick 
Tip

Paint separate elements on their own layers so that 
you can lock the transparency and paint each one 
without going over the edges. To do this, choose 
the corresponding layer in the Layers palette and 
click the checkered square icon at the top next to 
the word ‘Lock’.

Pick colours Colour defi nes the mood 
of a piece. The key to having lush colours is 

fi nding a balance between rich and dull. Too bright 
and your image looks contrived and over-the-top. 
Too dull and your image looks washed out. Lighter 
colours should be less saturated and darker colours 
more saturated. On a new layer, pick a basic fl esh 
colour, scribble and repeat, increasing the saturation 
as you go darker. To help the image pop, add subtle 
oranges and warm pinks for the eyes and cheeks. 
Pale cyan works as a highlight colour to contrast 
against warm shadows.

05

Understanding light Form shadow 
(or core shadow) creates the illusion of form 

and gives objects depth. It occurs when light fails 
to completely wrap around the form of something 
and is a gradual transition from light to shadow, 
with softer edges (like the cheekbone, which at fi rst 
catches the light and then curves downward into 
shadow). Cast shadow occurs when something 
(like the nose, for example), blocks the light, 
throwing areas below into darkness. It tends to have 
sharper edges.

06 Visualise where light falls When 
creating an object without reference, it is vital 

to be able to picture in your mind where the shadow 
would fall if you could see it. Sometimes it helps to 
picture the subject matter as if it were made up of 
several small geometric polygons. Look at each 
surface plane and ask yourself if the angle would 
catch the light or not, then translate that into your 
painting. Don’t forget to add in cast shadows of 
made-up elements to ground the work and give it a 
cohesive feel.

07 Create the Background Create the 
illusion of a light source just off canvas using a 

hard round brush choosing a pale yellow hue. Sweep 
the brush downward to emulate the glowing effect of 
light on a wall. Picking a dark green colour, sweep the 
same brush along the edges of the canvas to push 
the corners into darkness. Blend the colours with a 
soft round brush as necessary. Note that the light will 
be brighter here and the change between values will 
be more drastic near the top where the light is closest 
to the wall.

08
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Pattern should conform to the form beneath. 
To create the effect of the pattern wrapping 
around the silk shirt, paste the pattern on a 
new layer above the painting. Create a quick 
mask over your painting by clicking between 
the two layers on the Layers palette and 
pressing Opt/Alt. 

Set the layer Blend Mode to Overlay and 
reduce the Opacity to 30%. Go to the Liquify 
fi lter (Filter>Liquify), and with the painting 
layer visible beneath your pattern, use the 
Forward Warp tool (W) to push the pattern 
downward around the edges of the arm. 

Do the same for the fabric texture above 
the vest area.

More on pattern

Down to detail
Apply paint, add texture and create atmospheric effects

Start painting On a layer beneath the 
sketch, paint the skin using a default round 

brush. Keep your Opacity and Flow at 100%, and 
rely on the sensitivity of your tablet to blend the 
colours. Make a clear delineation between light 
and shadow. As you continue to refi ne, add the 
transitions between the two values using a soft brush 
when needed. Use your highlights sparingly for the 
greatest effect. Merge your Sketch layer and your 
painting layer and gently paint out the sketch until all 
the lines are gone.

09 Shiny versus dull When painting 
matte surfaces like the cotton vest, do 

not paint highlights. Only two values are needed 
for these – mid-tone and shadow – with gradual 
transitions between the two on occasion. When 
painting refl ective surfaces like silk or brass, however, 
exaggerate the drastic change in value by using 
sharp specular highlights in areas where the light 
would logically fall and by using contrasting strokes. 
Remember to incorporate surrounding colours, as 
metal is highly refl ective.

10 Painting skin and hair When painting 
skin, fi nd a balance between matte and shiny. 

The skin will have sharper and brighter highlights if 
the face is wet (like around the eyes) or where oils of 
the skin refl ect light (like on the nose and inner tear 
duct). If you haven’t already, add these specular 
highlights to create luminescence. When painting 
hair, start by putting in the darkest values fi rst, and 
then add the midtones using a chunky round brush. 
Gradually reduce the size of the brush until you are 
painting individual strands.

11

Add texture and pattern Texture and 
pattern add realism to your work when done 

correctly. To create the illusion of wallpaper, paste 
a damask pattern on a new layer and set the layer 
Blend Mode to Overlay from the drop-down menu 
on the Layers palette. Reduce the opacity of the layer 
so that the pattern is not overbearing but still present. 
You don’t want your image to be too busy or distract 
viewers from the fi gure in the foreground.

12
Add atmospheric effects The last 
step is to add subtle atmospheric effects. 

Create a glare on the highlight of the goggles using 
a soft round brush in a pale yellow colour on low 
opacity. For the blur on the dragon wings, copy the 
wings onto a new layer underneath and use the 
Motion Blur fi lter. Set the angle to 40 degrees and the 
distance to 200px. Use a smoke brush for the dragon 
steam. To make it glow, on a new layer use a soft 
green brush set to Hard Light.

13
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The following tutorial is not for the faint of 
heart, and is intended for those who are 
obsessed with striving towards Photoshop 

euphoria. Assuming those following along have at least 
a moderate understanding of Photoshop, we’ll attempt to 
be direct and thorough without being redundant or 
repeating ourselves. 

Knowing where things are within the program, as well 
as having basic painting and masking skills, will aid you 
on the metaphorical road ahead. Some of these effects 
may appear intimidating initially, but fret not, for those 

who persevere through the thick and frustrating times will 
always take away more than those who are easily 
shaken. Following our guide will support you.

In short, you will discover how to summon a glow 
effect from nothing but variations of a single image, 
engulf a model within a glossy ice texture, and ponder 
not the ‘right’ way but a ‘different’ way to organise layers 
and groups. We’ll also throw out some tips that you may 
already know, but if you don’t, they could open up a 
world free of rules that will allow you to maximise your 
ability to create iconic work at the level few have roamed.

Fantasy Art

Create an ice 
queen heroine

From gloomy to 
glistening

Working

Progress 1: Getting started

Progress 2: Summon glow

Progress

Progress 3: Final

Fantasy Art

Begin the transformation
Download the model stock image and set the colourcast

Getting started Download the fi le ‘model_
cutout.psd’ from blog.advancedphotoshop.co.uk/

tutorial-fi les, which has the base model already cut out from 
her background. Keep anything you add to your model in 
a folder titled ‘Ice Queen (Cutout)’; that way, everything you 
add to the model will automatically be masked to the cutout, 
eliminating the need for clipping masks.

Set the colourcast Create a new Fill Layer 
(Layer>New Fill Layer>Solid Color) and title the layer 

‘Blue’. Change the blending mode to Color, hit OK and select 
your colour, or alternatively enter #5b7ca4 and hit OK. You’ll 
want this colourcast to affect the entire image, so move it 
above the cutout group mask to the top of the layer menu.

01
02

Digital artists explain the 
techniques behind their 
amazing artwork
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Drew Lundquist

Personal portfolio site 
www.drewlundquist.com
Country US
Software used Photoshop
A recent graduate with a 
bachelor’s degree in 
photography, Drew 
Lundquist is one of the 
premier artists at creative 
support studio Elevendy Inc. 
in California.

Ice Queen  Photoshop

Drew Lundquist Photographer

Summon a glow effect and engulf a 
model within a glossy ice texture

Source files
available

On the disc you’ll find a 
selection of the supporting 
images used to create 
atmosphere, the model 
start image and a PSD file 
to speed up your process
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Using multiple texture layers scaled and warped differently can add 
believability to an image and be a deterrent against fl at surfaces. 
Using Perspective and Distort to mimic the surface you’re texturing 
can really sell some depth. No one’s fooled when one fl at rock 
texture is over the model’s entire face.

Quick 
Tip

Duplicate the base layer Duplicate 
(Cmd/Ctrl+J) the ‘Model (Base)’ group and 

fl atten it (Cmd/Ctrl+E), then duplicate the copy layer 
and invert it (Cmd/Ctrl+I). Title each respective layer 
‘Normal’ and ‘Inverted’. These two will be your go-to 
layers, as you’ll duplicate them many times, but for 
now, turn the layer visibility on each of them off.

03

Blending madness To create the model’s glow, you’re going to use many versions of the two 
layers you just created. Within a new group titled ‘Blending Madness’, duplicate a mixture of the Normal 

and Inverted layers of the model as you see fi t. Using layer masks, vary the brush Size and Hardness to blend 
or paint in areas of the model that you’d like to appear glowing using the Inverted model layer, or where you’d 
like to maintain highlights and shadows using the Normal model layer.

04

Experiment with blending modes You should 
now have a cluster of Model (Base) layers, both inverted 

and not, to achieve that perfect glow. It’ll need a lot of tweaking and 
refi ning to reveal that perfect combination of blending modes that 
ultimately make the model feel incandescent. Each mode acts 
differently, exaggerating or excluding some tones while maintaining 
others. This is a major experimentation phase. If you’re really 
having trouble with it, move past this step and continue from the fi le 
‘blending_madness.psd’.

05

Multiply and Screen You’re now going to adjust the 
highlights and shadows of the model. Create a folder above 

your Blending Madness folder, add a Black & White adjustment 
layer within it and set the blending mode to Multiply. Now, with the 
layer mask on your adjustment layer selected, hit Cmd/Ctrl+I to 
invert the mask, making the Multiply effect invisible. Paint in the 
areas you’d like to see darkened, varying in brush opacity or fi ll. To 
lighten, repeat this step, but instead of Multiply set your blending 
mode to Screen.

06
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Skin frost Now it’s time to grab the frost texture. You can use image #5179760 from www.
depositphotos.com, which will work perfectly. Be sure to select ‘Advanced Search’ on the site or it 

won’t show up. Position the texture over the model’s chest and set the blending mode to Overlay. Use a layer 
mask to hide and feather the edges of the texture image so there aren’t any harsh lines (seams) all over the 
image; you want seamless transitions between textures. Group this texture and title it ‘Skin Frost Texture’.

07

Shape the skin texture You’ll need 
to duplicate and reuse this texture all over 

the model’s skin using at least one texture image 
over each feature, ie one layer covers an arm, one 
her face, and so on. Use Transform (Cmd/Ctrl+T) 
to resize texture layers and place them on different 
parts of her skin as needed. Use Warp to mimic 
areas of the skin that curve, like the model’s shoulder, 
and a layer mask to keep texture contained to the 
model’s skin and off things like her dress.

08

Step back and admire your work Getting this far is not easy considering how much 
experimentation this image requires, so pat yourself on the back, stand up, stretch and then buckle 

down because you’re not out of the woods yet. Let’s take a look at what’s been done so far… 

09

Lay down some ice Similar to steps 9 
and 10, you will need to add extra texture the 

model’s dress to make it appear as though she’s 
engulfed in ice. Go back to 
depositphotos.com, grab image #5179582 and 
drop it into your composition. Use the Transform 
tool to manipulate multiple duplicates of this texture 
to cover the entirety of the model’s dress and lower 
exposed leg.

10

Divide the ice into sections Divide 
chunks of ice into sections of the dress to give 

the end result dimension so it doesn’t look so fl at. 
Each section of the dress should be its own layer. 
Use masks to isolate and shape each chunk on the 
dress. Set each ice texture layer to Screen or Overlay. 
With the toning you did before (based on how dark 
your image is), blending modes may vary, so feel free 
to experiment.

11

ADD GLOW 
Experiment with normal 

and inverted layers using 
blending modes to create 
alternate lighting and glow

01 UP THE CONTRAST 
Use non-destructive 

adjustment layers to paint in 
highlights and shadows to further 
emphasise drama

02 TEXTURE THE 
SKIN Overlay snow 

textures on the skin to manipulate 
the model into looking like a cold-
hearted… princess

03

01
02

03
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Duplicate and fl atten Once you have your dress’s ice textures all set, group all 
those layers together. Title the group ‘Dress Ice Original’, duplicate it and then fl atten it. 

It’ll look different initially, but that’s okay. Create a new group with the layer you just created and 
name this group ‘Dress Ice’. Keep the original group folder in case you’d like to go back and 
tweak your ice, but turn the visibility of that group off. 

12

Blend ice texture Change the blending modes of all three layers, from bottom to 
top, to Linear Burn, Soft Light and Hard Light. Set the Linear Burn layer to 80% Opacity, 

add a layer mask and invert it, effectively hiding the layer, at which point the ice effect will get 
a little brighter. Paint in where necessary to darken the ice around the dress. Play with adding 
more ice texture or revisiting your Dress Ice Original group.

14

Create the ice throne Head back over to 
depositphotos.com, purchase image #13470132 and 

drop it into your composition above the Ice Queen (Cutout) group 
but below the Blue layer. Cut the bottom of the iceberg out, title the 
layer ‘Bottom Ice’ and place it in its own group also titled ‘Bottom 
Ice’. Use the Transform tool to scale and rotate it 180 degrees. Place 
it at the bottom of your composition, just under the model and 
apply the same Filter Gallery effect from step 13 to this layer.

15

Layer organisation is key when working with so many duplicates of the 
same layer, or just an extensive amount of layers in general. It will 
simplify your whole experience in Photoshop if you use a group mask 
as a cutout rather than applying 16 clipping masks to one layer.

Quick 
Tip

Create the glass texture Once you have grouped 
the dress layers together, you can add a glass texture to 

them. With the current single layer in your Dress Ice group, go to 
Filter>Filter Gallery and under the Distort tab, select Glass. Set the 
Distortion to 20, Smoothness to 15, Texture to Frosted and Scaling 
to 200%, then hit OK. Duplicate that layer twice so that you have 
three layers in total in your Dress Ice group.

13
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Mask the model to the throne You 
now need to fuse the ice queen to her throne. 

Duplicate the Bottom Ice layer. Change the blending 
mode of the top one to Hard Light and the bottom 
to Lighten. Select the Ice Queen (Cutout) and group 
that group. Add a mask to the new group, right above 
the old one. Use your Brush tool with a super soft 
edge and paint away any hard edges you see. Do the 
same with the Bottom Ice layer – paint away the top of 
the ice so that the dress and iceberg blend together.

16

Add ice spikes Snag image #8159693 from Depositphotos and drag it in above the Bottom Ice 
group, into its own group titled ‘Ice Spikes’. Cut the ice from the sky. Shape and place the layer just 

above the Bottom Ice group, slightly lower on the model, surrounding her with ice. Duplicate it three times. 
From bottom to top, change the blending modes to Pin Light, Color Burn and Hard Light with an inverted black 
mask, and leave the top layer at Normal with an inverted black mask. Paint in Normal and Hard Light layers.

17

Add some atmosphere Grab the 
‘snow’ and ‘fog’ images provided in the 

tutorial fi les and pull them in as needed. Keep most 
of it behind (below) your Ice Queen (Cutout) layer 
and only some snow layers in front (avoid covering 
her face) to give the image depth. Change all these 
layers to Screen. You’ll still have to mask the edges of 
each image with a soft brush to avoid those ‘seams’. 
Vary these assets in size with the Transform tool.

18
Final adjustments The last thing to 
do with every image is to tone-manage over 

everything the same way you did at the beginning of 
this tutorial. Create a group just under the Blue layer 
and title it ‘Overall Adjustments.’ In here, create two 
Black & White adjustment layers and again set them 
to Multiply and Screen and invert the layer mask 
(black). Paint the tones in with a soft brush on each 
layer. Multiply will darken, Screen will lighten. Add as 
many as you need.

19
Combining blending modes can become a 
tedious process. There’s typically one 
blending mode that will achieve what you’re 
looking for, but with the amount of options 
at hand, it can be diffi cult to fi nd. Using 
adjustment layers combined with various 
blending modes can have the perfect effect 
on your image, while the inverse can 
destroy your tones entirely. For future use, 
it’s wise to become familiar with what each 
mode does to an image as well as what 
each does to each adjustment layer.

Blending 
modes
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Personal portfolio site
www.kuziola.com
Country Edinburgh, UK
Software used ZBrush, 
Photoshop
Andrzej Kuziola specialises 
mainly in character creation, 
from concept to render, and 
detailed 3D model creation

The idea behind this 
illustration is to create a 
unique fantasy character 
– I’ve decided to 
concept a female spirit 
of a tree. I want to 
achieve a very 
sculptural, stylised look 
to the image, inspired 
greatly by ancient Greek 
mythological character 
sculptures.

Concept
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In this tutorial we will explain the design and 
creation process of a fantasy character 
showcasing the features in ZBrush. We’ll explore 

various ZBrush tools and show how helpful they are to 
visualise ideas and achieve great effects. ZBrush gives the 
freedom of creation in any workfl ow, enabling you to 
experiment and visualise ideas.

This tutorial will explain how to design and create a 
character from scratch, showing important considerations 
along the way while explaining the workfl ow and various 
techniques used. We will focus mainly on sculpting the fabric 
of the dress, the character’s hair and some stylised tree 
branches to fi nish, but also show you how to create the body 
and establish composition.

Dryad – Spirit of a Tree  2012 Photoshop, ZBrush

Andrzej Kuziola Illustrator

The goal of this image was to create a stylised, sculptural, 
fantasy character with a focus on showcasing the dress folds

Sculpt fabrics for 
fantasy characters

Create the body with ZSpheres
Let’s begin by creating the character in a neutral pose

Establish your base mesh 
Using ZSpheres, create an initial 

armature and block in the shape of the 
character. In these early stages we won’t draw 
ZSpheres in place of the eyes and mouth. We’ll 
focus on proportions, as this will give us more 
design freedom in the later stages. When happy 
with the result, change the rig to Adaptive Skin, 
then press the Make Polymesh3D button.

01

Sculpt the body Modify 
the shape of the mesh with 

the Move Topological brush and 
start defi ning masses with the Clay, 
Clay Tubes, Simple and Smooth 
brushes. Work gradually from the 
lower subdivisions to the higher 
levels, subdividing the mesh when 
necessary. Focus mainly on the 
head and hands, because the rest of 
the body will be covered with clothes. 
We’re creating a stylised character so 
change proportions by exaggerating 
the head and elongating the limbs.

02

Face detail Switch the model 
to a high subdivision level, sketch 

the shape of eyes and lips with the Pinch 
brush. Create eye sockets with the Clay 
brush and shape an interior with the 
Smooth brush. To sharpen eyelid edges 
use the Pinch brush with a very small 
Draw Size. To create eyeballs, append 
a sphere as a SubTool, adjust its size, 
position and then mirror it to the second 
eye socket. With the character base 
mesh active, use the ZProject brush on 
the eyeballs. We’ve now got spheres 
projected into the eye sockets, so we are 
able to delete the eye SubTools

03

I’ve chosen to create 
whole body anatomy 
– even though most 
of it will be covered 
with cloth – for two 
reasons. The fi rst is 
so I can reuse the 
model in my future 
projects. Keeping a 
repository of base 
meshes and models 
gives a huge 
advantage when a 
deadline is short and 
you don’t have 
enough time to create 
something from 
scratch. The second 
reason for creating 
the whole body is that 
the clothing process 
is much easier with 
body armature 
underneath. Besides 
these, it’s always 
good to practise 
sculpting human 
anatomy when you 
have the opportunity.

Model the 
whole 
body
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There are a few golden 
rules that you need to 
follow if you want to create 
a really impressive 
illustration. First of all you 
need an interesting focal 
point to pull in the viewer’s 
eye. You also need to 
design and place elements 
in your image in such a 
way that the viewer’s eye 
will fl ow around the various 
details. Creating rhythm 
and variety in your image 
to keep it balanced is 
important. Always think 
about positive and 
negative space, and also 
about the relationship of 
light and dark.

Principles 
of good 
design

Design and composition
Establish composition and block general forms for further development

Pose the character 
Pose the character with 

the Transpose tool and then 
fi x deformations with the Move 
Topology, Clay and Smooth 
brushes. We don’t need to 
adjust body distortions in some 
areas due to the fact that they 
will be covered with a dress, but 
we’ve done it for the purpose of 
the tutorial. We want to create a 
neutral, balanced and relaxed 
pose. This is a framework for the 
cloth anchor points and will help 
us establish interactions between 
the body and the clothes.

04

We want a mesh that matches the shape of the legs as much as possible. This 
will help us establish interaction between the fabric and the body later

The dress base To 
create the base for a dress 

use DynaMesh. We want a mesh that 
matches the shape of the legs as 
much as possible to help us establish 
interaction between the fabric and 
the body later. First, duplicate the 
character, then extract the bottom part 
of the mesh by partially hiding it with 
Cmd/Ctrl+Shift, the Delete Hidden 
and Close Holes options. Convert it 
to DynaMesh and reshape it with the 
Move Elastic brush. For smaller areas, 
use the Move Topological brush. Use 
the Standard brush with a large Draw 
Size to sketch the direction of the folds.

05

Refi ne the dress 
Activate the DynaMesh 

function by clicking its button. This 
creates a new uniform topology 
with the density defi ned by the 
Resolution slider. Always start with 
a lower resolution and then adjust 
it to achieve the desired result. 
Each time polygons become 
stretched after adjustments to 
the mesh, recalculate DynaMesh 
by hitting the Cmd/Ctrl key and 
dragging the cursor onto an 
empty canvas.

06
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Move to the top To create the top of the dress we’ll use DynaMesh 
again, but in a slightly different way than previously. Mask the area that 

you want to use for a new SubTool. Go to SubTool>Extract, adjust Thickness 
and choose Accept Extraction. This is a good way to create a mesh around 
a complex shape. Now start to reshape a new mesh, using the Move Elastic, 
Move Topological and Standard brushes to add volume and block large folds. 
Remember that DynaMesh needs some thickness. When you get artefacts after 
re-calculation, undo the action and work on the area with the Infl ate brush.

07 Design the tree Create a curved tree trunk with ZSpheres, adjust 
its shape with the Move Elastic brush, then transfer it to DynaMesh and 

start adding branches with the Curve Multi Tube brush. This is a great tool for 
elongated, tentacle-like structures. Re-calculate the mesh often and also use 
the Infl ate, Smooth, Move Topological and SnakeHook brushes. This sketch-
like workfl ow is a good way to create designs and develop ideas straight in 3D 
without an initial sketch.

08

Create the background Now we’ll add a background that will play two roles. 
First it will show the fi nal image proportions that will consequently help establish an 

effective composition. We’re also going to use the background plane as a basis for the hair 
– but fi rst we need to add some dimensionality to it. Use the Move Elastic brush to create a 
recess behind the character, then move a part behind the head towards it and the bottom 
edge towards the viewer to create some ground. After that, sculpt the whole plane with the Clay 
Tubes brush, then equalise it roughly with the TrimDynamic brush and Morph Target.

09

Sculpt the hair Now we can start sculpting the hair with 
a modifi ed Slash 2 brush. Sculpt the hair strands with loose 

and smooth strokes on a separate layer. Our goal is to create an 
effect of hair fi lling the background and turning into it. We also want 
the hair to be tangled with the branches. At the end, decrease the 
layer’s intensity and gradually work with the Morph brush to create 
a smooth transition between the strands and the background 
material. For the loose hair strands, append a sphere and move it 
to the head area, also using the DynaMesh and Curve Multi Tube 
brushes. After that, fl atten the strands with the TrimDynamic brush 
and fi nish with the Standard brush with Alpha 38 and Lazy Mouse 
options turned on.

10
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Detail the tree Go back to the tree and develop it further. Use the Curve Multi Tube 
brush to add roots and vine-like structures. The Draw Size determines the diameter 

of tubes created by the brush, so work here with a smaller size. When a tube is painted you 
can adjust its location and shape. It’s possible to draw multiple tubes at once but it’s handy to 
update DynaMesh after each added tube. Also increase the DynaMesh Density to keep all the 
new details. When you’re happy with the form of the tree, quit DynaMesh and start detailing with 
the Clay, Clay Tubes, TrimDynamic and Dam_Standard brushes.

11

To create believable wrinkles or 
folds you need to keep in mind 
a few factors such as the 
interactions of folds and the 
forces generating wrinkles like 
kinetic energy and gravity. You 
need to know where to place 
anchor points – areas of 
retention on a body – where 
wrinkle systems will originate. I 
highly recommend the book 
Dynamic Wrinkles and Drapery 
by Burne Hogarth, where you 
can fi nd all this information. It’s 
also a useful source for great 
references.

Crinkle and 
fold effects

Add the fine details
Create a winding tree and realistic cloth elements

Add some wrinkles Start sculpting wrinkles and 
folds on the bottom part of the dress. Begin working with the 

Standard brush without any Alpha loaded and with Lazy Mouse 
mode turned on. Begin to add volume with the Infl ate brush, 
using it lightly with low pressure. Also adjust the brush’s Gravity 
Strength and start using Alpha 38 for the fi ner wrinkles. Work with 
smooth, loose brush movements, relying on your own intuition and 
experience. During this process, smooth and sculpt again until you 
get the shapes you want. You can also switch between ZAdd and 
ZSub modes.

12

Refi ne the curls 
Now move to the top 

part of the sculpt. Initially the 
workfl ow and brushes are the 
same as in the previous part, so 
create some horizontal folds with 
the Standard brush. Mainly use 
Alpha 38 here and turn Gravity 
on and off in the Brush>Depth 
menu to check your work. To 
create vertical patterns, use the 
Clay brush and then develop 
it further with the same Slash 2 
brush used earlier. Refi ne the 
shape of the curls with the Move 
Topological brush. Add some 
more volume to the horizontal 
folds using the Infl ate brush.

13
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Finishing touches
Finalise the model and render it for illustration

Complete the dress Add more volume to the folds 
with the Infl ate brush and pull down some parts that are 

lacking in gravity. Fine-tune the creases with the Standard brush 
and Alpha 38, then use the same brush with a very small Draw 
Size to add some texture to the fabric. Work with different Gravity 
settings and adjust interactions between the wrinkles. See how 
they react to kinetic and gravity forces and tweak the overall fl ow.

14

At the beginning, without 
knowledge of fabric dynamics, it is 
very diffi cult to sculpt believable 
folds. I recommend studying as 
many references as possible, 
observing different kinds of clothes, 
studying sculpture works – even 
taking photos of varied fabrics in 
different confi gurations and then 
trying to re-create them digitally. 
The more you practise, the more 
believable your effects will be. When 
you understand folds you can 
create any fabric without relying on 
references. It’s vital not to focus on 
one area at a time; fi rst establish 
larger folds, their direction and 
placement, and keep in mind fabric 
qualities and gravitational forces.

Practise 
makes perfect

Facial expression AOur goal is to show that our Dryad enjoys the presence of 
a tree (she’s the spirit of a tree, remember). To change her neutral facial expression to 

something with more character, fi rstly re-sculpt her eye a little to a half-closed, sleepy shape. 
Mask the lower lid and lower half of the eyeball with the Layer brush and then work on upper 
parts of the eye with the Clay brush. When the upper eyelid is lower, use the TrimAdaptive and 
Smooth brushes to create the correct curvature of the lid. To fi nish, use the Pinch brush to 
sharpen the edge. To create an elusive smile, decrease the model’s subdivision and use the 
Move Topological brush to move the corners of her mouth slightly.

15

Apply materials I’m going to re-create materials 
from a similar, older illustration. Before we start sampling 

information we need to prepare our tools. Choose a Plane 
primitive, convert it to Polymesh3D, draw it on the canvas and 
enter Edit Object mode. Choose a Flat Color material, then in the 
Texture menu import an image to sample information from and 
add it as a texture to the Plane. Drop it on the canvas and choose 
a sphere – an object to check the new material. Draw it on the 
canvas in Edit mode beside the Plane and choose MatCap 
White Cavity material from the ZBrush library. Pick the MatCap 
tool and start sampling from the illustration reference. Click the 
image and drag the cursor until a red arrow points outwards. 
Repeat this several times, bearing in mind the direction of the 
facing surfaces. When happy with the colour, hit Cmd/Ctrl and 
start grabbing the highlighted areas. Doing this we can create 
specular highlights.

16

Create illustration 
Use Best Preview 

Render to render the image in a 
few separate passes: different 
MatCap materials, Ambient 
Occlusion and Shadow from 
one main light source. Fill each 
SubTool with a different colour 
and render it with a Flat Color 
material – it will be the mask 
for easy separation of each 
SubTool for post-production. In 
Photoshop, apply a layer mask 
to each rendered MatCap layer 
and experiment with different 
material confi gurations. To 
fi nish the illustration, import a 
Shadow pass and Ambient 
Occlusion and set them to a 
Multiply blending mode with 
customised opacity.

17
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Photoshop is quite capable of being utilised to 
the same effect of more-traditional mediums. 
Brush styles can simulate markers, coloured 

pencils, watercolours and even oil paints. Like any artistic 
format, the best way to become familiar with such options is 
by experimenting with them. 

In this tutorial you will learn how to accomplish 
comicbook styles using Photoshop from start to fi nish. 
Digital illustration is at the heart of this approach, because it 
enables a great amount of control to create such stylised 

results, which simply can’t be found in real-world media or 
many programs other than Photoshop. 

The techniques covered in this tutorial don’t require any 
additional tools that aren’t already available in Photoshop. 
All the effects and techniques covered can also be applied 
using older versions of Photoshop. We’ll be exploring how to 
target image areas using Lasso controls and the Magic 
Wand tool, then using standard brush presets to paint to 
these specifi c areas. We’ll also look at ways in which fi lters 
and blending modes can enhance your image.

Comicbook heroine  Photoshop

Emilio J Lopez Animator

Use Photoshop’s brush styles and other tools to create 
high-impact comicbook imagery

Character concept
Simple thumbnails and block colour using Lasso controls

Paint a colourful 
comicbook character

Map your ideas First we’ll 
design our comic character 

– in this case a comic heroine. One 
rule to remember is that audiences 
should be able to recognise your 
character even if it’s silhouetted. 
Also, if the character has any logos or 
symbols, we should include them on 
the design.

01

Make thumbnails Make 
multiple drawings before 

settling on any single composition. 
Use the default round brush with 
Shape Dynamics and Transfer turned 
on. Set the Control options to Pen 
Pressure, as this will enable us to 
create thick, thin, light and opaque 
lines, which is great for sketching.

02

Finish the Sketch Once you’ve 
settled on a thumbnail concept, start 

to refi ne your sketch. Use multiple layers to 
separate drawn elements, for example in 
the foreground, midground, background 
and other elements such as the visor of 
our heroine’s helmet. This will keep things 
organised later on.

03

From sketch to 
fi nished comic art

Working

Step 01: Concept design

Step 04: Colour fi ll

Progress

Step 07: Paint character

Step 17: Special effects

Fantasy Art Genius Guide  53

Fantasy Art
Genius Guide



Select with the lasso There are two types of Lasso tool controls: Freehand and Polygonal. You 
should use the Polygonal Lasso to apply straight edges to areas such as the fl ame jets coming from 

her feet and her trail, which signifi es momentum. Use the Freehand Lasso tool to make selections of oval or 
rounded shapes, such as the lips or eyes. We can toggle between the two while applying live by holding the 
Opt/Alt key and releasing the mouse button or lifting your stylus pen off the tablet surface.

Colour holding  Using the techniques we’ve just covered, 
continue to apply selections and fl at colour throughout the 

image (see the supplied example). Once fl at colours are spread, 
duplicate them and the line art. Now we’ll make sure that our line 
art’s Transparency is locked and proceed with colouring in the lines 
themselves. This is referred to as a colour hold or self line. When our 
colour holds are complete, we will merge our copied line art with these 
new coloured layers, with the exception of the visor.

Magic wand colour 
fi ll  Make sure to lock the 

Opacity of each of your drawn 
layers and ensure each one has its 
own colour layer underneath. Now 
we select the Magic Wand tool, 
turn off Anti-Aliasing and set it to 
Contiguous and Sample All Layers. 
Select the empty area around 
your line art and hit Shift+Cmd/
Ctrl+I to invert your selection. Next 
choose Select>Modify>Constrict, 
repeating application until the 
selection inside reaches the edges 
of your line art. Hit Opt/Alt+Delete 
to fi ll the image.

Make more fi lls Now the image is fi lled, 
lock the Opacity of its colour layer and use 

the Magic Wand tool to select inside the line art. 
Once selected, go to Select>Modify>Expand. 
Sometimes, because of unclosed or incomplete 
line art, the Magic Wand will bleed out into areas you 
don’t want to colour. We can clean up our fl at colour 
areas by using the Lasso tool, applying fl at colours 
and detailing areas. We can also use this tool to 
target the areas we want to select., but remember to 
deactivate Anti-Aliasing.

04

06

07

05

Expand 
and 

contract 
actions
Instead of choosing 
Select>Modify to Expand or 
Contract selection edges, you 
can create an Action from 
these functions. First make a 
selection then go to Actions 
and hit the Record button. 
Choose 
Select>Modify>Expand, add 
a value of 1 and stop 
recording. To fi nish, name 
your action, give it a hot key 
and repeat to gradually 
contract selections.

Character
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Background painting At this point 
it’s time to hide all the foreground layers 

but not the background. Painting this before any 
other special or rendering effects helps, as it’s the 
focal point for lighting in our piece. We’ll paint the 
background using our preset Photoshop brushes. 
Select the Round Fan Stiff Thin Bristles brush in the 
options and activate Shape Dynamics, Transfer and 
Wet Edges. Set the Control Options to Pen Pressure, 
as this gives us a more natural, painterly look.

Review your progress We’ll start by selecting our fl attened character colour layer. Use Chalk 
brushes to lay down the fi rst indication of light and shadow in the contours of the character, then try to 

work with the whole fi gure at once to get a full sense of the lighting in the piece.

Apply to the face Select the fl at colours 
of the face and use the Splatter brush with 

the preset options mentioned to render contour. To 
better render faces you can make a bespoke oval-
shaped brush by going to the Brush Preset options 
and selecting Brush Tip Shape. Now adjust the 
Roundness values to edit the existing brush shape 
into an oval. You can adjust the direction of the brush 
as well as the spacing to create different effects. Any 
brush can be distorted in this way, so experiment and 
see what works best.

Build up hair 
and clothing 

Select the hair from your fl at 
colour layer. When rendering 
the hair, use the oval round 
brush we created in the last 
step and pay attention to 
your light source and the 
direction it falls. Splatter and 
Round Fan Stiff Thin Bristles 
brushes work really well 
when applying hair. When 
rendering a shiny outfi t you 
should remember that it has 
a refl ective surface and will 
pick up any stray light in the 
environment, often including 
hot spots. 

08

09

10

Paint your character
Use preset brushes to ev0lve contour and texture

Use reference 
imagery to help 
with lighting, 
examining how 
light and 
shadow react

Use references of 
clothing and materials 

to see how light 
refl ections can vary

Choose a pose that 
engages the 

viewer and offers 
maximum impact

11
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Create the visor Now that the initial painting is done, we can begin work on the 
visor that lies over the face. Turn off all of your layers except your character line art. 

If you haven’t already added a colour fl at of the visor, do so by using the Magic Wand 
selection techniques discussed in Steps 4 and 5. Duplicate your line art and your fl at colour 
once more, but this time don’t merge the line art with it, as we’ll need the line art to do some 
colour holds later.

Add colour holds to the visor Set your amber-tinted visor layer to Multiply and 
lightly paint the eye area white using a feathered brush. This will enable the colour of the 

eyes to show through the tinted visor. Go to your duplicated visor line layer and paint lines based 
on the background lighting. Now create another layer under the line art layer, so that we can 
create the indication of raised glass. Use a small round brush for this.

Focus on the details Use a small round brush for 
minute details and tighten up any loose lines, like on her 

hands or the logos on her arms. Add hot-spot highlights and 
refl ections, then use a round soft-edged brush to lightly smooth out 
her uniform and face. Don’t overdo the feathering in this brush style 
as you’ll want to soften the surfaces, not totally blur them. You won’t 
want to lose your strokes and detail, so try setting the brush Opacity 
to 40% to soften the effect.

Visor tint and shadow Now the visor is fl at-coloured, 
make sure that the Opacity is locked and use a feathered 

brush to colour it in. Try using bright- and dark-amber tones to 
indicate light. Next we’ll create shadow on the face created by the 
visor on a separate layer. Make sure that this shadow layer is under 
the main visor fl at colour, again using the Lasso tool. Once the 
shadow is drawn, set the layer to Multiply.

12

14

13

15

Add finishing touches and effects
Use Photoshop blending modes to create your character’s visor
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Bring in the special effects Create a new layer and set it to Linear Dodge Add. 
Take a feathered brush and start painting on top of the blue tones in the image’s blue 

lighting and energy effects (see the example) to improve the glow effects. On the same layer, 
colour pick from the background and apply similar glow effects here. Create another layer set 
to Multiply, adding dark gradients on the left and right side. Apply the oval brush on a new layer 
to create a lens fl are from the glowing hand. Use an electric, blue, small round brush to add 
accents to the heroine’s suit.

Use grain Create a new layer and fi ll it with grey, making 
sure it’s not too dark. Go to the Filter options and select 

Texture>Grain, setting Intensity to 27 and Contrast to 25. Hit Cmd/
Ctrl+Shift+U to make the grain into a uniform grey. Now set the 
layer to Overlay at 47% Opacity. This layer serves two purposes, 
adding a bit of texture to our piece, but also lightening the whole 
composition slightly.

1817

Insert more 
highlights 

Duplicate your fl at colour 
again and make sure the 
Transparency is locked. 
Place the layer between 
the detail layer and your 
amber-tinted visor layer. Fill 
the new visor with black, 
then paint the details 
and shines based on the 
background and previously 
established lighting. Use 
an oval-shaped brush and 
a feathered round brush 
to paint light shines. When 
you’re done, set your layer 
to Screen.

16Quick 
Tip

Switching through different-
sized brushes can be a bit 
cumbersome, especially if you 
want to quickly change to a 
smaller version of a brush 
you are using. Try using the 
square bracket keys ([ and ]) 
to expand or constrict your 
brush sizes. 

The simplest of features can say a lot about a 
person, from the shoes they wear, the look on their 
face, or even simply how they present themselves 
in public. If you look hard enough you will fi nd that 
everyone wears a story on the surface. As an 
illustrator you need to pick up on these subtle 
things and apply them to your own work. Every 
little bit counts toward the believability of your 
character no matter how fantastic it is. Observe the 
world around you and let it inspire you to create 
worlds of your own.

Good 
advice
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Character

Use DynaMesh wisely. I start using DynaMesh on a very low 
level. In this case I have it set to 48, but depending on how 
large your model is the resolution will differ. At the early 
stages it’s almost like what you do with sketching: blurring 
your eyes to start visualising where the forms are, and 
quickly laying down broad strokes to fi nd the design. 
DynaMesh is extremely useful at this stage and can be used 
in the entire sculpting process. However, I prefer to use it as 
a base generator and subdivide further. Later I want to be 
able to drastically pose this character, so having a lower 
subdivision level helps with this.

Using DynaMesh
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Digital artists explain the 
techniques behind their 
amazing artwork
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Andrew Baker

Personal portfolio site
www.andbakerdesigns.
blogspot.co.nz
Country New Zealand
Software used ZBrush, 
Photoshop
Andrew Baker creates and 
conceptualises characters 
and creatures for physical 
and digital pipelines
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A bust or portrait is always a great place to 
start visualising a character. TZBrush enables us 

to conceptualise an idea to an extremely high level 

relatively quickly as well. We no longer have to go through an 

arduous technical process to create an eff ective, realistic-

looking 3D character.

Without getting too focused on the technical aspects in the 

3D process, I’d like to show how I generally start 

conceptualising a character by creating a bust and portrait. 

Due to the speed at which I execute such refi ned work, this is 

where I begin the conceptual stage of my project – often, in 

essence, cutting straight to the point.

Use primitives to establish a base 
Traditionally, it used to be quicker to start a 3D sculpture 

from a base mesh you had already created. I’ve always found 
this process a bit limiting on a conceptual level, though, as 
you are technically pushing and pulling a volumetric shape – it 
feels constraining. All of my design sculpting now starts from 
a sphere. With the use of Insert Mesh brushes and DynaMesh 
I can experiment with different shapes before locking into the 
base I’ll use to fi nish the sculpture on. Once I’ve got enough 
primitives there to manipulate, I use DynaMesh at a low level of 
48 and start sculpting.

The right geometry With this sculpture 
we’re trying to be fast, but effective. My goal is 

not to create a production model; however, ZBrush still 
enables you to create a high-res sculpt really quickly, 
so it’s worth having enough geometry to get you there. 
I fi nd it’s essential to get as much information in the 
lowest subdivision level before subdividing, so that I 
won’t need DynaMesh again. I keep design elements 
like horns and eyes on a separate SubTool to move them 
independently if I need to. I subdivide twice at this stage 
to begin sculpting further.

Design considerations I create several lines to 
highlight relationships on the face. The ears line up with 

the eyes to the point of the nose and from the nose outwards 
to the edges of his jaw. I generally think of character faces in 
triangles that are largely based on humanoid confi gurations. 
This can be pushed as far as you like – for example huge noses, 
tiny eyes, massive chins. It’s a game of consideration. Be aware 
of what’s working and what isn’t. This will be the design base for 
the following steps.
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The Satyr  2012  Photoshop,  ZBrush

Andrew Baker Digital artist

Learn to use ZBrush to create a fantasy character portrait, 
following Andrew’s Weta workfl ow

01

03

Design a 
Weta character

02

The aim of this tutorial 
is to create a fantasy 
satyr-type character. I 
want to create an 
overly stylised face for 
a fantasy genre that 
can be rendered 
realistically and create 
impact.

Concept

Source files
available

Find tutorial fi les on 
the disc

Conceptualise with digital clay
Get started on the sculpture in ZBrush
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Quick 
Tip

Using different shaders is 
a great way to tackle 
certain aspects of your 
sculpting and colouration. 
For my primary forms, I 
prefer to use a shader like 
MatCap Grey, which 
shows the forms off really 
well. When I start my 
secondary forms, I turn on 
the Blinn shader, as this 
has a nice general 
specular highlight, which is 
also good for showing the 
detail. I fl ick between that 
and MatCap Grey. The 
Skin Shader default is 
awesome for colouring 
fl esh-toned characters, 
and I use this a lot for my 
concepts as it displays 
really well.

Form, texture and pose
Let’s get the character into pose and refi ne the sculpt

Build the forms Now, with 
some extra subdivision levels, 

I build up some of the forms. Using 
the Clay Buildup brush I want to create 
direction for the surface and build 
up some secondary forms. Doing 
this on one of the lower subdivision 
levels can create some nice organic 
effects on the upper levels. I often 
switch between the lower and higher 
subdivisions at this stage to play with 
the options a little. I want to create 
a drastic pose for this character, 
looking over his shoulder, so I don’t 
want to get too precious about any 
forms at this stage, but rather block 
out the basis for his personality.

Put the character 
into a pose As our 

end goal is not a symmetrical 
production model, I want to 
pose it right away. I have a 
clear idea of how I’d like to 
present this character, having 
him look over his shoulder to 
create an asymmetrical bust 
and an interesting view for the 
portrait. I use Transpose Master 
to generate the pose. Be as 
bold as you can! It’s important 
not to marry to any forms at 
this stage and let it come out 
in the posed maquette. I also 
sculpt into the mesh while 
transposing, trying to fi x any 
broken anatomy as I go.

Tighten up the forms 
Now that the model is 

posed and I have some higher 
subdivision levels, it’s about 
refi ning those secondary forms, 
like the cheekbones, lips, brows, 
eye sockets and so on. For me, 
there’s no better brush than the 
Clay for this. It creates very nice 
crease lines, which can start as 
the base for our wrinkles. I fi nd 
the Clay brush, if treated right, 
can give some nice results to 
the higher subdivision levels, 
using the Smooth brush to 
soften where needed. I also 
play with the shape of the horns, 
considering how they affect the 
overall silhouette more, now 
they’re on the posed character.

04

05

06
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Pores and extra 
texture To create 

another level of focused noise 
in areas, I use the Standard 
brush with a Scatter effect and 
a very small Point Alpha. I turn 
the Z Intensity slider quite low 
and increase the size of the 
brush and intensity as needed, 
especially on the shoulder 
and chin areas or anywhere I 
think a specular highlight might 
appear on the fi nal piece. I also 
use DamStandard with a really 
low intensity to create very fi ne 
wrinkles, going in the direction 
of the skin compression.

Detail and texture I am now happy with 
the secondary forms and can start to see 

where my detail needs to go. DamStandard is my 
new favourite brush for going into these soft forms 
and giving them some sharpness. They fold into the 
surface and create a pinched, V-shaped crease, 
instead of a U-shaped crease like the normal 
Standard brush makes. I also add a noise pass to 
create the pore effect on the surface. Playing around 
with the scale and intensity of the noise function 
can create awesome pore- and skin-like textures. 
Experiment with this feature to really get a grasp of 
just what it can achieve.

Refi ne detail with colour Because ZBrush enables 
us to affect the form while adding colour, I go back to my 

DamStandard brush, turn the RGB down very low with a brown 
colour and start to tighten up some of the wrinkle details. I also use 
the Infl ate brush to push all the details tighter together.

Add some colour As colour will greatly affect how our texture is shown, I want to start 
adding that in, treating the detail of the surface and colour now at the same time. I start 

off by adding a very light base colour, covering the whole model. I use the default skin shader 
as this shows up colouring for skin very well – and all in real-time. I layer up the model with reds, 
blues and yellows for the underlying blood vessels to wash with a fl esh colour and soften in 
areas. I also mask out the cavities to add some dirt.

0807

10
09
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Give him some ink I want to add another element to this character that isn’t 
necessarily a costume accessory. I’m thinking of a large religious-style tattoo on the 

character’s back. I create the tattoo in Photoshop as a fl at template then use Spotlight in ZBrush 
to project it onto my character. Spotlight is another great way to project any other further texture 
onto your characters.

Get creative Without going too far and crashing your 
machine, you can have a lot of fun creating different hair 

around the face. Masking areas like the tips of the ears is a nice 
touch, I fi nd, while creating some scraggly sideburns can also 
be effective. There are lots of options to play with, so I suggest 
spending some time to get used to what’s possible. I always take 
time to manipulate with the brushes afterwards, so I can be sure to 
create a much more effective look.

12

13

Quick 
Tip

Depending on how long I have to get an image done, I sometimes 
spend a bit of time playing with the hair and positioning tattoos. 
These are often things that can be explored in 2D for conceptual 
pieces, but it never hurts to have something 3D there for the fi nal 
render. All of what’s been done so far has been done very quickly 
without getting too consumed with technical aspects. If it’s not 
working in 3D, solve the idea quickly in 2D by doing paint-overs 
before committing to the 3D render. This can also be really handy 
to show a client for variations.

Final touches and presentation
Finish the painted sculpt and get it ready for maquette presentation

Add the hair 
Another hugely 

innovative tool from 
ZBrush is FiberMesh. 
This is a great addition 
to the process as things 
like hair really add a nice 
touch to a character like 
this. By simply masking 
off areas where I want 
there to be hair, I turn on 
the FiberMesh button 
and begin to adjust to 
the different hair I’d like 
to add. I want some 
variation in the hair 
around him, but I want it 
to be quite thin, 
sparse and wiry.

11
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A perfect comp 
Having the composition 

in mind from the beginning 
will certainly help you get 
to this stage quickly. This 
way there’s no unnecessary 
sculpting and the entire 
process is geared towards 
aiding what we want to show. 
I aim to create an interesting 
pose that isn’t front-on to the 
character, thereby enhancing 
his silhouette a little. Having 
the sculpt turned to a grey 
shader (Blinn, in this case) and 
doing some quick BPR renders 
with the main light source will 
also help us judge how best 
to compose the character. I 
create my document in portrait 
at about 1,310 x 2,050 pixels, 
which will be the fi nal crop.

Render out 
layers for post 

Once I’ve established my main 
light source, and the shadow 
that is created by looking at 
the BPR render passes, I start 
to look at what else I can take 
to Photoshop to help this 
image along. I render out a lot 
of diff erent light passes on the 
various standard shaders turned 
to black. I use the BPR render 
passes, a cavity and refl ection 
pass. For SSS I use a standard 
shader set to red and amp up the 
ambience. Then I just need any 
shader that looks like it might 
do something interesting in 
Photoshop.

14

15

Render and capture the essence of the sculpture in post

Compose the final image

The fi nal composition I generally experiment a 
lot with blending options on the passes I’ve rendered out. 

Because this guy has human skin and I’ve painted the model, the 
initial render gave me a lot to work with. This is the great thing about 
this process and leaves us a bit of time to spruce up the image. Using 
the Z-Depth map and changing the colour while turning it to Overlay 
can create some nice depth eff ects. Refl ection and Light maps can 
be used to create interesting eff ects for the eyes, too. At this stage, be 
experimental and have fun.

Post-production Once I’m happy with the blended 
layers, and they’re all doing what I want, I can really start to 

have some fun. A background can be used to make the image look 
more of a studio shot or something more photographic. As this 
image could be used as the base for many design passes, I’m not 
shy about painting over areas that need further attention – even 
using photographs – although I only ever use photos to add noise or 
textures where I can. Sometimes it’s unavoidable, but if I’m sculpting 
a character like this, there’s really no need.

Quick 
Tip

It’s vital to experiment with 
different shaders and 
effects in ZBrush. There’s 
no limit to the variation of 
materials and textures you 
can create in ZBrush 
without the use of photos 
or alphas. Designing and 
creating characters in 3D 
and getting realistic 
results doesn’t have to be 
a laborious process 
anymore. Also, keeping a 
library of references will 
always aid the creative 
process and arm you with 
a catalogue of ideas.

16 17
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My aim is to highlight what I wanted to 
achieve with this illustration of a fox spirit, as 
well as my concept art and design process in 

general. As a professional concept artist, I start every 
piece with a picture in mind of the artwork I want it to be, 
but it does change and evolve throughout the process. 
My advice to anyone going into concept art is to watch a 
lot of movies, look at a lot of art and read a lot of books. 
Other media is full of things that can infl uence and help 
you realise the kind of character you want to create. I was 
infl uenced by martial-arts movies, Asian folktales and 
novels, as well as an underwear fashion show while 
creating this character! Don’t be afraid to draw from many 
different sources, because the way you put them together 
makes something that is uniquely yours. 

I wanted to create a sexy oriental woman who was 
attractive but lethal at the same time. I therefore looked at 
fi ctional characters that exemplifi ed this. The inspiration 
for her design was derived in part from the character of 
Snow (played by Brigitte Lin) in the martial-arts movie 
Deadful Melody (Liu Zhi Qin Mo). The central character 
has to protect a powerful and beautiful Chinese musical 
instrument, known as the magic lyre. Inspired by this, my 
character stands with her hand on a lyre-type instrument, 
known as a zither in the West and a guqin in China.

The role of Daisy in the ancient Chinese novel 
Investiture of the Gods had a profound impact on my 

design ideas too. In the novel, a fox possessed Daisy. Her 
coquettish beauty captured the heart of the king, and the 
country was paralysed. In the East, charm and magic are 
often symbolised by the fox in this way, and legends of fox 
spirits are also found in Chinese, Korean and Japanese 
folklore. Fox spirits can change their shape at will into 
beautiful women and live for hundreds of years. Their 
myths are similar to English stories of fairies; they can cast 
illusions over places and take people out of time.
Sometimes evil, sometimes good; but fox women are 
always beautiful and clever. I wanted to bring this into my 
piece of concept art to give it a distinctly oriental fl avour. 
Fox women feature in some manga too, so I was 
confi dent that Western viewers would at least be familiar 
with them as an Asian art staple. 

At the beginning of the drafting stage, I placed the 
image of the fox into the design, positioning it on the 
shoulder like a fur coat. I also developed the eyes to look 
out at the viewer. In the fi nal draft, though, I removed the 
shoulder design and gave her fox ears instead. When 
creating concept art for a character, the viewer must focus 
on one thing, and that’s the character. I felt the fox’s eyes 
were distracting and pulling focus away from my woman, 
so they had to go. Pay attention to what an image tells 
you even at the sketch stage. If it looks too busy, the 
shapes don’t look right or the eye isn’t drawn to where 
you want it to go, then you need to change something. 

Quinnv  Photoshop

Zhonglu Zhao Digital artist

Paint a fox spirit, taking inspiration from scenes in martial arts 
movies and model references

Digital artists explain the 
techniques behind their 
amazing artwork
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Zhonglu Zhao

Personal portfolio site
fi reluzhao.cghub.com
Country China
Software used Photoshop
I live in Shanghai, where I 
majored in printmaking. 
After graduating I have been 
engaged in the game 
business. I love this career 
and hope I can create my 
ultimate job within it.

Design a magical 
character

Determine her action and structure with a simple silhouette without going into too much detail. At this stage you should 
have a clear design direction
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Use coloured layers to 
build up vibrant art 

Working

Progress 1: Silhouette

Progress 2: Use one brush

Progress

Progress 3: Alterations
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Zhonglu Zhao shows us 
his other masterpieces

She and I
2011, Photoshop

 The idea behind this picture is the 
relationship between my wife and I. 
Although the wall has been damaged 
and the roof is leaking, I hope that no 
matter what, I will be able to protect this 
loving environment

Comfort
2010, Photoshop

 In this piece I aimed to create a 
harmonious atmosphere taking visual 
inspiration from birds and crocodiles. 
Instead of presenting two opposites or 
a frightening monster, they are in 
coexistence. I wanted to express the 
themes of love in life in this work

Syracuse
2010, Photoshop

 I painted the scene as a futuristic 
vision of the city Syracuse. It looks very 
grand and sturdy, even though it was 
rendered in a rather relaxed style. I tried 
some new techniques to create a 
heavy feeling

Keeping a strict light source in mind, I added realistic 
shadows onto her chest and collar. In the strongly lit 
areas I added more detail, and toned down the detail 

in the dimmer parts. Remember that not every material 
will refl ect light in the same way. Silk, for example, is 
smooth and transparent, but the refl ections on metal are 
much stronger. I also added a backlight to make the 
character seem more three dimensional. Finally, I 
added a hint of texture on the fabric of the sleeves 
and chest to complete this portion. 

Pay attention 
to what an image 
tells you at sketch 
stage

Once I’ve roughed out the pose and silhouette, I focus 
on the head and face, where most of us look fi rst. 
Designing the head, I thought of the movie The Bride 
with White Hair, and the role of Bingbing Li in The 
Forbidden Kingdom. I therefore gave her white hair. 
The risk is that this can make a character look too old, 
so think carefully about how you’re going to render it. 
Casting it with yellow or grey will make your character 
look like they have aged white hair. Casting it with faint 
notes of blue, platinum or purple makes it look like they 

naturally have frosty-white hair, keeping them youthful 
and unusual.

In my early sketches I experimented with making my 
character’s hair accessories look like the tail of a 
scorpion. This made her look defi nitely evil, rather than 
the sense of ambiguity I was aiming for. Once I started 
to incorporate the fox ears, the scorpion design looked 
out of place so I removed it. It’s important not to fi ght 
with an image. If something isn’t working, change it! 
The fox ears became the focus of her accessories; 
they’re what make her face stand out and grab 
attention. I used a lilac-toned white for her hair, so the 
eye is automatically drawn from the tips of the ears 
down to the face. 

The design of the clothing was meant to be a 
combination of loose and tight, fl owing and clinging, to 
really emphasise her sexiness. The sleeves are tight 
fi tting but then fl are out, while the skirt skims her body. 
The exaggerated high heels make her more 
statuesque. This heightens the perception that she’s 
very slender, giving even more of an impression of an 

I meticulously painted the Chinese musical instrument, 
added a ponytail for my fi gure and she was basically 
complete. 

I gained a lot of inspiration from watching a Victoria’s 
Secret video. I drew two sketches very quickly and chose 
the one that I felt best conveyed the effect I wanted. 

Materials and light
Strengthen contrast and add detail

Before

After
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Rough sketch I drew a simple silhouette and 
lines to show her outer contours. The corner of 

the eyes are tilted, chin sharp and the hair colour black.

01

Develop the 
head

How to paint the head from 
sketch to fi nal render

Overlay colour I used overlapping to colour, 
then built another layer for the light source. The 

hair colour changed to white and her mouth open. 

02

Add details Saturating colours in the lighter 
parts made highlights and shade more apparent. 

I also added smoky eyes, a beauty spot and earrings. 

03

Modify and complete Adjust proportions, 
lighting and detail. Her earrings became blue, 

and headgear design changed to the fox ears instead.

04

otherworldly, magical character. The overall pattern is 
moiré, a double-overlaid grid that creates a shimmering 
look, adding to the magical element. 
I changed this design several times. One thing I added and 
then removed was a lantern. Fox spirits are often 
associated with them so I initially placed one on her thigh 
underneath her sleeve, but quickly decided that it was too 
eye catching. 

I spent time watching a video of models posing for a 
lingerie company so I had more of a sense of how women 
move when wearing these kinds of clothes. As I looked at 
the way the garments fell, I introduced more fl owing shapes 
and asymmetry in order to make the image feel more 
energetic and elegant. 

Most of my effort went into the design, so production 
methods were relatively simple. I added new techniques 
into the more complex or improvised parts; some to 
achieve the shimmering, painterly effect and others just as 
personal exploration. I’ve become used to painting with one 
of Photoshop’s preset brushes from start to fi nish, always 
with the Wet Edges setting. Using just one brush is good 
practice as it helps create a more uniform image. Simply 
change the colour you use, or modify the settings to make 
the brush effect wetter or drier. Using different layers or 
modes like Screen or Multiply, or even using the brush as 
an eraser, can reveal underlying colours, deepen or 
brighten them. If you’re used to using different brushes this 
can be a hard technique, but with practice you will master it 
and create some skilled renderings. 

I think concept artists should stick to no more than three 
main hues. This image is magical and otherworldly so 
makes use of purples, reds and yellows. Other colours 
should only be used for embellishment. Follow this advice 
and you’ll be creating magical concept art in no time!

I felt that the piece needed 
an overall boost of contrast. 
I used Photoshop’s Curves 
adjustment for this and began 
working seriously on the 
highlights and shadows. 

The effect was beginning to 
get slightly muddy, so I drew 
out more details and made 
further adjustments to the 
colour tone. 

I painted over the original 
design according to my new 
sketch to tweak the pose and 
some of her garments.

During any creative 
process, the 
temptation to give up 
can be strong. This is 
often the case if you 
feel the design is 
moving too far away 
from your original 
concept. If you spend 
time studying 
references and styles 
early on and modify 
the design at the 
concepting stage, 
you will be much 
happier with the 
result and less likely 
to give up.

Create a 
character
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90 Develop fantastical animals
98 Master expert creature renders

Bring mythical beasts to life

Creatures

 When 
designing a 
creature, a good 
place to start is 
the head
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Digital artists explain the 
techniques behind their 
amazing artwork
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Benjamin Erdt

Personal portfolio site
www.ben-erdt.de
Country Netherlands
Software used Maya, 
Modo, ZBrush, MARI, 
Photoshop
Character and creature 
artist, utilising a range of 
techniques and styles.

This sea monster was created so I could 
practise creature modelling and texturing at a 
large scale. The following tutorial will guide you 

through the processes I learned, from inspiration through to 
fi nal render. By the end you should have developed an 
understanding of how Maya, ZBrush, MODO, MARI and 
Photoshop can be used to tackle such a project. The 
Leviathan was a very complex task in terms of modelling, 

texturing and composition. The following steps will 
demonstrate how the model can be built, textured and 
rendered. Furthermore, we will take a closer look at how 
such a huge and daunting task can be approached and 
executed effi ciently. This project helped me to gain 
experience in the creature modelling and texturing fi eld. 
Hopefully by exploring the process of creating the Leviathan, 
you’ll see how this workfl ow can benefi t your own projects.

Terrorfish – Leviathan  2014 Maya, ZBrush, MODO, MARI, Photoshop

Benjamin Erdt Professional 3D artist

The idea behind this project was to create a highly complex and 
detailed sea creature, from concept to model and fi nal render

Master the art of 
creature creation

Source files
available

Tutorial screenshots

We’ve only explored a relatively small part 
of the sea, so I can only imagine what else 
might live down there. Due to my 
fascination with sea-life – especially 
deep-sea creatures – and inspired by 
monster myths, I wanted to create my own 
interpretation of a Leviathan beast.

Concept

Creatures
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Inspiration and research
Develop your ideas and gather reference

Set your goals For this project I conceived the 
Leviathan as an enormous creature living in the ocean. To 

get a sense of the scale, I imagined that an aircraft carrier would 
be a little toy compared to its size. The song lyrics of a well-known 
pirate metal band describe the hunt for a Leviathan as well as 
the fi ght, which were the initial sparks of inspiration to design and 
create the beast in 3D. We want to make a creature that is a hybrid 
between several aquatic animals with an emphasis on deep-sea 
fi shes. Gather reference images – for this project, I went for images 
of viperfi sh, anglerfi sh, squid, sea snakes, whales and prehistoric 
sea creatures as well as reading articles about recently 
discovered species. When gathering animal reference images 
it’s worth visiting sites such as  www.thefeaturedcreature.com. 
Along with a large database, it is updated weekly with images 
and scientifi c information about bizarre, beautiful and recently 
discovered species of the animal world. Compile your image 
references and print them out so you don’t have to repeatedly load 
them up while working.

Work on overall shape When combining 
your varied sea creature reference elements 

into an overall form, make sure that the Leviathan looks 
convincing for life in its habitat. When straightening 
the body from tip to tail, the overall shape still has to be 
dynamic and functional for proper swimming. Check 
the image for step 3 supplied with the disc – it shows the 
straight body from a top view and compares the detailed 
body with a blurred version. You can see that even with its 
enormous size and complexity, the shapes of the creature 
can be broken down into a simple fi sh. This is important for 
readability and therefore a believable design.

Start designing It’s the head that will defi ne the whole character, so let’s start 
working on this fi rst. To make our beast look more aggressive, double his lower jaw into 

an inner and an outer one. We can also add four individually sized eyes on each side. Based on 
the anglerfi sh, we want to give him fl uorescent tips that illuminate his face. This will help to draw 
the viewer’s eye to the creature’s head in the fi nal image. To support the transformation from a 
rather humanoid upper chest into a whale-like design, let the limbs morph into fi ns as they go 
down the body. In order to add more continuity and consistency to the overall design, make the 
tips of the large back fi ns elongate until they become long tentacles.

01 02

Keep it 
simple

When learning how to sculpt 
or draw a skull, a general idea 
is to break it down into simple 
planes and primitive shapes. 
It’s worth referring to Eliot 
Goldfi nger’s Human Anatomy 
for Artists to look for examples 
of this. Tweaking the 
proportions and silhouette of 
the design is also an easier 
task when dealing with simpler 
shapes. Applying this process 
to your designs is important to 
make even the most 
bizarre-looking creatures easy 
to read and acceptable to the 
human eye. The ways that I 
check design readability are 
by squinting my eyes and 
blurring the image, or having a 
copy of the viewport window 
that shows the model from a 
greater distance.

03

Creatures
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Model the creature
Start building the beast’s head and model the body shape

Model the eyes Most of my creature 
projects start with the head, as it is the 

most important part of the fi gure. The best place 
to start is with the eyes. My reference for the look 
of the eyes was the prehistoric fi sh known as 
Xiphactinus. Using Maya, create a PolySphere 
for the fi sh eye, fl atten it a bit and start building 
the eye socket around it with standard polygon 
modelling techniques. Starting with a single 
polygon, work your way around the eye by 
extruding edges, adding edge loops, cutting 
faces as well as pulling and pushing components 
into shape. Repeat this process for each of the 
eyes. Keeping the eye sockets separate will make 
it easier to tweak their relative positions.

04

Develop the head The head is 
obviously very complex, so we need to 

spend a good deal of time tweaking to make 
it accurate. We should start by blocking out 
the parts that contribute the most to the overall 
shapes and silhouette. In this case these are the 
eyes, the glowing antennas, the placeholders 
where the scales will be, the tentacles surrounding 
the head, the teeth, the jaw lines and the basic 
layering of the skin around the cheeks. Keeping 
these parts separate makes it easier to adjust the 
silhouette. Once we’re happy with the silhouette 
and shapes, fi ll in the spaces in between and 
stitch the parts together.

05

Create the body and limbs The 
body is created in much the same way as 

the head by modelling very rough representations 
of the features. Lay down the basic foundation for 
shapes, silhouette and volume. Once the correct 
proportions are established, continue adding 
more defi nition and detail. From time to time we 
should take a break from working so that we can 
look at it with fresh eyes when we come back. This 
helps to spot any proportional issues. 

06

Benjamin Erdt
I have been fascinated 
by Sci-Fi universes and 
fantasy movie creatures 
since I was a child, so I 
trained myself in CG art 
so that I could make my 
own. Here are two other 
projects that I have 
invested a lot of time in.

Saric/Killzone: Shadow Fall Maya, ZBrush, 
MODO, Photoshop (2013)

 For Killzone: Shadow Fall I worked on Saric’s head, 
creating the high-poly, game mesh and textures.

Monster Concept Maya, ZBrush, Photoshop 
(2013)

 One of the monsters that managed to make it from my 
sketchbook into a fi nal 3D render. 
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Add scales Most of the scales are 
separate objects and are not modelled into 

the body geometry. By approaching the scales this 
way, we can give them individual UVs and therefore 
greater texture resolution and detail. Four different 
types of scales should be created as a starting 
point – bigger plate-like scales to go along the tail, 
medium-sized scales for the back and shoulder 
area, U-shaped scales going from the chest down 
to the belly and smaller scales to be used as t
rims to create a transition to the skin. All of these 
different scale types should be copied, 
transformed and tweaked by hand across the 
body. This is a very time-consuming process, 
but it will give you the cleanest and best results 
for both the design and articulation.

Clean up After the modelling is complete, 
clean up the scene to prepare it for creating 

UVs. This includes deleting the history of all objects, 
snapping their pivot to the world space centre, 
freezing transforms, checking for fl ipped normals 
and deleting unused nodes and empty groups. 
Naming all objects properly helps to maintain the 
overview of the model. Proper naming can also 
reduce issues with scripts that need to iterate through 
your outliner. After the clean-up process, the entire 
creature model is organised and ready for export into 
MODO. The same hierarchy in our outliner is going to 
be the folder structure for the OBJ fi les. Each OBJ fi le 
has the same name it has in Maya to make it easier 
to rebuild the outliner hierarchy inside the MODO 
item list.

Unwrap in MODO Before creating UVs, think 
about where we want the texture seams to be and 

which objects are going to share the same UV space. I 
decided to go for a maximum of 4096x4096 texture maps as 
they have enough density for the targeted render resolution. 
Larger texture maps would lead to longer loading times and 

slowdowns while painting. The torso is the largest object and 
therefore it needs to be split into nine individual UV patches. 
The scales are packed together with eight to 20 scales in each 
group, depending on their size. Here a texture resolution of 
2048x2048 per group is enough to reach the desired detail 
level. Unwrap and import back into Maya for the next step. 

07

08

Tidy up the scene
Clean up the scene and import into MODO to create UVs

Stay 
clean

When working on a large 
project like the this, think 
about what could be done in 
advance to stay organised 
and effi cient in later stages. 
Before creating any polygons, 
start thinking about the 
targeted geometry resolution, 
which pieces are going to be 
separate, which parts are 
visually more important for the 
later render and which need 
extra attention. During the 
modelling process we’ll be 
working towards these 
specifi cations. Having a 
proper naming convention is 
helpful to maintain the 
overview of the scene as well 
as the project folder and to 
quickly track down objects 
that could cause errors. It also 
makes it easier to transfer 
objects between applications 
and ensures a smooth 
texturing workfl ow for the 
100+ parts that the creature 
model is built out of.

09

Creatures

74  Fantasy Art Genius Guide



Sculpt fi ner 
details Use 

ZBrush to sculpt surface 
details. Each OBJ of the 
creature model will be 
imported as a separate 
SubTool into ZBrush. For 
objects like the torso, which 
has multiple UV patches, 
use the UV Groups option 
in the Polygroups palette to 
assign a Polygroup to the 
parts of the mesh that share 
the same UV patch. This 
is going to be important 
for baking Displacement 
maps. In this project, the 
brushes that I frequently 
used for the model were 
the Standard brush, Clay 
brush, the Slash brushes, 
Dam Standard and Infl ate. 
To keep the sculpted details 
consistent, stick with one 
type of detail and fi nish it on 
all parts of the model before 
introducing new detail 
patterns. In areas where 
the pre-modelled scales 
needed to blend smoothly 
with the underlying skin, 
sculpt in scales to create the 
desired transition.

Create additional Bump 
maps The Displacement maps 

provide the necessary detail pattern and 
density when looking at the model from a 
distance. To visually support the huge size 
of the creature with an appropriate detail 
hierarchy, it’s worth adding a Fine Detail layer 
on top using additional Bump maps. When 
zooming in closer to the creature’s body, the 
Bump maps reveal the little details like pores, 
barnacles, wrinkles and other patterns. First, 
create a set of tiled grey scale maps using 
Photoshop. In MARI 2.5, the Tiled Procedural 
layer should be used to spread the maps 
across the model. By painting on the layer 
mask we can control the strength and 
visibility of the details. This process was used 
to create fi ve different types of skin detail, 
which were then combined together into one 
Bump map.

10

Texture painting
Use maps and layers to texture the Leviathan

Cavity 
maps

To have a guide while texture 
painting and so that you can 
bring some detail back into 
the individual textures, create 
a Fine Cavity map in ZBrush. 
The method that I use is quite 
old but still very effective. 
Choose the stock ZBrush 
MatCap SketchShade4 and 
import the particular 
Displacement map as an 
Alpha. By using the Crop and 
Fill Function (Alpha>Transfer> 
CropAndFill), ZBrush will 
generate a fl at map based on 
the height information of the 
Displacement map and the 
MatCap. This method tends to 
work best if the Displacement 
map is confi gured to have 
around 50% grey as 
no displacement.

11
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Block out colour After importing the 
creature into MARI and setting up all 

shaders and layer stacks, begin roughly blocking out 
the basic colours for the creature. As the beginning 
of this texturing process is very experimental, don’t 
use more than three different colours. The goal is to 
fi nd a fi tting colour scheme, pattern and hierarchy. 
Instead of painting on empty layers, use colour 
constants with masks, which will enable you to 
edit colours and patterns separately. Along with 
MARI’s masking and adjustment stacks, the colour 
blocking process will become very fl exible and less 
destructive. Once satisfi ed with the basic layers, 
move on to the next level of detail. We’ll work with 
the tones of the existing colours and use a variety of 
organic brushes and MARI’s procedural layers to 
add more variation to the skin and to blend between 
different colours and patterns.

Take it into Photoshop For 
fi nal texture edits and creating maps 

like Roughness, Refl ection, Normal/Bump 
and SSS layers, set up a PSD work fi le for 
each piece of the creature model. The image 
to the right shows the Photoshop hierarchy 
of one of the arm textures. The MARI pass 
is the base, while all additional texture edits 
are added on top in a group called Painting. 
Use the previously generated Bump maps 
as masks for more texture detail and to make 
them pop out more in the fi nal render. To bring 
back details of the high-res sculpt, we will 
generate a Fine Cavity map in ZBrush and 
blend it very lightly on top of the Diffuse.

12

13

Final rendering
Pose and render the fi nal composition

Pose the creature We’ll now create a low-resolution 
representation of the model to be used as a rig mesh and as a driver 

of the high-resolution geometry. This will make posing a lot faster as we 
won’t have to deform a multimillion polygon model. After posing the low-res 
mesh, switch to the high-res geometry to see the results. The rig consists 
of a simple FK driven joint hierarchy, which is suffi cient enough to pose the 
Leviathan for the render scene. Once happy with the pose, export all objects 
into MODO using a Batch Export script. In MODO, polish the pose by fi xing 
deformation issues and distortions caused by the skin weights of the rig. For 
this task, MODO’s Sculpting tools will come in handy.

Set the scene in MODO The model consists of 100 parts. Each 
has its own material, which is named after the object it’s assigned to. 

This helps to control the overview of the large Shader Tree. Before loading in any 
Diffuse, Roughness, Refl ection or other maps, do some test renders to check the 
Displacement and Bump maps. Regions with UV seams need extra attention as they 
can cause artefacts when displacing, or show cuts in the Bump or Normal maps. 
Once the Displacement and Bump maps render cleanly, continue adding other texture 
maps. For lighting, use an HDRI to provide the lighting information of an ocean storm 
scenario. To create the rim light effects on the creature’s left side, add an area light at 
the appropriate position. Another area light can be added to emphasise the specular 
highlights caused by lightning..

14 15
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Render passes When 
working on the fi nal composition, 

it’s important to be able to edit individual 
objects through masks, so you can 
adjust highlights, refl ection and depth, 
or to tweak intensity and brightness of 
each light. In order to gain full control 
over the features of the fi nal image, 
render out a number of passes. Next to 
the standard ones like Beauty, AO and 
Depth, render a pass for RGB Lights, 
Object Space Normals, Refl ection, 
Specular, Shadows, RGB Masks, 
Fresnel and fi ne AO. By disabling all the 
Bump maps, we’ll render an additional 
Specular pass of the highlights only 
caused by the Displacement maps. 
This will enable us to adjust the bigger 
highlights of the skin and scales. The 
image above shows some of the passes 
I rendered for the fi nal composition.

Tweak the fi nal composition Using the previously 
rendered passes and adjustment layers for colour correction 

like Brightness/Contrast, Color Balance, Hue/Saturation, Curves and 
Levels, we’ll end up with a base version of the composed image. This 
is going to be the starting point for the fi nal touches in Photoshop. The 
background is based on Cloud layers in combination with Custom 
Cloud brushes. For the water splashes, experiment with different types 
of Noise layers as well as Water brushes. Render passes allow for a lot 
of experimentation when creating effects and tweaking the image. The 
Depth pass can be used to create a depth of fi eld effect or as a mask 
for a Saturation adjustment layer. The fl uorescent lights can be used 
to draw the viewer’s eye to the face, as they are the only objects with a 
glowing turquoise colour. Flipping the image horizontally from time to 
time is a good way to refresh the eyes and to spot composition issues.

16

17

To 
end

Working on a project of this 
scale can be quite a 
challenge, but it’s also good 
training as it covers multiple 
disciplines of the design 
process, from modelling, 
sculpting and texture painting 
to shading, lighting and 
rendering. You also learn how 
to stay organised and think 
ahead. Breaking this project 
down into smaller steps made 
it easier to plan and was 
therefore more feasible.
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Digital artists explain the 
techniques behind their 
amazing artwork
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Ben Erdt

Personal portfolio site
www.ben-erdt.de
Country Netherlands
Software used Maya, 3ds 
Max, MODO, ZBrush, 
MARI, NUKE, Photoshop
Concepting and producing 
both hard-surface and 
organic models.

Lukruk is an armoured alien character I 
created as an exercise at Vancouver Film 
School. During this process you’ll get an insider’s 
view of his creation from the fi rst spark of inspiration 

to the fi nal render. By the end of the steps you’ll have a full 
understanding of how Maya, MODO, ZBrush, MARI, 
Photoshop and NUKE can be used.

Lukruk was a very complex project from both a design 
and technical point of view, so here you can get a closer 
look at how to design and build complex characters with 

rigging and animation in mind, without compromising the 
original design intent. I’ll also share my approach for 
keeping clean topology for effi cient subdivision, rigging, 
texturing and rendering. 

This project was a great learning experience for me in 
fi elds such as design, modelling, texturing, rigging, 
animation, rendering and VFX, as well as how to 
collaborate with other disciplines. I hope the little nuggets 
of experience shared here will help and inspire you with 
your own characters.

Lukruk – The Thelarian Elite  2012 Maya, MODO, ZBrush, MARI, NUKE

Ben Erdt Professional artist currently working at Guerrilla Games

Here I’ll discuss how I created a highly complex and functional 
armoured alien character, from concept through to fi nal vision

Design & model 
sci-fi creatures

Make a concept
Develop who and what your character is

Turn inspiration into a concept I imagined a futuristic knight 
standing on a high platform. Since he’s extra-terrestrial, I wondered what if 

an alien race – after their fi rst contact with mankind – became inspired by human 
history, especially by stories about the Knights Templar and the samurai. If they 
used their superior technology and created their own group of protectors, what 
would a member of this group look like? I imagined them as characters who are 
spiritual, intelligent and serene but also as powerful and unpredictable creatures. 
Only their strongest hatchlings are selected and Lukruk was one of the chosen. 

01

In-depth design As the head is the 
focal point of the character, I wanted to 

make sure Lukruk had a very expressive face and 
attitude. I wasn’t happy about the fi rst iteration, 
because he didn’t look as powerful as I wanted 
so I made his head more angled and sharp along 
the jaw. The argus monitor lizard was a great 
reference for this. The elongated cartilage tips 
on Lukruk’s chin further helped to emphasise 
the shape of the head. To counter the aggressive 
features of his design a little, and add some 
confl ict, I gave him two small ears. 

02
The body and armour Lukruk’s armour was designed to be 
functional and built for protection, but it’s also supposed to have a bit of an 

elegant and ceremonial touch that comes through the curved lines and shapes. 
Because I imagined the model having lots of detail, I fi gured a more humanoid 
silhouette would be better to read. When putting on the armour, the longer tail 
was supposed to be a mechanical extension that could be used as a weapon. 
As a reference for his facial expression and attitude, I referred to heads of birds 
of prey such as eagles and hawks. For the hard-surface parts of the armour I 
collected images of sports motorcycles, CNC machine parts and landing gear – 
incredibly useful reference when approaching design as functionality.

03

http://www.ben-erdt.de
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Inspired by the unpredictable-looking 
reptiles such as tegus and iguanas, the 
spiritual feel of Gregorian chant, the armour 
of the samurai, as well as the Knights 
Templar, I decided to create Lukruk, an 
armoured alien lizard knight.

Concept
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Work on the head Starting out in Maya, I always begin modelling the 
head because it’s the most important part of the fi gure and can determine 

the look and feel of the character. For example, a bulky head with a fat neck would 
make me expect an appropriate body to support it. I start with the eyes fi rst, 
placing a polySphere at the position where the eyeball sits and scaling it to fi t. 
For shaping the eye socket, I usually start with a single polygon and work my way 
around the eyeball. When beginning work on a model, start simple, as too many 
polygons can make any fi xes later on rather diffi cult and time-consuming.

04

Work on the model
Begin sculpting in Maya

Refi ne the head After blocking in the eyes, I move over to the mouth, 
ears, lips, the jaw and the bony structures around the head. The goal is 

to create the individual facial features fi rst and stitch them together at the end. 
When they are separate, it’s easier to move them around and adjust the head 
proportions. With the eyes fi lling the spaces in between, you can already see what 
the proportions and volumes are going to be. Above Lukruk’s eyes I created a row 
of eyebrow-like scales, which help when conveying emotion. 

05

Model the body When modelling the body I followed the same approach as for 
the head. I started modelling, then tweaking very rough representations of the features 

to build the correct silhouette, shape and volume. In order to manage the amount of detail in 
the original concept art, I broke it down to primary, secondary and tertiary shapes using colour 
coding. During the modelling process, I needed to determine the large and small shapes, as 
well as where they join or overlap one another without constantly referring back the original 
concept work. The chest was one of the more complex pieces, so I wanted it to fi t as neatly as 
possible. Since everything else was proportionally correct at the end, the chest was very easy 
to add in. 

06

Effi cient topology To avoid ineffi cient geometry, the topology was created to 
look nice and smooth, with a maximum of two subdivisions, though most of the pieces 

needed only one. The overall rule was to have complex forms and shapes with a decent amount 
of polygons for each object. In effect this made life a lot easier for later unwrapping and texturing 
all the pieces. Always try to stay as clean and effi cient as you can and it’ll pay off later on.

07
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The model versus the rig Making sure that 
Lukruk wasn’t only functional in design but also in terms 

of articulation was a challenge, so I gave extra focus to areas that 
were most visible and complex. One of the more complicated 
parts was the waist, as the tail, shield fl aps and legs all come 
together in this region. To avoid individual armour parts touching 
or interpenetrating one another, I used a basic proxy rig while 
modelling to ensure any changes made improved deformation 
as well as design. Instancing geo here also served to improve 
iteration times. To make the tail believable and to maximise the 
range of movement, its inner core was based on a row of single 
vertebrae inspired by the chameleon – one of the few lizards that 
can completely roll their tails. This dynamic tail is key to Lukruk’s 
personality and body language.

08

Sculpt skin details ZBrush was used for detailing the head. As for reference, I chose 
images of crocodile skin to create a smooth transition between the separate scales and 

skin. Greek turtles have a noisy scale pattern on their neck that I used for inspiration when sculpting 
the softer skin parts on the character’s face. I used the Clay brush to block out scales, then while 
sculpting in the surface details I kept the design of his head in mind, making sure the details didn’t 
overwhelm the overall aesthetic. The Slash2 brush was used to sculpt in some overlapping scales, 
while the Slash3 and Dam Standard helped to emphasise the crevices in between. The Infl at and 
Standard brushes add more volume to the fl eshier areas, while hPolish was used to break some of 
the hard edges of the scales. Once happy with the result, I rendered the Displacement map inside 
ZBrush. Here I chose an 8,000 pixel-sized map to have an opportunity for a higher-res detail pass 
in MARI.

09

Sculpt skin details 
Before jumping into MARI I 

wanted to make a colour concept for 
the head to get a better idea of the 
possibilities therein. I rendered out 
basic passes – AO, Depth, Shadow 
and two Light passes – using the BPR 
Render in ZBrush, just as a base to 
paint on in Photoshop. Once they 
were composited I started to build up 
the skin, while each group and layer 
represented a paint step for the skin. 
As a result I had a clean layer structure 
that was going to be rebuilt in MARI to 
achieve the textured look.

10

It’s important to know the end purpose of your 
creation. In this case the character was a production 
model for a short movie. At the end we were going 
to need many high-res textures, as well as a 
complex mesh with lots of individual pieces that 
were going to be rigged and animated, but we also 
wanted to keep the render times as short as 
possible. I thought about what could be done in 
advance in order to stay effi cient without 
compromising quality. For example, adding simple 
colour shaders while modelling can help to get a 
better overview of the shapes and details. Also step 
back and see if the model still fi ts the concept art.

A clear end goal
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Sort and name the pieces  In order keep the 
amount of potential issues low later on, it’s important 

to keep a clean scene. I went through the scene hierarchy and 
deleted nodes such as empty groups, duplicates, unused nodes 
and so on, to make sure there was no excess left that could cause 
problems at a later stage. All geo objects were sorted according to 
the design hierarchy of the character. For example, everything in 
the left arm was contained in a Group node. Individual objects were 
then grouped separately according to their visibility, size and shape 
hierarchy. Each group represented one quadrant in UV space, 
which was the foundation for the UV-layout and texturing process.

11

Clean up the scene
Prepare and unwrap the geometry for the next stages

Unwrap all the pieces I exported the pieces as individual OBJ fi les for UV-
generation, plus the MTL fi le to keep the assigned colour shaders inside MODO for 

later texture-baking. The tools I predominantly used were UV Unwrap, Relax UV and UV Peeler. 
Unwrap and Relax are helpful for generating and refi ning UVs of shapes that are more organic 
and curved. The UV Peeler is a fast tool to unwrap pipes and hoses. For simpler shapes that are 
more cubic, spherical or cylindrical, I used the UV Projection tool as a starting point, as it offers 
appropriate projection types. The screenshot shows the fi nished UVs for a part of the foot.

12

Lukruk has an extremely complex hierarchy. Counting meshes alone, around 
1,800 different objects needed to be named, grouped, organised, unwrapped and 
laid out effi ciently in UV space. A clean scene is vital to making your life and those 
of your colleagues easier. Clean UVs within a good layout are half the texture job 
and even riggers can benefi t. I decided to unwrap everything in MODO because I 
was going to bake Cavity, Flat, Diffuse and RGB maps in it. Switching applications 
also brought a bit of variation into this tedious process as I like using a Cintiq when 
working inside MODO. When it comes to polygon-modelling, especially, this is one 
of the most artistic methods I have found.

Complexity demands 
organisation

This project was a shared effort between several 
people, with Amir Ronen performing rigging and 
secondary animation, Colin Giles completing primary 
animation and myself responsible for design, modelling 
and texturing. We shared and referenced the main rig 
as a master fi le that was frequently updated with rigging 
information by Amir. 

When Colin, the animator, started blocking out the 
animation, I could work on the textures and shaders. In 
order to stay on course, we had regular meetings to 
discuss our progress, the next steps in the work, and to 
discuss any current issues that might have arisen.

Supplied with your free resources, you’ll fi nd several 
video tutorials from Amir Ronen (www.amirronen.com) 
who generously provides an in-depth look at his own 
rigging workfl ow.

Collaboration is key

http://www.amirronen.com
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Cavity/Convexity maps in MODO Since I was going to texture the actual 
high-res character mesh, I used Cavity maps as a guide for painting textures. These 

were baked inside MODO using the Occlusion shader. They also helped to bring back some 
detail into the Diffuse texture. In MODO I added the Occlusion shader to the Shader Tree and 
set it to Concavity with a Max Distance of 60cm and a Spread Angle of 45 degrees. I created 
another Render Output, set it to Diffuse Coeffi cient and made sure the Diffuse Amount inside 
the base material was at 100%. The desired texture resolution for the particular object was 
set inside the MODO Render Properties. Remember, baking these maps in MODO using the 
Occlusion shader takes some time. On your disc you’ll fi nd a step-by-step video guide for 
baking Cavity maps. 

13

Prepare textures
Enhance and refi ne the character

Begin authoring textures After unwrapping the 
entire character model, I ended up with almost 50 sets of 

four to fi ve textures, so it was important to maintain a consistent 
workfl ow. The hidden Plain Diffuse layer was used as a selection 
guide. The Dirt Effects group slightly broke up the fl at colour among 
all the textures and added overall dirt and grime to the character. 
The MARI group consisted of object-specifi c layers that were 
painted in MARI 1.4, although this workfl ow was improved thanks to 
MARI 2’s full PSD support. Additionally, to make the fi nal character 
design easier to read, I made his feet more muddy, while reducing 
this effect higher up his body. This resulted in a light colour gradient 
from bottom to top. I also focused more on areas that look worn-out 
and used in order to add a bit more history to his armour.

14

Render and post-production
Finish with tiny details and complete render passes

Render out passes The screenshot shows the passes that an 
average shot required. My friend and colleague Andrew Paxson (www.

andrewpaxson.com) was in charge of compositing and adding VFX inside NUKE 
and he did an amazing job. I wanted to give Andrew as much control as possible 
over the shots, so to give us the opportunity to tweak the blue parts of the body 
armour, I took the fl at colour textures that I baked before texturing and created 
simple RGB maps. The result was a pass in which R represented the metal types, 
G represented pieces that could cause potential artefacts and noise, while B 
represented all the blue parts of the armour. Staying clean and organised like 
this from the very beginning saved us a lot of time during lighting, rendering and 
composition. There was one case during the fi rst render test in which I had a bad 
polygon causing the Subdivision Approximation to crash mental ray. However, 
because the character model had an elegantly structured hierarchy, the bad 
piece could be tracked down and quickly fi xed.

16

Include dirt and paint chips Alongside some hand-painting, 
I also used photomanipulation for texturing Lukruk – something that 

increased his sense of believability. A great source for photo textures is www.
cgtextures.com. In order to add paint chips to the character, I chose a texture 
with a high contrast between the paint and the areas where it had faded. I 
created a selection using Color Range and used it as a mask on a solid colour 
layer. This enabled more control if I needed to change the hue, saturation or 
brightness. Back in MODO I then baked an additional Cavity map with a lower 
range, as well as a Convexity map that was used to emphasise the edges in the 
roughness texture.

15

http://www.andrewpaxson.com
http://www.andrewpaxson.com
http://www.cgtextures.com
http://www.cgtextures.com
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Over these steps we are going to be jumping 
into ZBrush with plenty of reference to create a 
cinematic creature concept. Within production, 
ZBrush is an extremely valuable tool. By spending 

time creating a sculpt, rather than drawing, you’re able to 
create an asset that can be reposed, textured and altered 
very quickly and easily. This results in multiple angles and 
visuals all within a single 3D package and means you’re 
able to produce an orthographic view in seconds, rather 
than days. 

We’ll use DynaMesh along with standard ZBrush tools to 
build up all the creature’s kinks, wrinkles, muscles and other 
details. The point of interest of The Wraith is its menacing 
head, complete with a sizeable set of teeth, so we’ll only 
focus on this once the easier main body 
is complete. 

ZBrush is also a great tool to use in conjunction with 
Photoshop, where you can achieve great-looking results by 
painting on top of your renders. This is where we’ll complete 
post-production work on the model.

The Wraith  2013 Photoshop, ZBrush

Justin Fields Concept artist

Learn how to create 3D cinematic concept art that’s good 
enough for the movies Digital artists explain the 

techniques behind their 
amazing artwork
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Justin ‘Goby’ Fields

Personal portfolio site
www.justingobyfi elds.com
Country USA
Software used ZBrush, 
Photoshop
Concept art for fi lms and 
games, including creatures, 
characters and 
environments.

Source files
available

Free tutorial fi les on 
the disc

Design a 3D alien

Use ZSpheres as a starting point After 
gathering reference and fi guring out what the main 

goals are for the concept, we’ll start building the creature using 
ZSpheres. Sometimes in production it may be faster to begin 
with a preset base mesh from a previous sculpt, just to speed 
things up. Here we’ll be starting from scratch to see what the 
overall look will be. Once we have the proportions right, we 
can break the work into separate SubTools and then move to 
DynaMesh.

Reference 
is key Keep 

a collection of images 
on another monitor to 
constantly refer to and 
keep the design in check. 
Nature is the greatest tool 
in any artist’s arsenal, so 
spend some time studying 
photos. For this project, 
observing insects and their 
body parts is useful.

Establish a base
Build your concept using simple shapes & ZSpheres

01

02

Don’t rush things We’ll need to spend a lot of time detailing the head, so we’ll save this 
until last. At this stage, staying at a lower subdivision level will help us make major design 

changes fast without the sculpt getting too loose. Try to keep major elements as separate SubTools 
so you can really subdivide and get some great details.

03

http://www.justingobyfields.com
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With The Wraith I wanted 
to focus on an insect-style 
monster with elongated 
limbs and a multi-jointed 
mouth to give him some 
intimidating features. 
Adding more aggressive 
shapes also helps create a 
frightening alien concept.

Concept
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Tighten up the graphics Now that we have a lot 
more digital clay to push around, we can really dive into 

some serious detail. Using some of the same techniques from 
the previous step, we’ll continue to refi ne detail and defi ne the 
interesting shapes. We can also start laying the groundwork for 
wrinkles, edges, creases and apexes. The fi nal pass of detail will 
make your work much easier.

Develop shapes & form Going up in subdivisions now and looking at the 
references, we’ll use the Clay Buildup brush to establish the broad outline of the creature. 

Once this is done we can really start to plot out the concept, and smooth and cut into the fl esh of 
the model. When working as part of a team, make sure you consider the artist you’ll be handing 
over to. Digital is limitless, but it’s worth keeping in mind that someone else may need to fi t inside 
your design. For most of the organic sculpting we’ll use variations of the Dam Standard brush 
plus various stock Alphas in ZBrush. You can also use the Standard and Clay Buildup brushes 
at a very low pressure to blend in and out of shapes.

86  Fantasy Art Genius Guide

Begin work on the head After adding the head we’ll use DynaMesh and the 
SnakeHook brush to pull out some interesting shapes. Following the same steps we used 

on the body, quickly lay out the shapes and detail them. We can add eyes early on, then test 
different shapes and sizes to see what looks best. After these are in place, make sure that the 
underlying shapes support the sockets to give the head a bit more character.

06

04

05

Create a dynamic concept
Take your time, choose your plan of attack and stick to it

Depending on the concept, I like to wait and leave 
the detailed sculpting of the head until last. 
Sometimes I also take what I have so far, drop it in 
Photoshop and do quick paint-overs to get a few 
variations. This way I can see which direction I want 
to take the fi nal sculpt in.

Sculpting heads
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Layer on textures & fi ne detail Try to keep your design grounded with areas of 
rest and subtle textures. Experimenting with stock Alphas and different brushes in ZBrush, 

as well as pressure, is a really great way to learn just what the tools can offer a project. Using 
LightCaps to see how light is affecting the surface of your creature may also affect some of your 
design decisions.

Play with tonality Colour can drastically change 
how your design is perceived. Try choosing a fl at colour 

and airbrushing variations in to slowly build up the tones. 
Masking out the cavities and adding some dirt always helps to 
make your designs ‘pop’ as well.

Pose the character Since a stagnant pose is 
a good way not to get your design picked by clients, 

we’re going to add a slight variation. Usually it’s a safe move to 
turn the head slightly and shrug the shoulders to mimic a bit of 
action. Using the Transpose Master plug-in here is a godsend, 
as this will keep all your SubTools in line with the model while 
you pose it. Hit the TposeMesh button, then after posing hit the 
Tpose>SubT button and ZBrush will align all of your SubTools 
with the posed mesh.

Turn off Symmetry
At this point we can add further detail without the Symmetry function turned on to give the 

design some love. Get in there and add various details and wrinkles. This step helps make your 
design unique by adding variation, so take the time to really consider what you’re applying where 
and always keep your goals in mind.
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Colour can drastically 
change how your design is 
perceived. Try choosing a 
fl at colour and airbrushing 
variations in slowly

Build up the features
Apply details & choose an active pose 

It’s worth spending time making and collecting Alphas. Pixologic has built a large 
collection of stock Alphas into ZBrush to choose from already, but it’s also very easy 
to use Photoshop to build up your own collection for your personal sculpting needs. 
To create Alphas in Photoshop, simply create an image at 1,024 x 1,024 pixels and 
desaturate it to get a high-contrast, black-and-white image. If the image has edges, 
you may want to darken these gradually with a soft round brush – this will make it 
easier to work with in ZBrush. Simply save your Photoshop image as a JPG or PSD 
and import it into ZBrush through the Alpha palette.

Save time with Alphas
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Choose your angle Get ready to start the composition by fi nding your favourite 
angle and locking that in the camera view via the ZAppLink properties. Some of your 

details will inevitably get lost in the view that you choose. However, if you need a different pose, 
all you have to do is repose and re-comp, rather than go back to re-sculpt detail that isn’t there. 
Having detail in there and not needing it is better than needing and not having it.

11

Using DynaMesh in conjunction with extractions frees 
up a lot of technical modelling issues and enables 
limitless creation possibilities. Pixologic has really broken 
the creative barrier with this solution, as well as the Insert 
brushes. Using these in production has made me a 
faster artist and has provided assets for the pipeline that 
can be used again. Seeing how a practical design studio 
builds and replicates props has really opened up the 
worlds of kit-bashing and production modelling to me. 

DynaMesh 
means freedom

Bring it to life in Photoshop
Move to post-production and refi ne your creature

Render your creature After establishing the lighting 
and BPR settings, we’ll begin rendering out the passes for 

post. We’ll get the basic passes out of the way so we can play with 
some options for use in Photoshop. After this we’ll get various light 
passes for fi ll and rim lights.

12

Final composition When you have all of your render passes, take 
them into Photoshop and lay them on top of one another. Putting the fl at 

model pass fi rst, we can begin experimenting with blending layer options. This 
can vary with every piece, so use your artistic eyes and see what works best.

13
Add some atmosphere Painting in Photoshop now, this is 
another fun stage of the process. In this step we can drop in a few gradient 

spotlights to mimic the light setup and blend the alien into the background. At this 
stage you can also opt to drop a photo into your backdrop – just remember to 
match the perspective of your character.

14
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Adjust with layers Being confi dent in Photoshop will help at this point as it’s key 
to make changes in a non-destructive way. Using masks and adjustment layers is vital 

in production, as this way the changes aren’t permanent and each can be developed to suit 
your art director’s various demands. Another valid concern is that you may not be the only one 
working on the piece, so make it easy to edit, label those layers and keep it clean. Because you 
have to keep things organised and non-destructive, you will probably end up with a few hundred 
layers while building up your post effects and painting on top of your render.

15

Because you 
have to keep things 
organised and non-
destructive, you 
will probably end 
up with a few 
hundred layers

Add fi nal details Now we can start painting in some 
detail work using photo overlays of textures. Complete 

some fi nal touchups and effects, but take the time to blend 
everything properly. The time you spend at this level really ties the 
piece together. 

16

Make the fi nishing touches Now we can add in a small vignette and a little chromatic 
aberration to help prevent the creature from looking like a 3D render. We can also add a little noise to 

break up the image.

17
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Digital artists explain the 
techniques behind their 
amazing artwork
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Danail Nikov

Personal portfolio site
http://didom.cghub.com
www.behance.net/didom
Country Sofi a, Bulgaria
Software used Photoshop, 
ZBrush, 3ds Max, V-Ray
Danail Nikov is a freelance 
3D artist working in 
advertising, for movies and 
on personal projects

Creatures

I’ve always been interested in 
the nature around us. Why do 
hummingbirds fl y backwards? 
Why do fl ies have compound 
eyes? How come sharks don’t 
have bones? 

Nature is a mystery that 
inspires my work. With this 
project, my goal was to create 
a nonexistent animal, 
combining the characteristics 
of three different creatures 
already present in our natural 
habitats. Even though they are 
all completely different, they 
all, rather remarkably, share 
something in common.

Concept

http://didom.cghub.com
http://www.behance.net/didom
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The concept of cross-evolution is a great area 
for provoking and inspiring your imagination in 
your 3D art and design work. The animal I’m 

creating for this tutorial – using ZBrush, 3ds Max, V-Ray, 
UVLayout and Photoshop – is a mix of a chameleon, a 
fl ower and a giraffe. I’ve chosen this bizarre combination 
because a chameleon is adapted for climbing and hunting; 

fl owers attract insects; while a giraffe can catch food with its 
extraordinary tongue. 

In this tutorial you will learn how to combine objects, 
compose a scene, retpopologise in 3ds Max and pose 
using animation tools. 

So let’s experiment with some different objects and 
methods to create a fantastical hybrid creature.

Begin 
modelling 

It’s good to work with 
simple objects at this 
stage as they are easy 
to manipulate and will 
provide more freedom 
to make changes, which 
is why I use ZSpheres 
for the body and the 
tree. To model the other 
objects I start from 
spheres, leaving them 
as separate SubTools 
at the beginning. This 
helps me manipulate, 
transform and change 
them quickly.

Combine the objects 
Once happy with the results of my 

sculpted objects, I can start combining 
them to form more complex shapes using 
the DynaMesh option at a low level. When 
combining the objects, you not only have 
to think about how to merge them, but also 
keep in mind that as a complete object 
the total number of polygons will be much 
bigger. There’s no right or wrong way 
to do this, so duplicate the objects and 
experiment. For static images it’s better to 
keep your elements separated, as this will 
make it easier for you to work on the details.

Chagirro  2012 Photoshop, ZBrush, 3ds Max, V-Ray, UV Layout

Danail Nikov 3D artist

Learn how to create hybrid creatures, combining various species 
from the animal kingdom

Establish a concept
Forge a surreal idea in your mind

01

Source files
available

Tutorial fi les on the disc

Develop fantastical 
animals

02

For retopology work in 3ds Max I tend to use Graphite 
tools, which are very easy and convenient. Simply go 
to the Freeform tab, choose Surface and select the 
high-res model, where you can put the new polygons. 
Use Offset to control the distance to be glued on the 
model. Pull the polygons with Extend and make use of 
materials for better visualisation of your topology. For 
the high-res model, choose a Standard material with a 
darker colour. Use the Standard material for the new 
topology. Tick Color in Self-Illumination and choose a 
bright colour – orange, for example. Tick Wire in Basic 
Parameters so that you will 
have better visibility of your 
new topology. This method 
refers only to the Default 
Scanline Renderer setup.

I also use Wrapit, which is 
a very useful and 
convenient plug-in for 
retopology, available for free 
at www.matt-clark.co.uk/
wrapit.

3ds Max Retopology

Retopologise 
your model For 

the retopology process I go 
into 3ds Max and also open 
Decimation Master. Set 
the number of polygons to 
50,000 to avoid navigational 
problems.  Retopologising is 
simple since the model is only 
going to be used for a static 
image. I don’t need specifi c 
topology, but it should be 
good enough to make the 
pose of the model.

03

http://www.matt-clark.co.uk/wrapit
http://www.matt-clark.co.uk/wrapit


92  Fantasy Art Genius Guide

Creatures

92  Fantasy Art Genius Guide

Give the model some 
shape NSince I’m not 

too familiar with the anatomy of 
chameleons and giraffes, I have 
to use references to make sure 
I get accurate results. Using the 
Project feature in ZBrush, I can 
add the details that I want to save 
onto my new retopologised object. 
For modelling, I mainly use the 
Clay Buildup, Move, Standard and 
DamStandard brushes. I would 
certainly advise taking your time 
over the details and gradually 
increasing the resolution as you 
progress. Following this process 
ensures the model stays concise, 
organic and consequently much 
more believable.

04

Add detail & establish a pose
Once your topology is clean you can start to add more details

Pose your creature I 
already have in mind what 

the fi nal pose of the model should 
be. When considering this, try to 
imagine your creature in its natural 
environment, how it would interact 
with its surroundings and so on. I’ll use 
Transpose Master to work the creature 
into a position and choose the Move 
and Smooth brushes to repair any 
broken areas, where necessary. At this 
stage you don’t have to be afraid of 
destroying what you’ve already done; 
the model is saved, so be brave and 
experiment. Once I like the pose, I can 
import it into 3ds Max to see how it will 
look in front of the camera.

05

Finish the 
details For the 

fi nal details I need lots of 
polygons, so I’ll use HD 
Geometry. I can choose 
between two methods: the 
fi rst is using Stencils with 
standard sculpting; the 
second is using Stencils with 
Projection Master. Both are 
identical, but personally I feel 
the latter is better – I’ve found 
it very useful while making 
this creature.

06
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Make some lunch To make some lunch 
for the creature I shape the fl y using the same 

techniques – modelling the basic shape using the 
standard primitives of ZBrush, shaping with DynaMesh, 
retopologising with 3ds Max and adding fi nal details in 
ZBrush. Since the insect isn’t the main character I don’t 
need too much time detailing it. Adding some simple 
hair helps with the realism without too much effort. I 
create a few hairs in 3ds Max and apply them to the 
model using the Insert Brush.

Detail the environment To detail the tree I’ll mainly use the Clay Buildup brush. On a lower 
level I make separate lines following the shape of the tree. It’s not necessary to smooth these 

features, as after increasing the level of polygons they will make a great base for smaller details. Next I 
use several Alphas for larger elements and fi nish by adding the colour texture to the tree. I do this with the 
Spotlight tool in ZBrush, then duplicate the texture, use it as a mask and add details using the Infl at brush. 
I decide to use 3ds Max for the leaves, starting with a plane and continuing with the Shell modifi er. Keep 
laying on fi ner elements and texturing them in ZBrush. The leaves are thin objects, so you should switch on 
Back Face masking for brushes, including the Smooth brush.

Fantasy Art Genius Guide  93
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Here’s how to use Stencils using 
Projection Master:

to turn the Stencil on and 

the details, clear the 

Stencils
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Create your UVS  All 
UVs for the models are created 

using UVLayout (www.uvlayout.com). 
Personally, I fi nd this to be one of the best 
tools for creating UVs, as it’s very easy 
and convenient to work with. You can fi nd 
a helpful tutorial on how to use this tool on 
the 3D Artist website at http://tinyurl.com/
perfectUVs.
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Before you start 
texturing it’s 
good practise to 
extract the 
Displacement 
and Normal 
maps from 
ZBrush. For the 
Displacement 
map I set Adaptive and DSubPix at 1 
and extract 16-bit maps.

For the Normal map I use Tangent, 
Adaptive and Smooth UV. For 3ds Max 
you must check FlipG, because 3ds 
Max reads the Normal maps this way. 
You can also extract a Cavity map and 
an Ambient Occlusion map to give a 
good base for texturing. Choose Mask 
by Cavity from the Mask menu, then in 
Texture Map choose the New from 
Masking option. 

It’s good to keep in mind that Ambient 
Occlusion masking for models with 
more than a million polygons takes too 
much time. The program could crash, 
so it’s good to save the fi le fi rst. For 3ds 
Max, all maps extracted from ZBrush 
should be V-fl ipped in advance.

If you’re not sure about 
the fi nal model you can 
always make different 
variants and experiment to 
optimise the result 

Before you start 
texturing it’s 
good practise 
to extract 
the 
Displacement 
and Normal 
maps from 
ZBrush. For the Displacement map I set 
Adaptive and DSubPix at 1 and extract 
16-bit maps.

For the Normal map I use Tangent, 
Adaptive and Smooth UV. For 3ds Max you 
must check FlipG, because 3ds Max reads 
the Normal maps this way. You can also 
extract a Cavity map and an Ambient 
Occlusion map to give a good base for 
texturing. Choose Mask by Cavity from the 
Mask menu, then in Texture Map choose 
the New from Masking option. 

It’s good to keep in mind that Ambient 
Occlusion masking for models with more 
than a million polygons takes too much 
time. The program could crash, so it’s good 
to save the fi le fi rst. For 3ds Max, all maps 
extracted from ZBrush should be V-fl ipped 
in advance.

Map extraction

Texturing tricks
It’s time to map and texture our model to bring the creature to life

Start PolyPainting  The main texturing 
of the creature will be completed in ZBrush. 

First you should try using a trick I’ve learned to save 
time: When you have the UVs of your model and the 
Displacement maps are ready, open your model in 
Photoshop and get your colour tones established. 
Save this as a new fi le and then open it in ZBrush. 
By following this method you’ll have a great base 
for adding the model’s colours. If you’re not sure 
about the fi nal model you can make different variants 
and experiment to optimise the result. If you have 
separated large areas it’s good to make them in 
black and white, then save them on another map so 
you can remove or repeat later, where needed.

10

To texture the tree I use Spotlight. Open 
the textures you want to use from the 
Texture menu, then bring them in via the 
Add to Spotlight button. Turn off ZAdd and 
turn on RGB. When the Spotlight circle is 
visible you can edit the texture. By hitting Z 
on the keyboard you can switch from Edit 
to Drawing mode and apply your texture. 
Shift+Z will turn Spotlight on and off.

Texture with 
Spotlight

http://www.uvlayout.com
http://tinyurl.com/perfectUVs
http://tinyurl.com/perfectUVs
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Shed light It’s good to start with just one light and continue only when satisfi ed with the 
position. My setup contains three lights: two VRayLights and one V-Ray Dome light with 

an HDRI on it. To light your scene with an HDRI in V-Ray, it’s always good to use a Dome light. The 
main light comes from the front lamp, which has Temperature set to 5,300, Multiplier to 130 and a 
Size of 10 x 10. This is placed slightly above the camera and directed towards the creature’s head. 
The other lighting comes from a Dome light with a forest HDRI and a few modifi cations to achieve a 
darker mood. This back lamp doubles the effect and has Temperature set to 7,000, Multiplier set to 
20 and a Size of 60 x 60. This produces ambient lighting coming from the environment.

11

To texture the tree I use Spotlight. Open the textures 
you want to use from the Texture menu, then bring 
them in via the Add to Spotlight button. Turn off 
ZAdd and turn on RGB. When the Spotlight circle is 
visible you can edit the texture. By hitting Z on the 
keyboard you can switch from Edit to Drawing mode 
and apply your texture. Shift+Z will turn Spotlight on 
and off.

Set up your lights

The composition of 
your scene has a great 
impact on your audience’s 
reaction to the piece

Apply lighting & shading
Perfect the fi nal look of your scene & set the right mood

Set up your shader With this scene I’m mainly 
using VRayMtl and VRayFastSSS2. When setting up 

materials it’s often necessary to go back and forth between 
Photoshop and 3ds Max to adjust your textures. I use Normal 
and Displacement maps extracted from ZBrush, but the others 
are painted within it. For the Scatter Radius and Glossiness I 
also use textures painted in ZBrush, but this time black-and-
white ones. I combine these with a VRayColor map using a 
Composite map in 3ds Max to give me better control over the 
fi nal result. Using a VRayColor map as a base, with black-and-
white textures, makes light and dark areas stronger with Multiply 
or Screen in compositing. You can also adjust their Opacity 
levels. When I use FastSSS2 in V-Ray, I create a black map with 
many small, white spots painted in ZBrush using the Spray and 
Alphas with points. I combine this with the Normal map using 
VRayCompTex for the Bump. I also use the same texture in the 
Diffuse Amount texture and use this as a fi lter for visualising the 
diffuse colour. This way I can achieve a scaly effect and dead 
skin cells, which are paler and lighter.

12

Shade skin For VRayFastSSS2 I use a Subsurface Color map, which I make in ZBrush; 
a Specular map for Specular Amount; and a Glossy map. One of the key settings of SSS2 is 

Prepass rate, which defi nes the quality of the effect to a great extent. How strong or weak the effect 
will be depends on Scale and Scatter Radius which are connected with the size of the object. Start 
from standard settings and apply them in accordance with the object.

13
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The basic rendering 
setups  Setting up the 

render of your scene will also 
include adjusting and lighting the 
materials, which may take a little 
time. I fi nd it’s best to keep the 
V-Ray settings low to keep things 
operating smoothly. Go to Image 
Sampler and choose Adaptive 
DMC. I fi nd this is the best sampler 
for photoreal scenes like this and 
does a good job. You can keep 
the default settings in the Adaptive 
DMC Image Sampler as you fi nd 
them. From the Settings menu in 
the sampler, choose 1 and adjust 
Min to -1, Max to 50, and 0.008 
for Noise Threshold. You’ll now 
be able to produce a test render 
without losing too much time re-
rendering the entire scene.

14

Rendering & compositing
Experiment with your settings to reach the ultimate result

Use Render Elements Render Elements are 
key for rendering, as the right combination will give 

you executive control of the fi nal image. Using them you can 
decrease or increase the lighting effect as well as the refl ection. 
For my scene the elements that I render separately include: 
VRayFastSSS2, Shadow, Refl ection, Specular, Z-Depth, 
Bump Normals and Ambient Occlusion (AO), for which I use 
VRayExtraTex with a Dirt map attached to it. I also want to 
separate elements for the light effect that I’m using in my scene – I 
can do this with VRayLightSelect. I fi nd it’s only necessary to set 
up VRayExtraTex, VRay ZDepth and VRayLights: 

accordance with the objects’ sizes. For my scene, a Radius of 2 
and Subdivs at 60 create good results.

between the closest and furthest object from the camera. 
These indexes should be put in VRay ZDepth Min and Max.

name them differently (FrontLight, BackLight and so on). Add 
each lamp through Add in the VrayLightSelect menu.

I often use the free script, RenderMask, which saves a lot of time 
and is a very useful rendering tool for different elements (www.
tepavicharov.com/scripts.html). To composite the different render 
elements I use Photoshop. There are basic rules for compositing, 
but when you’re creating an unrealistic creature you can feel more 
free to experiment. This way you might achieve some unexpected 
results. I experiment a lot with blending options; VRayLightSelect 
elements are great for enhancing/reducing your light effects.

15

http://www.tepavicharov.com/scripts.html
http://www.tepavicharov.com/scripts.html


Fantasy Art Genius Guide  97

Genius Guide
Fantasy Art

Begin compositing The 
composition of your scene has 

a great impact on your audience’s 
reaction. Even a perfectly modelled 
creature can look poor with a bad 
composition. The main guide to follow 
at this stage is the rule of golden 
proportions. This just requires you to 
mentally divide the frame into three 
vertical and three horizontal parts. The 
points where the dividing lines cross 
are the most important. Your focus 
should be on one of these points – the 
meaningful centre of the picture.

16

The Bump Normal Render 
Element can help you to 
generate masks for 
different adjustment layers 
in Photoshop. If you want 
to darken or tone the 
bottom of your image, 
choose the layer that’s 
your Bump Normal pass. 
Pick Color Range from the 
Select menu, grab a tone 
that suits the correction 
you want to make and 
then choose your 
adjustment layer.

Masks in 
Photoshop

Final touches When I’m happy with how the 
different rendered elements are working together, it’s 

time to add a background image. It’s always possible to use a 
photo, but I want this fi nal result to look a little more fantastical. 
I’m going to make my background in Photoshop, fi rst by 
adding some basic colours. When I’m content with the results, 
I add some fog and air particles, also painted in Photoshop. 
This unique background really gives unity to the image and 
helps defi ne the overall mood. To create fog and air particles 
I use Photoshop brushes that I normally make myself. Create 
a new document at 256 x 256 pixels and fi ll it with white. Paint 
different spots and particles using a normal brush with soft 
edges, but be careful not to go out of the image’s frame. When 
you’re ready, select the whole image and pick the Defi ne 
brush preset from the Edit menu. All that now remains is to 
change the settings of your brush and save it. For air particles 
it’s good to increase the Spacing and Scatter size of the brush, 
then increase the size and apply a few spots to the image. 
Create a new layer and paint a few more spots with different 
sizes there too. Now you can start experimenting with different 
blends between the layers – rotate them, change their opacity 
and so on.

17
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The main focus is the open mouth. We 
want to accentuate the roar. However, in 
the process of creation, changes can 
occur, and the composition might shift 
from your original intentions. Therefore, 
a good rule of thumb is to make your 
camera frame as wide as possible, so 
you can keep the information from the 
image’s sides if you decide to re-
composite the image later. In this case 
you can also set up a larger render 
resolution, and crop out sections you 
want to focus on without losing any of 
the quality.

Why set up a 
wide area for the 
camera?

98  Fantasy Art Genius Guide

Digital artists explain the 
techniques behind their 
amazing artwork
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Iliya Atanasov

Personal portfolio site
www.pixelhunters.com
Country UAE
Software used Maya, 
mental ray, Fusio
Expertise A CG generalist 
who focuses on ideas, art 
direction, lighting and 
compositing

Creatures

The idea behind this 
image was to create a 
dinosaur that, despite 
its scary look, also 
expressed character. 
This was because in 
the original animation 
(tinyurl.com/
PixelhuntersRoar) it 
sings Carmen by 
composer 
Georges Bizet as it 
roars.

Concept

http://www.pixelhunters.com
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Master expert 
creature renders

In this tutorial we will discuss the lighting and 

piece of artwork, ready for your portfolio. The 
tutorial will mainly focus on rendering in mental ray, lighting 
and compositing, but we will also discuss some of the 
starting stages of the project. We will cover tips on how to 
prepare the dinosaur for the forest scene in Maya; the 
process of creating the materials with textures; how to create 
the light rig; and learn some useful tips and techniques on 

mental ray for Maya. There will be several passes rendered, 

subsurface scattering, ZDepth and so on. These elements 
will then be assembled in eyeon’s Fusion tool for 
composition. Finally, we will experiment with different colour 

to bring life to the overall image. If you follow these steps in 

your portfolio.

Set up the 
models 

This dinosaur was 

Semionov in Softimage 
and textured in ZBrush 
and Photoshop. 
Rigging, animation, 
muscle simulations 
and particles were 
completed by Anton 
Gonzalez in Maya. 
After the animation 
and simulations were 

cache so it was easy to 
scrub through the Maya 
timeline.

Singing with dinosaurs  2013 Maya, mental ray, Fusio

Iliya Atanasov Studio director and lead artist at Pixelhunters

Here we will discuss the process of lighting and 
rendering in mental ray, for images that will really burst 
off the pages of your portfolio

Prepare your models
Place your object in the base pose

01

Source files
available

  Light and composite  
fi nished artwork
  Prepare the model inside a 
CG forest
  Choose composition, pose, 
and prepare the elements
  Modelling of the small 
elements such as trees, 
shrubs and rocks
  Prepare the lighting for 
the scene
  Composite the fi nal 
render passes

Learn how toRendering using 
mental ray

Working

Step 01: Set up your 
dinosaur model

Step 05: Set up different 
materials using mental ray

Progress

Step 11: Create the beauty 
and ambient occlusion 
pass using mental ray

Step 08: Prepare a 
basic light rig for a 

Step 15: Combine your 
dinosaur passes

Step 17: Brighten the top 
part of the background
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Create the 
environment For the 

forest scene we created several 
bushes, trees and lianas. We created 
the lianas using simple primitives 
from Maya, extruding, scaling and 
moving the vertices. The leaves are 
polygon planes with a few spans 
with changed vertices to achieve 
the desired shape. We used Bend 

rocks, we created polygon cubes 

Effects and Xfrog to create the trees 
that populate the scene. Wood 
mushrooms were placed on the tree 
bark, with shrubs and small rocks 
covering the ground. We grouped 
the objects and duplicated them 
using Transform to populate the 
environment with foliage.

02

The texturing process To create a dinosaur you need several textures, but depending on the render engine and the type of materials, only some of these 
can be used. The most important ones are the Color texture and the Displacement texture. As we are working with a large render with close-up shots, textures must 

be a large resolution – 8k for Color textures and a 32-bit Displacement map for the dinosaur body. From the Color map you can extract the Bump, Specular or even the 

the tree bark. For the leaves, procedural ramp textures can be used or real leaf textures with an Alpha channel for the transparency. For the ground we used a photo texture 
of rocks and gravel.

03
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Materials and textures
Achieve the right look for your creature

Body language and composition Dinosaurs have rather large heads but, in 
contrast, very small eyes. That’s why we’ve rotated the head in such a way so that the eye 

area is more visible to the viewer. Remember that good eye contact always makes for a more 
exciting render! Later on in the process we will also increase the brightness of the eyes to increase the 
impact. You may also decide you want to see more of the dinosaur; not just the head with the teeth. If 
this is the case, you can raise the tail to twist behind the head, which gives you a better sense of the size 

need to consider the shadowy, dark forest, and where sun rays will pass through the branches, making 
some parts better lit than others. For example, when we come to lighting in a few steps we will increase 
the visibility of the tail in order to better communicate the creature’s massive size. 

04

Decide on materials  Since we will render using mental ray, the very best method 

the body. Attach a colour texture to the colour attribute of the shader. Connect the Bump map 

and a strong Glossiness of 0.654. This will create some nice specular areas over the body of the 
creature. Since we are aiming for a darker forest environment, this will help a lot to exaggerate 
some of the body scales, especially on the darker areas of the skin. You can try to use a Gloss 
map with different dark and white splotches, but your rendering speeds will increase if you decide 
not to apply this texture. You can leave the Glossy Samples on 8 for static dark images such as 
this, as that will be more than enough. In the shading group node add the Displacement map to 
the Displacement mat. Now you are able to experiment with the settings of Alpha Gain and Alpha 
Offset. In this case the rule of thumb is to set up the Alpha Offset at a negative value, with the 
number itself half that of the Alpha Gain, so in this case you would use the following: Alpha Gain: 

the placement Texture node if it’s necessary to mirror the UVs. It’s also important to note that the 
values are very dependent on the scale of the scene. For the teeth material, once again use mia_

05
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Materials for the foliage  For the plants it’s recommended 
that you use the subsurface material, because you can easily achieve 

great translucent results with this. Simply place the Color texture map on the 
diffuse colour attribute Epidermal Scatter Color. On the Subdermal Scatter 
Color, make sure you use a highly saturated version of the same texture. For 
the Back Scatter colour, use the following RGB values: 58, 220, 26. This will 
assure a nice green back scatter when we light the scene from behind. Bear in 
mind that the settings for the Back Scatter Weight, Radius and Depth are very 
dependant on the scale of your scene, so you will need to experiment with 
different values when you get to the rendering phase. Also keep in mind that 
SSS shaders take a bit longer for calculation than general materials, so you 
might decide to use SSS only for very visible/close-up elements in the shot. 
For most of the small leaves we will use the normal Blinn material. Add a Color 
texture map to colour attribute (if you have an Alpha in the TGA or PNG or TIFF 
image it will automatically connect to the transparency attribute). Add some 
bump to the leaves with a small value of 0.2.

06

Texture the trees and rocks We are going to use standard Maya 
materials for this step. Use a Blinn shader. Set the Bump Map value to 1 and 

lower the Diffuse to 0.341 so that the texture is not too bright. Set the Eccentricity to 
0.3 and Specular Roll Off to 0.285. Specular Color itself is good with RGB values of 
24, 24, 24. This will assure a subtle, bright specular feeling over the cylindrical shape 
of the tree trunks. Also, try adding some displacement over the bark. Use a fractal 
procedure with Alpha Gain set to 2 and Alpha Offset set to 0. Once again, you should try 
playing with these settings depending on how close to the camera the object is. As the 
number of trees in our scene will be high, it’s useful to duplicate the material, delete the 
displacement connection and then apply it to the trees further from the camera. This will 
really help to speed up rendering time. The approach to the rocks is very similar. Use a 
Blinn material with slightly higher Specular value than that of the trees: Eccentricity: 0.3, 
Specular roll off: 0.203. Again, if you would like to make the ground darker, you could 
reduce the Diffuse parameter to 0.5 or more. 

07

Quick 
Tip

When creating a stunning 
render, you must think like a 
true photographer. Imagine 
you’re shooting an actual 
image of a dinosaur. In this 
case you might need to use a 
big zoom lens – try it with 
200mm. With such a long 
lens the head will look very 
big, and the neck and rest of 
the body will look thick as 
well. This will contribute to the 
impressive, domineering look 
of the character. You can 
compare this to the look of 
using a 35mm. Using this 
type of lens we will get a 
sharp foreground element – 
the dino head – with blurred 
background elements.
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The lighting phase
Prepare a basic light rig for a dramatic fi nal scene

Create the key, rim and back lights In this instance, 
the lighting we’re aiming for is that of a daytime environment, but 

shrouded in dark by the canopy above. There are both shadowy and lit 
areas, and lots of volumetric rays that are cutting through the forest trees. 
We will start with a directional light behind the dinosaur’s head with an 
Intensity of 0.9. Add a bluish tint by using RGB: 170, 208, 255. Smooth the 
shadows with a Light Angle of 5 and Shadow Rays at 5 to ensure a bluish 
rim around the edge of the creature. Use Spot Lights to light the front of the 
dinosaur. Place a Spot Light with a Cone angle of 34 facing the dinosaur 
head with an Intensity of 1 and RGB colour tint of 255, 241, 200. Use smooth 
Ray Traced Shadows with a Light Radius of 5 and Shadow Rays at 5 again. 
This will create the sense of yellowish highlights from the Sun. Repeat this 
procedure for the back of the body. For the tail add the same spot light but 
with a stronger Intensity at 6 and place the light just behind the tail facing 
towards the camera. This will light the top scales over the backbone and 
will offer a contrast with the surrounding darkness. Make another small 
Spot Light with a short Cone angle of 15 and Penumbra angle of 10. Set 
the Intensity to 1 with a pure white colour and No Shadows turned on. You 
can use this light to control the brightness of the eye by placing it so it points 
directly into the eye. Finally, put one big Area Light behind the trees with 
a small Intensity of 0.1 and the same bluish tint. This will add some wider 
column shadows on the back of the tree trunks.

08

Image Based 
Lighting Following 

a test render, you’ll see that 
the shadows of the picture 
are still too dark. To equalise 
this, let’s add Image Based 
Lighting. There are two ways 

go to Render Settings and in 
Indirect Lighting click Image 
Based Lighting. The second 
way, which enables more 
control, is to create a simple 
poly sphere, scale it up to 
cover the whole scene and 
press Attribute Editor. Open 
the render stats and turn 
off Cast Shadows, Receive 
Shadows, Motion Blur and 
Primary Visibility. This will 
ensure that the sphere will 
not block the rays from 
the directional lights and it 
will not be rendered from 
mental ray. Let’s apply a 
Surface Material to it and an 
HDRI image to Out Color 
parameter. You can use 
whatever HDRI images you 
prefer, but if the render is too 
bright, just reduce the Color 
Gain using Maya, as we 
want to have a rather dark 
and shadowy environment.

09

Render in mental ray  Open render settings and click Renderable cameras. Check 
the boxes for both Alpha channel and Depth channel. Set up the resolution at 4,957 x 6,500 

on 72dpi. Under Quality>Raytrace/Scanline Quality use Adaptive Sampling with Minimum Samples 
Level 0 and Max Sample Level 2. You can leave Anti-aliasing Contrast to 0.100 as we are creating a 

Size of 4. This will slow down the render, but you will get sharper results. Under Raytracing reduce 

Changing the colours, brightness and contrast later in compositing is better using 32bit, but for this 

Illumination. As we are rendering a static frame let’s leave the Accuracy setting at 50. As for secondary 
bounces, they will slow down the render a great amount and due to the many dark and colourful 
pixels in this image they will add little, so leave them set to 0. An important parameter to change is in 

spots and with a small Accuracy setting we can achieve a nice blur around the edges of the objects. 
Under the tab Custom Entities you must also turn on Pass Custom Alpha Channel.

10
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Render passes
Create various passes for compositing

The beauty and ambient occlusion pass 11

The shadow and specular pass 12

The fog pass 13

The subsurface scattering pass 14
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Composite your layers
Combine your various layers using Fusion

Add passes Inside eyeon’s Fusion create a background layer and, using the Merge tool, add 
the rendered environment background layer. We rendered our dinosaur passes separately from the 

background so we could better blur the environment. Use the Defocus tool with Lens Filter and change the 
Bloom level to 0.057. There is not a great deal of depth in the composition, which is why we are not using ZDepth 
to blur the background. The focus will only vary slightly over the creature, while the background is all out of focus. 
Next let’s composite the passes of the dinosaur. First add the beauty pass, then the shadow pass on Normal 
with a Blend of 0.4. Now add the SSS passes of the skin – we have both Specular and SSS information in this 
pass, so put them on screen with a Blend of 0.3-0.5. If you need to you can take out some of the speculars or 
parts of the hands with masks, as they were also thin tissues and might also have a reddish tint from the SSS. Use 
the Boolean Channel tool to enable extra channels, enabling you to plug the foreground Z-Buffer from the beauty 

and Depth Blur to the dinosaur so the focal point will be the eye on its head, while the tail at the end will be slightly 

15

Add more passes Use the Merge Node 
on Multiply to compose the ambient occlusion 

of focus, you can mask only the dinosaur. Next is the 
rays pass. Put it on Normal with maximum Opacity. 
For the specular pass, put it on screen and it will 
add specular to the inside of the mouth, around the 
head, and on the rest of the body. For the fog pass, 
use a small Blend of 0.18 to separate the back from 
the foreground and colourise it to make it a green, 

used an SSS shader, so it will add some shadows 
over the teeth. Put them on Normal mode with 0.8 

mode with 0.5 Transparency. Finally, place some 
particles on the screen for extra effect. You can do this 
using a simple dot emitter in Fusion with some blur 
added to them.

16

Colour grading Your image will likely still look a little uneven from top to bottom. In general the top 
needs to be brighter than the ground, so use a soft glow with simple polygons to brighten the top part of 

the background. You can also increase the midtones of the Green channel to add a more lush and vivid feel to 

creature is roaring and the mouth is wide open it will be good to try to picture the effect of the roar somehow. You 
can use the Displace Filter and Drip Filter tool with a simple polygon mask around the mouth, which will create a 
smear effect to create the sensation of a roar. Finally, add some grain to the picture with a Power of 2 and small 

render passes varied between two minutes and ten minutes per pass.

17
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landscape painting 

138  
144  Create fantasy landscapes from 
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It’s important to base your 
fantasy landscapes on the real 
world or careful reference study

124

112
Paint a surreal 

fantasy 
snowscape in 

Photoshop
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Digital artists explain the 
techniques behind their 
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Joe Cummings

Personal portfolio site
cummingsillustration.com
Country UK
Software used Painter, 
Photoshop, Illustrator, 
SketchBook Pro
I have been a long-time 
traditional illustrator, 
producing artwork for 
magazines and 
newspapers. I like to explore 
different styles and media. 
The abundance of digital 
drawing programs and 3D 
applications offers more 
avenues for exploration.

I’m sure we all have a clear image in our 
minds when we think of a fantasy 
landscape. The types of landscapes are almost 

infi nite but no doubt they will include soaring cliffs and 
plunging waterfalls, twisted, alien rock formations, 
mysterious fortresses, fl oating islands and sharp 
horizons. It is tempting to think that anything goes in 
fantasy but that would be a mistake. The best fantasy 
artists base their ideas, no matter how wild or abstract, 
on the real world and careful reference study.

For this tutorial I tried to emulate, in part, the style of 
Roger Dean, whose posters were both loved and hated 
by fellow students when I was studying at art school. 
Unlike the moody fantasy landscapes we often see 
today that are linked to games and fi lm, Photoshop 
speedpaintings and 3D-based renders, Dean’s 
landscapes were much simpler, portraying monolithic 
rock formations painted in bright, complementary 
colours, often without fi gures.

Looking back at Dean’s work, I was reminded of the 
rocks and cliffs of the Arizona and Nevada deserts that I 
saw when on holiday some years ago, especially the 
high sandstone arches. This helped me to quickly 
establish a scene. Painter and Photoshop are my main 
tools here. I decided against jumping straight in alla 
prima but painted it initially in greyscale with the intention 
of using Photoshop’s powerful adjustment tools to 
quickly add colour.

To speed up the process I also created a couple of 
custom brushes, one in Photoshop and one in Painter. 
With these aids and a little pre-planning, the job of 
creating a  striking fantasy landscape can be a quick, 
fun and immensely satisfying artistic process.

The Warrior’s 
Departure  2012 Painter, Photoshop, GroBoto

Joe Cummings Illustrator

It is tempting to think that anything 
goes in fantasy but that would be a 
mistake. The best fantasy artists base 
their ideas… on the real world

Paint a 
colourful 
terrain

Landscapes

http://cummingsillustration.com
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Sketch and sketch again This is the moment to let your imagination run 
riot. Look for a good combination of realistic and unlikely structures as well as strong 

verticals juxtaposed with elegant ellipses. This is fantasy, but don’t be afraid to use the 
marquee selection tools as rulers. Getting it right here enables you to move at speed with the 
rest of the painting.

Develop your scene
Add complimentary colours and use custom brushes to build your landscape

01
Make a brush An effective way to paint rocky structures 
is to use a rocky brush. In Photoshop I painted a basic 

shape with cracks and fi ssures on a white background. I then 
dragged a rectangular marquee around it and defi ned it as a brush 
preset using the Edit menu. I added some scatter and size jitter in 
the brush controls.

02

Painting rocks 
With my main rocky 

structure defi ned within my 
canvas on its own layer, I 
locked the transparency and 
then painted in the rocks on 
top, remembering to reduce 
the brush size as the rocks 
receded. This was simply 
a base for further painting 
where I would add highlights 
and shadows. 

03

Use Painter’s brushes I opened 
the fi le in Painter in order to utilise its 

superior Bristle brushes. I used the Variable 
Round Oil option that has a nice bristle density 
and can be easily tweaked via the Feature 
adjustment. I continued to paint in highlights 
and shadows, paying close attention to the 
values for foreground and background rocks.

04

Try modelling 
The dwellings on the 

rocky outcrop are quite small 
and the architectural shapes 
could simply be suggested 
with a few brushstrokes. But 
it only takes a few minutes 
to construct something 
appropriate in Google 
SketchUp or, in this case, 
Braid Art’s GroBoto.

05

Framed by trees I placed the 3D 
image in the Painter fi le and continued to 

blend in all the elements. The twisted, sinuous 
tree was painted in to add variety but it also 
helps to frame the city and fl oating islands, and 
draws the eye to what is, at this stage, the main 
point of interest.

06

Add colour The 
greyscale image is 

ready to be transformed into 
colour. In Photoshop we can 
use an adjustment tool called 
Gradient Map. Select the rock 
layer and open the Gradient 
Map dialog then click on the 
Gradient window. This opens 
a further dialog where you can 
select colours for highlights, 
midtones and shadows. Save 
your choices.

07



Fantasy Art Genius Guide  111

Genius Guide
Fantasy Art

Fantasy Art Genius Guide  111

Complementary hues Roger Dean liked to stick 
to a simple colour palette, generally comprising one 

or two closely related hues and one complementary colour. I 
chose mainly yellow and orange, and jumped straight across to 
the other side of the colour wheel for blue shadows. The saved 
gradient can be used and adjusted on other layers.

08

Colour 
adjustment In 

Painter I began to build upon 
the colours, adding texture 
and detail to make a more 
natural-looking landscape. 
The colours in the foreground 
needed to be warmer and 
stronger in value, with those in 
the background being much 
fainter, picking up the ambient 

from the sea.

09

Painter’s nozzles I made a nozzle for the Image 

several stems, each on their own layer, and then grouping the 
layers. From the Nozzle panel’s drop-down menu, select Make 
Nozzle from Group and name it. The select a brush from the 
Image Hose category and choose Load Nozzle from the drop-
down menu.

10

Random stems The Nozzle brush 
will paint the different stems randomly 

but the appearance can be adjusted using 
the brush controls. I painted rows of stems in 
different layers and locked the transparency so 
I could colour without destroying the shape.

11

Flower beds 
stems into a single layer and, on 

a new layer above, painted in some very 

daubing blobs of colour randomly will not 

paying attention to reference images.

12

More custom brushes With the rocks and islands 

horizontally and vertically. I keep these functions on a custom 
palette for easy use. I also call upon another custom brush, this 
time in Photoshop, for the tree foliage.

13

Treetops Although the tree is in the foreground, the 
leaves can be painted loosely with the custom brush on 

a few separate layers, coloured and blended accordingly. I can 
then use an eraser to sculpt out a pleasing shape. The tree trunk 
also needs texture to give it volume and enhance the twists.

14
Final details With all the hard work 

inclusion of a tiny horseman gives the whole image a 
sense of scale and, like all good fantasy landscapes, 
suggests a story. A few more fantasy motifs – such as 
the daylight stars – and it’s done.

15

Quick 
Tip

If you struggle to select 
colours for use in your 
painting, try a gamut mask. 
This is simply a way of 
masking off large parts of the 
colour wheel to reveal a few 
harmonious colours. A 
brilliant free online tool can be 
found here: www.
livepaintinglessons.com/
gamutmask.php.

http://www.livepaintinglessons.com/gamutmask.php
http://www.livepaintinglessons.com/gamutmask.php
http://www.livepaintinglessons.com/gamutmask.php
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Eduardo Lopez 
Mustaros

Personal portfolio site
@edlo747
Country Mexico
Software used Photoshop
Lopez is a profesional matte 
painter and art director 
working at Epics FX Studios 
in Mexico City. He now has 
two European movies under 
his belt, plus several TV 
shows.

Source files
available

Tutorial images are 
supplied on the disc
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Let us transport you to the furthest, coldest 
places with this fantastic matte painting 
tutorial, which shows you how to create a 

digital illustration of a frozen bay in a surreal 
landscape. This tutorial will show you how to manipulate 
images over a base render to build up your scene using 
painting techniques, and then use a graphics tablet to 
paint in the detail on the ice. You will use masks and 
adjustment layers extensively to blend the different 
images and achieve photoreal, dramatic results. Different 

elements will create a foreground presence, which you 
can then use as a composition tool to build up and add 
to the base image. You will also learn to detail your piece 
and refi ne your painted sections to minute detail. 

On the disc you’ll also fi nd stock images and the 
original PSD fi le which will help you to compose your 
scene. You need a strong knowledge of Photoshop in 
order to complete this tutorial to the standard seen here, 
but don’t be afraid to try out the techniques whatever 
your level.

Paint a fantasy 
snowscape

Base image to render

Working

Progress 1: Extract images

Progress 2: Screen the lights

Progress

Progress 3: Create

Surreal landscape  Photoshop

Eduardo Lopez Mustaros Matte painter

Create a digital matte painting of a frozen bay in a striking 
fantasy environment in Photoshop by following Eduardo’s 
simple techniques
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Build up the 
foreground 

The fi rst stage is to fi nd all 
the images needed for the 
scene, but we’ve already 
taken care of this for you by 
supplying them on the disc. 
These include the mountain 
JPEGs and ‘bay.jpg’. Your 
job is to extract the sections 
you need and start placing 
them roughly on the base 
image provided to fi nd a 
good composition. Make 
sure that the different sections 
are placed in a realistic 
manner and you don’t have 
weird mountainsides going 
nowhere, or in a position that 
doesn’t agree with the overall 
illumination of the scene.

01

Adjustment and blending A very important step 
that you need to do right away is to blend the images to the 

environment, both through colour and shading. This allows you 
to get a good feel of how the different sections are sitting on your 
image and which areas could do with fi lling in. This also helps to 
avoid any distracting inconsistencies. Once you have adjusted 
each section at least roughly to the plate, it’s much easier to go 
ahead and fi nd a good composition and keep the creativity fl owing.

02

Layer Masks A brilliant tool at your disposal is the use of layer masks to quickly 
cut out sections and make them sit on the image, to give you a sense of the look and 

composition quickly. However, as these masks are non-destructive, you can edit and refi ne 
them as much as you need without worrying about having to go back and extract the same 
image again, or about little mistakes in the extraction process. Instead, be creative and use the 
masks without fear of messing anything up.

03

Blending modes The use of blending modes, in this case the Overlay mode, 
allows you to paint in simple layer highlights or shadows as needed, taking you one 

step further to merging the different pieces with the base plate. Simply sample colour from the 
highlights in the plate and apply them where needed, to increase the brightness of a surface 
and make the light direction more apparent in the selected region. This is also a non-destructive 
process that can be fi ne-tuned or reduced in opacity as needed.

04

A brilliant tool at your disposal 
is the use of the layer masks to 
quickly cut out sections
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A non-destructive workfl ow allows you to create your artwork freely without 
having to worry if the next step will be a problem further down the line. It also 
means that you can decide later if you need to adjust or readjust any aspect 
of your image, rather than having to make decisions on the spot. With 
non-destructive editing, creativity and experimentation are always welcome.

Quick 
Tip

Town lights Once you have the base of your landscape laid out, you will now use an image 
of a night city scene to quickly build up the appearance of a town on your bay. Copy the image 

‘night_town.jpg’ from the disc into your Photoshop document and then scale it down. You will need to 
rotate it a bit so that it matches the angle of the surface below. Also make sure that the size of the town 
corresponds to the image’s perspective.

05

Screen and mask Set the layer mode for 
your lights to Screen so that all the black is quickly 

discarded, and then create another layer mask to get rid of 
what you don’t need, effectively placing your lights across 
the bay. Make sure there are no lights where it would 
seem unlikely for a structure to be built, such as on steep 
hillsides. Mask away until you have all the light following 
the coast and placed on the land for the base of your town.

06

Extend the town Now you want to extend the town beyond what you have already placed, 
so do this with the help of the Clone tool and a small brush. You can also use the Clone tool to 

choose interesting, varied sections of the lights and eliminate those that are not very interesting; just be 
sure to set your Clone tool to Current Layer in the top settings bar. Then clone all around the bay to extend 
the town out from the main area and into the surrounding land.

07

Light levels You should now have your city 
dispersed around the edges of the bay. At this 

point you can adjust the light levels of the town by using a 
Levels layer clipped to the main lights. Adjust the Levels 
to increase the contrast and bring out the highlights, yet 
at the same time increase the blacks. As you have this 
layer in Screen mode, it means that the blacks are hidden 
even further and the bright lights get boosted even more, 
consistently giving a better look for your town.

08
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Quick 
Tip

Solid colour layers in different overlay modes 
are a great way to add drama and contrast to a 
scene, giving you the freedom to mask and 
reduce the opacity as needed, and even 
combine them to get interesting results. Don’t 
hesitate to experiment with them.

Light hue To fi ne-tune the city’s lights even further, you can now apply yet another adjustment layer. 
This time go with the Hue/Saturation adjustment, and reduce the Saturation slightly to get rid of the 

orange and red excess. You can then use a small amount of blue tint to make the lights appear somewhat 
colder in order to match the rest of your scene, yet once again keeping control of the non-destructive workfl ow. 
This means that you can go back and adjust the lights at any time.

09
Ice base Create a new layer and sample 
a light blue-white from the image ‘snow.jpg’ 

on the disc, then start painting in the base structure 
for what you envision to be the ice covering the bay, 
painting in the smaller sections that break off as the 
ice sits further into the water. 

10

Increased ice detail Once you have the base, you can go in with an increasingly smaller brush 
to start adding detail, getting rid of all the obvious paint strokes, refi ning the shapes and making them 

more solid as you go. You can also start sampling darker shades to add shadow over the ice, taking into 
consideration where the light is coming from. Add another level of detail to the ice surface by refi ning what the 
base has provided for you, eliminating the rough strokes or following them if needed.

11

Add Texture Use the ice image on the 
disc to add extra texture to the frozen bay. 

Copy ‘ice.jpg’ onto a new layer and scale and distort 
it into place and perspective over the ice. You can 
duplicate or clone it several times to cover the entire 
bay, and use a dirtier texture for the shaded areas. 
Then just clip it over the ice layer and reduce the 
Opacity to about 68%. After that you can spend a 
bit of time refi ning all of the other layer masks and 
making sure the edges are clean.

12
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Mountain highlight and boat You 
will now use the technique you used earlier 

to paint some highlights onto the background 
mountain. Make sure they are in keeping with the 
direction of the scene’s light source and do them 
on a layer in Overlay mode. Then extract the image 
of the boat from ‘boat.jpg’ to add a bit of action to 
the middle of the bay, and again use a couple of 
adjustment layers to shade it and adjust the tone to 
match the image.

13 Mountain refl ection You now need to duplicate all the layers for the background mountains and 
then fl atten those layers to use them as a refl ection in the water. Once you have done this, fl ip it upside 

down and place it as a mirror image below the mountain range; then when it is in position, once again use a 
mask to get rid of everything that is not over the water. Reduce the opacity of the layer, and adjust the Color 
Balance so it has a colder hue.

14

Final look To fi nish the matte painting off, add several colour and toning layers on top to add more 
drama into your image. Cool off the shadows and increase the warmth from the sun so you have a nice 

contrast of colours and shades to frame your scene. On each layer, use a soft brush and masks so the effect is 
applied only where you need it. Be sure to take a look at your PSD fi le and study each layer setting.

15



Source files
available

A selection of stock 
images on the disc

The following techniques will teach you to 
create a moody and ominous fantasy 
landscape. The world of J. R. R. Tolkien (author of 

The Lord Of The Rings and The Hobbit) easily provides 
inspirational context for countless images of this sort. The 
only things you’ll need are Photoshop and the 
opportunity to take your own stock photos. Third-party 
images almost work as well as your own photos, but 
might limit your possibilities in certain situations. Before 
you start with your image, think about the key elements 
that should be present. Be sure to have enough stock 

footage for your mountains in order to avoid repetition. By 
reading this tutorial, you’ll learn how to combine different 
photos to create new mountainscapes and add that little 
bit of magic to your scene. Special focus is given to 
working with composition and how to create depth of 
fi eld, using Photoshop gradients and the right cloud and 
haze effects. Last but not least, you’ll learn how different 
adjustment layers help to push your image to a whole 
new level aesthetically. It’s also benefi cial but not 
absolutely necessary for you to use a drawing tablet 
when performing this tutorial.

Magical snowscape  Photoshop

Tobias Roetsch Digital artist

Create a lord of the rings-inspired scene using 
photocomposite techniques

Compose a magical 
mountainscape
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Tobias Roetsch

Personal portfolio site
www.gtgraphics.de
Country Germany
Software used Photoshop
Roetsch has been focusing 
on space and science 
fi ction-based images as 
long as he’s been doing art. 
He improves his skills 
step-by-step with a lot of 
patience and effort.
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From reality to fantasy
mountain scene

Working

Step 02: Compose scenery

Step 08: Add clouds & fog

Progress

Step 15: Finishing touches

Create a 
concept It’s 

always good to start with a 
rough concept sketch to get 
your composition right from 
the start. You don’t have to 
be an experienced painter 
to do this. A medium-sized 
hard brush is suffi cient for 
this task. Just start laying 
down mountain silhouettes 
here and keep an eye on 
the rule of thirds. 

Get started Create a new document at 7000 x 4375px with a white, 
solid background. It’s useful to work with sky colours in the background, 

so it’s easier to combine your mountain stock in the next steps. Add a new layer 
and use the Gradient tool. In the Gradient Editor, set three colour stops at 0%, 50% 
and 100% with the colours #05355a, #115992 and #64a2d0. Place the gradient 
from the very top to the very bottom of your layer. Now you can start adding your 
stock images.

Place the foreground Open ‘IMG_6423.jpg’ and ‘IMG_6402.jpg’ 
and add both to a new layer in your image. Transform (Cmd/Ctrl+T) the 

IMG_6402.jpg image layer and enlarge it by 240% of its original size. Move it to 
the bottom-right corner. Repeat this with the other IMG_6423.jpg image layer 
and transform it to a size of 155%, fl ip it horizontally and place it in the bottom-left 
corner. Now take the Lasso tool (L) and make a selection of the parts you want to 
cut out in both of these separate layers.

Getting started
Begin composing your mountainscape

01

Scattering 
smaller 
clouds 
between your 
mountain 
layers is a 
great way to 
add depth

02 03
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Detailed edge The rough selection made with the Lasso tool means that it’s 
necessary to work with the edges of the trees a little more. Add a new layer mask to 

your IMG_6402 layer and select a small hard black brush 5px in Size with 85% Hardness. Go 
to Brush Settings>Shape Dynamics and change Control to Fade, set at 50%. Set Minimum 
Diameter to 0%. Now you can create a new edge for your trees, stroke by stroke. Make sure you 
are working at 100% zoom. 

Extend the landscape The two layers still contain 
undesirable elements, such as signs and skiing tracks. The 

foreground isn’t complete either. Activate the Clone Stamp tool (S) 
and sample the surrounding snow areas. This tool’s size should 
be around 30px with Hardness set at 80% to keep the details. 
Alternatively, use the Healing Brush tool (J), especially when it 
comes to replacing smaller elements. For the missing areas, make 
a fl at selection around the closest snow and copy and paste this. 
Select Edit>Transform>Warp and edit the snow sample until it fi ts. 
Use the Clone Stamp tool for transitions.

Create a 
Midground The other 

mountains are created using 
the same techniques as were 
used in Steps 3 to 5. Open up 
the fi le named ‘IMG_6405.jpg’, 
fl ip it horizontally and place it in 
the middle-left of your image. 
The other mountain photo stock 
supplied, ‘IMG_6413.jpg’, is quite 
a good choice for the right side. 
For organisational purposes, 
move both images to a folder by 
selecting the layers and pressing 
Cmd/Ctrl+G. Now, remove the 
sky and undesired trees like 
before and carefully work with 
the Clone Stamp tool to extend 
your mountains. Freely defi ne 
your mountain shape. Copy and 
paste parts you like and cut out 
parts you don’t. 

First improvements When your initial 
midground layers are complete, merge them 

by selecting both and pressing Cmd/Ctrl+E. Now 
it’s time for your fi rst colour and contrast edit. Go to 
Image>Adjustments> Brightness/Contrast and set 
Brightness at -50 and Contrast at 50 with Use Legacy 
deactivated. Press Cmd/Ctrl+B for Color Balance and 
set Shadows to -20, -5, +25; Midtones to 15, 0, -5; and 
Highlights to 20, 0, -5. For a softer edge, make a selection of 
your layer (Cmd/Ctrl-click layer), choose Select>Modify> 
Contract at 2px then Select>Modify>Feather at 2px. Invert 
your selection (Cmd/Ctrl+Shift+I) and then press Delete. 

04

05

06

07 Quick 
Tip

It’s essential for your artwork 
to work with the right material. 
You can download countless 
resources from countless 
websites. At the end, it’s the 
quality of the resources, next 
to your own abilities, that 
decides the fi nal quality of 
your artwork. Two good 
websites for an early resource 
hunt are www.deviantart.com 
and www.cgtextures.com. 
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Clouds and haze There still isn’t any real depth in the image, so 
add a second midground mountainscape behind your previous one and 

make sure it’s covering the left and centre of your image. Remember the rule of 
thirds and your initial concept. You want to create a valley on the right side. Make 
a selection of the layer and place a Foreground to Transparent #223857 colour 
gradient (G), applied from the bottom to the top of a new layer at 50% Opacity. 
Repeat everything, but use a stronger gradient.

Magic cloud trail Now comes the fantasy part of 
your image, which can be completed with the help of the 

brushes mentioned in Step 10. To create the cloud trails, activate 
Brush Settings and Shape Dynamics. Switch Control to Fade set at 
100 and set Minimum Diameter at 20%. The brush size should be 
around 600. Paint a curve from the middle-left to the centre of your 
valley several times, with several gradual opacity settings. Don’t 
forget to add darker cloud shadow as well. 

Foreground hazel Repeat Step 11 for a second trail, which should come from 
the bottom-right corner. Steps 11 and 12 might need some perfecting. Just pass over 

layers several times and play with settings such as brush size, opacity and colours until you get 
a satisfying result. The placement of the trails is indicated by the red marker you can see in the 
screenshot. This gives you an idea as to how you will create effects that replicate a mage’s ability 
to play with the forces of air.

Smaller midground clouds 
You’re now in need of a good, 

organised layer structure. Scattering smaller 
clouds between your mountain layers is a 
great way to add depth. It’s even easier when 
your mountains are on separate layers, like 
here. These clouds can be created by using 
stock images or by painting them. Dan LuVisi 
offers some great cloud brushes, available 
at http://danluvisiart.deviantart.com/art/
My-Brush-Pack-118954791. Cloud colour 
should be a bright grey, applied at a low 
opacity and brush size.

Final mountains It’s time to 
replace your blue background. Open 

‘IMG_1756.jpg’ and apply it behind your 
mountain layers. You can warp and transform 
it to your liking, but make sure that the light 
still comes from the left side. Add several 
layers for distant haze as already described 
in Step 8. In case you aren’t sure what opacity 
to choose for your gradient, just go with 
100% and play with the layer opacity controls 
afterwards. Good colours for your haze 
gradients are #5d7188 and #8c9db5.

08

11

12

10

09

Quick 
Tip

When it comes to adjustment 
layers, less is more. Color 
Balance, for example, should 
be used with only minor 
changes. If you’re overdoing 
it, the image immediately 
looks fake. Deactivate and 
reactivate adjustment layers 
individually to check if they 
add something to your 
scene.

Build background & foreground
Create clouds and fog, and add a focal element
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Snow effects Now add some snowfl akes to your scene. Add a 
new layer above all others, take a 5px hard round brush and paint some 

random dots. You might want to change the opacity of your brush every now and 
again. Duplicate your snowfl ake layer (Cmd/Ctrl+J), rotate this copy layer by 180 
degrees and size it up by 130%. Repeat this until you have enough snowfl akes. 
Merge all snowfl ake layers. Now go to Filter>Blur>Radial Blur, apply an Amount 
of 10, change Blur Method to Zoom and move the Blur Centre to the right side.

Finishing touches Apply a white, semi-transparent gradient to the 
very bottom part of the foreground. Adding large, blurred snowfl akes is 

also a nice touch. But the most important things are the adjustment layers you’re 
going to add now. You’re basically going for Color Balance and Brightness/
Contrast changes. For selective effects, use layer masks. Check out the PSD fi le 
on the disc for the individual layer settings and mask layouts.

The mage The image still 
needs a focal element, so 

here you’ll add a mage character. It 
will depend on your own abilities if you 
choose to work with stock images 
or try to paint your mage by hand. A 
combination of both is possible as 
well, of course. If you decide to paint 
your character, go for a small-sized 
hard round brush. Raised arms are 
good to symbolise that he is actually 
doing something. To better visualise 
his powers, simply add some semi-
transparent strokes above him. Take 
the Smudge tool to these, making 
them softer.

14
15

13

To better visualise your character’s 
powers, simply add some semi-
transparent strokes above him
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Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Sebastien Hue

Personal portfolio site
www.shue-digital.com
Country France
Software used Photoshop
Sebastien Hue is a 
self-taught artist who 
started using Photoshop 
when making logos. He 
rapidly turned his attention 
to sci-fi  environments and 
matte-painting techniques 
that let his imagination 
run wild.

Landscapes

http://www.shue-digital.com
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This tutorial is going to show you how to create 
a space scene using elements traditionally 
associated with Sci-Fi. You’ll be combining 

asteroids, planets and spacecraft to create a truly dynamic 
and unique composition. 

We’ll be exploring how to use Photoshop to create all of 
these assets and essentially an eye-catching spacescape 
full of depth and awesome lighting. The Photoshop tools 
we’ll use to do this are pretty standard and we’ll personalise 
the exposure by painting effects manually. We’ll utilise 

textures and blending modes to enhance contours and 
composite 3D elements to augment our image’s realism. 
Layer Style options are essential when producing 
believability, while Inner Shadow, Inner Glow and Outer Glow 
will all also feature.

Here you’ll also discover how to build an entire nebula 
from scratch by working with textures in Photoshop, then 
letting your own creativity and intuition do the rest. This 
workfl ow will enable you to experiment and produce 
interesting shapes and ultimately an epic sci-fi  scene.

Sketch your composition It’s always good to fi gure 
out a decent composition by sketching your ideas in several 

layers. Try to remain fl exible throughout the process and play 
around with your elements, especially any included planets. Use a 
hard round brush with Brush Presets>Shape Dynamics activated 
to vary the opacity control of your Pen Pressure. Outline your 
composition roughly in greyscale, including the main elements, 
then defi ne the scale, depth and light.

Add in a planet Create a new layer at 4,000 x 
4,000px 300dpi with a black solid background, then 

defi ne the centre of your document by applying two guides. 
We’ve imported and used the high-defi nition texture fi le 
fontenellefi re_ali_2012186_lrg.jpg from http://visibleearth.
nasa.gov. Hold Shift+Opt/Alt and apply the Elliptical 
Marquee tool from the centre to the border to get a perfect 
circle. Next, apply Filter> Distort>Spherize twice, at 100%.
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Nebula  Photoshop

Sebastien Hue Digital artist

Enhance depth, lighting and texture to 
build a unique 3D scene

The concept stage
Consider your backdrop and environment in initial sketches

01

Create space art

02

From empty space to a 
sprawling scene

Working

Progress 1: Gather elements

Progress

Progress 2: Add and refi ne

Progress 3: Boost effects

Source files
available

On the disc we have supplied 
personal stock and 3D renders 
and you can download 
free-to-use stock from http://
visibleearth.nasa.gov.
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Emphasise relevant details  When 
you’ve achieved satisfying results, duplicate 

your texture, hit Cmd/Ctrl+T and descale towards 
the focal point of your choice – this should produce 
more depth and detail. Create smooth transitions by 
softly erasing the textures and elements created in 
Step 4, using applied vector masks. Apply a black-to-
transparent gradient or a soft brush on these masks 
to emphasise relevant details. Feel free to paint 
highlights and shadows on a new layer to defi ne your 
nebula textures further.

Create shapes using stock  Import the supplied ‘Jordan_Marble_texture.jpg’ and invert 
it (Cmd/Ctrl+I) to create a nice contrast and a green tone. You can do this with any texture to reveal 

interesting shapes when inverted. Continue to play with your Levels adjustment layer to defi ne the texture’s 
contrast, then apply a Soft Light or Overlay blending mode between 50% and 60% to this layer. Hit Cmd/
Ctrl+T, to transform the texture with the Warp tool to match the contours you made earlier, then play around to 
optimise the positioning.

Pick your colour scheme  Create 
a new document at 2,950 x 3,800px 300dpi 

or higher with a solid black background, then 
activate the Lasso tool to make a selection. Select 
colours from bright to dark, creating a spectrum in 
the Gradient Editor. In our example we’ve applied 
Color Stops using #ffffff, #d599d8, #5a8eaa and 
#37667c. Apply this gradient to your selection from 
the centre at an angle, then deselect and apply a 
Gaussian Blur. You can use this same method for 
other similar selections.

Apply a 3d effect  Add a vector mask to create a textured circle, then insert a new layer and apply 
a horizontal gradient from right to left, with a black-to-transparent style. Next, highlight the left borders 

with your selection still active and use a soft white brush to simulate a horizon lighting effect. With your selection 
still active, create a new solid black layer above your planet layer, set to Screen blending mode. Add a cyan 
(#bbe6f2) Inner Shadow Layer Style at 40% Opacity, with Distance set to 40px, Size at around 250px and 
Angle at 170 degrees. Next, apply a bluish Outer Glow at 65% Opacity, with a Size of 50px and a Range of 55%. 
Add a bluish Inner Glow at 75% Opacity, with Size between 100 and 120px.
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Quick 
Tip

Take your time to clearly defi ne the light source in 
your scene, as it’s a crucial element when creating 
believable worlds and will save you a lot of time in 
the later stages. This essentially directs the 
orientation of a planet in accordance with its light 
and shadow.

Landscapes
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Focus the lighting  Creating a defi nitive 
light source in your scene is another crucial 

step when producing believability. We’ll begin by 
importing the planet we created in Steps 2 and 3, 
duplicating this and placing the new layers in other 
areas of the image. If you want to vary the look of your 
planets, we suggest creating a fi le full of alternative 
textured globes and importing from this selection. 
The sunlight that’s represented here by a large white 
dot will defi ne the position of your planet’s lighting.

No stars, no space  What’s a spacescape without bright stars? These are elements that will 
improve your image’s authenticity. To add them, begin by creating a new solid black layer and apply 

some white dots at varying opacity and sizes. Duplicate your new star layer, size it up or down, rotate it and 
reset the Opacity to 80%. Merge the layers, duplicate this new layer, rotate it again and add bigger painted 
dots with associated star colours. Repeat these techniques until you’ve created a believable spread of stars. 
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To make your composition even 
more realistic, interesting and 
original, you can use cross-
platform software. Study and 
understand the capabilities of 
such software to augment your 
own process and the results of 
your work. 3D packages, such 
as 3ds Max or CINEMA 4D, are a 
great starting place to get to 
grips with creating CG assets 
and understanding the working 
of the third dimension. You’ll 
become less restricted to a 
single plate photograph, where 
drastic perspective changes 
become quite diffi cult. After 
Effects is also an interesting 
application, as it comes with 
many plug-ins that could serve 
your 2D images, like the Optical 
Flares plug-in used here to 
enhance the Sun.

Essential 
software
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Refi ne the ship  Any spacecraft to be 
included deserves special care, so we’ll want 

to draw the viewer’s eyes to it by moving towards 
our sunlit focal point. Add surface details with metal 
texture stocks, sci-fi  textures, or any other royalty-
free stock applicable, then warp them like in Step 
5. Ctrl-click your layer and select Create Clipping 
Mask, then paint in typical sci-fi  lights using a soft 
white brush. Just as in Step 3, add an Outer Glow 
with 100% Opacity, 0% Range and 12px Size set to 
Overlay mode.

Add adjustment layers  Use a Hue/
Saturation layer with Saturation at +45, then 

a Brightness/Contrast layer on top with Contrast set 
at 45 and layer Opacity at 60%. Paint hints of purple 
(#d293d2) using a soft round brush to a new layer 
beneath these adjustments. Apply with a soft round 
brush set to Color blending mode, at a low Opacity 
of around 10%. Add a Curves layer, setting the RGB 
Curves Output to 65 and Input to 95. Set the Green 
Curves Output to 55 and Input to 80. Last, set the 
Blue Curves Output to 90 and Input to 60.

Final sharpening  Import the supplied 
‘SUN FLARE.psd’ and set this new layer’s 

blending mode to Screen. After including a couple 
of red comets in the background and adjusting 
all the layers, we can start sharpening. Flatten 
your image by hitting Cmd/Ctrl+Shift+Opt/Alt+E 
then select Filter>Sharpen>Smart Sharpen. Set 
Amount to 70%, Radius to 0.6px and activate More 
Accurate. Duplicate the layer and select Other>High 
Pass, setting the Radius at 3px. Set this new layer’s 
blending mode to Overlay at 50% Opacity.

11 12 13

Add more elements
Enhance realism and 3D elements inside Photoshop

Apply motion blur  The elements here 
look a little too static, so we need to imagine 

how all the scene would look if animated. Picture 
this in your mind’s eye and try to think of the global 
movement of asteroids in space, for example. Select 
several asteroids, apply Filter>Blur>Motion Blur and 
simulate this movement with an applied Angle of -53 
degrees and a Distance of between 4 and 6px. Try to 
be coherent when relating the motion of one element 
to the next.

Use 3D fi les  Import the supplied ‘Spaceship_model_render.jpg’ and ‘Asteroids_render.jpg’ 
into your scene. We need to correct hard edges or pikes generated by the 3D program, so take the 

Lasso tool with Feather Radius set at 1px and redefine the edges of the asteraoids by erasing from the edge 
selection. This method is manual and offers a better degree of control when refining edges, however, you 
can save time by using the automated Refine Edge tool. Hit Cmd/Ctrl+Opt/Alt+R to activate. 

10

09

Landscapes
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Use a perspective grid  Activate the 
Line tool set to a red and apply vertical lines, 

holding the Shift key to approximate symmetrical 
spacing. Hit Cmd/Ctrl+E to merge all your line 
layers, duplicate your layer and rotate it 90 degrees 
to fashion a square grid. Merge these two layers and 
select Edit>Transform>Distort to defi ne perspective, 
matching the lines of your spaceship.

Apply texture accordingly  Take a 
cool sci-fi texture that has defined shapes 

with clear angles, then apply a low Opacity value. 
Distort this using the Transform tools, matching your 
grid lines while transforming and making sure you’re 
compliant with the correct perspective. This may 
take time, but worth doing right to get the best effect.

Add blending modes Once you’re 
satisfi ed with your transformation, reset the 

Opacity of your texture layer to 100% and experiment 
with different blending modes according to the 
effects you want. We advise sticking to the Overlay 
or the Soft Light types, which are very effective for 
soft texturing. Finally apply a layer mask to erase the 
areas you don’t want.

14
15

16

The diffi culty when working in three dimensions is 
understanding how your three axes are actually defi ned in your 
scene. However, your favourite 3D program will normally work this out 
for you, which is very convenient. The program will usually calculate 
everything according to your XYZ axis and once you apply the texture to 
your object, the perspective will readjust wherever you move your object 
or camera. 

However, what if you’re applying outside of a 3D program? Problems 
can occur when you try to translate a 3D object into 2D space. Never 
fear though, because luck is on your side if you’re at least starting with a 
3D-rendered object, such as our spacecraft. This render will give you 
clues as to the actual perspective required, but it’s still up to you to 
defi ne it correctly, corresponding to the proper perspective when 
painting or texturing stock in post-production. Here we show you the 
best ways to tackle this creative conundrum and get plausible effects.

Texture in 2D
Create the illusion of 3D space using two-dimensional photo stock

Before After
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Digital artists explain the 
techniques behind their 
amazing artwork
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Eduardo Lopez 
Mustaros
Personal portfolio site
www.edlostudio.net
Country Mexico
Software used Photoshop
Ed is a professional matte 
painter currently working at 
Epics Fx Studios in Mexico 
city. He started a couple of 

industry and now has two 
European-Turkish movies 
under his belt plus several 
TV shows for the History 

channel.

Source files
available

stock images used are 
free to download, please 

links to each individual 
image referenced in the 
steps.

http://www.edlostudio.net
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In this tutorial we will embark on a matte-
painting adventure to achieve a fantasy image 
setup in the desert. We’ll start with a basic image, 

then paint detailed rock structures and use several images 
to convert a simple background to a fantasy environment, all 
while maintaining realism. Here we will need to use a pen 
tablet, since there is quite a bit of brushwork involved. You 
can try to use a mouse, but the process will be much more 

The tutorial is completed with Photoshop CS6, but you 
can use almost any version from CS2 onwards to achieve 

the same results. However, bear in mind some items and 
settings might have different names. As you progress, it’s 
recommended that you go through the videos to catch the 
action and details, as they can provide a better 
understanding of what is being done and clear up any 
doubts you might have before tackling the steps. 

In order to successfully complete this tutorial you’ll need a 
strong practical knowledge of Photoshop, since basic 
operations like accessing a menu, utilising the Brush palette 
or using a layer clipping mask are not explained. 
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Desert  Photoshop

Eduardo Lopez Mustaros Digital artist

Learn how to work with images to achieve a matte painting, 
using the process of cutting, painting and blending

Create a fantasy 
matte painting
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Balance the colour The 

Replace the 
foreground 

Create the abyss 

Detail the 
abyss 

01

02

03

04
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Highlight the walls Now 
that we have a section shaped, 

we want to start considering the sun 
or main light source, so we can start 
getting the feel for the volume in these 
rocks and how highlights change 
depending on the distance, as well as 
the shadows. Start sampling highlight 
colours from the plate according 
to the position on the landscape. 
Adding simple highlights gives the 
appearance of volume on the rock 
walls, with the variations applied 
according to depth providing a greater 
sense of distance.

Focus on the details 
Once we have a base structure 

time to zoom in a bit closer, reduce the 
brush size and start adding detail in 

Now that we have the overall light 
direction and depth dialed in, we can 

we have done so far, adding one more 
level of detail. This process has several 
levels or stages to it, depending on the 
detail we want.

Add some buildings
time to add some man-made structures 

to our image. Download and open image 

brush, mask off at the base so it sits on the sand.

05

06

08

07

Quick 
Tip

Painting, whether digital or 
not, is a process that takes 
several stages to get the 
right effect. Whatever the 

the overall shape. See how 
that looks, then add furhter 

zoom and decreasing the 
size of the brush.
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Lighten the building  For the highlights 
we need a new clipped layer on top of the 

building stack, set to Normal or Overlay blending 
mode. Make the Chalk brush very small, to around 
1-2px, and sample highlights from the sky to paint in 
the shimmers on the walls and roofs of the building. 
Remember to always keep in mind the light source 
and apply the highlights just where the sun would hit 
the structures.

 Use blending and shadow We will now add Color adjustment, Levels and Hue/Saturation 
layers all clipped to the building layer. What we are looking to do is match the overall shade and colour 

base building. By sampling colour from the plate we can paint in a shadow for this building over the sand.

Place a foreground tower  Add more buildings to the 
left and right of the image, using exactly the same technique as 

before. However, the foreground tower represents a bit of a challenge, 
since it’s much closer. Open up the link to the tower image ‘667214’ and 
extract it with a mask. Add a Levels layer to lift the blacks and darken the 
whole structure, then a Color Balance layer to match. Add the Highlight 

Make sure you are constantly checking if these changes make sense 
with the sun’s position, as this will be key to achieving the desired effect.

Bring in shadow 
blur and highlights  

A new feature in Photoshop CS6 
is the Field Blur. This is a brilliant 
tool if you want to control the blur 
over distance or shape using 
anchor points. In this project we 
need less blur close to the tower 
structure and more further from 
it. Set the layer mode to Overlay 
and reduce the Opacity to 75%. 
For the highlights, mask off the 
Levels layer with a 1px brush to 
reveal the original brightness 
that, in direct combination with 
the main Highlight layer set to 
Overlay, will give us a far more 
dramatic result.

09

11

13

Apply tower shadow  To get a nice shadow we’ll use the same tower, so 
duplicate all the tower layers, adjust the levels so it becomes black and then merge 

all these duplicated layers down. We will position this layer below the main tower layers and 
use the Distort command to place it over the sand. Always keep in mind that the shadows 
will project perpendicularly in opposition to the light source. To add some surface distortion 
we can also use the Warp tool a bit.

12

10
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 Insert the background mountain Download and insert the 
back mountain image from the link on the disc (‘1234175’) and paste 

it onto a new layer. Now we’ll again use a mask to carefully extract the main 
mountain, so we just keep what we need. Now, as with the buildings, apply 
Color Balance, Levels and Hue/Saturation layers to make it match the overall 

to blend nicely.

 Highlight detail and dirt Next insert 
another Highlight layer, also on Overlay, to 

brush. We’ll then follow with another layer, also in 
Overlay mode, to start adding dirt, wear and cracks 
onto the sculpture. Use the 2px Chalk 23 rock 1 

help add in random detail in a shorter time. Again 
be sure to keep in mind the light source position and 
also where the dirt would accumulate.

 Extraction and adjustment layers We will extract the statue 

a process similar to the foreground tower, using the mask to hide the bottom 
section following the mountain shape so it sits nicely on top of it. Next add Levels 
and Color Balance layers so it blends with the mountain and landscape at that 
distance. Add a new layer, also clipped, then set it to Overlay and start painting 
the highlights.

 Use extra texturing Use another layer with a layer style texture applied to it, so we can increase 

medium-grey tone, enable the Pattern Overlay in the Layer Style dialog and load the rock pattern. Reduce 
the Scale a bit and move the texture so we get it in position. Rasterise the layer, set it to Overlay and reduce 
the opacity.

14

16

15

17
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Cut the statue  We will now cut some pieces off the 
statue to add to the ancient look we want, then add a new 

layer where we can paint in some volume and highlights that 
correspond to the missing pieces. Continue using the small Chalk 
brush and just sample colour from the statue itself. Remember how 
you have painted these volume and highlights so far and always 
keep the light source in mind.

Apply some drop shadow 
to the mountain element  

We need to paint in some huge shadow 
for the mountain all over the left of the 
landscape. To have complete control over 
this process we will use a Levels layer. On 
the mountain stack, create a new Levels 
layer and start by bringing everything 
down darker. Fill the layer with black so 
it’s all gone and paint in with white only 
where you want the shadow to fall. Again, 
always keep in mind the position of the 
light source.

Enhance the sand  Now we’ll paint in some sand that piles up to the mountain. 
Find the mountain layer and create a new layer on top. With the Chalk 23 brush, at about 

1-2px size, start painting in sand over the lower part of the mountains. Remember, we always 
do our painting with Transfer enabled, controlled by Pen Pressure. Follow the shapes of the 

Adjust the shadows  Once we have the shadow where we want it, 
we will adjust the Levels layer to change the hue and depth so they match 

the rest of the image. We will accomplish this by adjusting the levels of the colours 
separately. So, if we go into the Yellow channel we can play with the blue/yellow 
amount our shadow has and if we go to the Green channel we can adjust the 

Complete the mountain Once we have the shadow, we’ll repeat 
the process on the mountain itself so both the landscape and the rocks 

have matching shades of shadow. We’ll create another Levels layer for the 
mountain and repeat the same process of masking and carefully adjusting the 
levels so that both shadows are the same. We can paint some more sand in the 
shadow area on a new layer, sampling colour from the closer shaded areas.

18
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Include live elements  To add some new elements to our image 
we will use another of the image links found on the disc. Download, open 

with a selection or a combination of both. We only need this camel and man for 

Insert detailed shadow  We will go about this the same way as we 
did the tower, adding shadow using the camel layer itself then duplicating, 

darkening and distorting it into position. Finalise it with a bit of adjustment from the 
Warp tool, set its mode to Multiply and reduce the Opacity to about 46%. Finally 
adjust the colour balance directly so the shadow is a bit colder.

Finish your adjustments 

to the mountain and statue layers and increase the warmth on these separately.

Paint tiny features 
tracks for the camel, sampling a darker shade from the plate close by 

and painting in a trail of prints. Then we will go back to the highlights in our tower 

sections of the tower.

Placement and shading 

in the original layer. We will then scale them into position and apply to each our 
technique of adjustment layers to bring the colour on par with the rest of the 
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The concept was initially 
created on a sheet of paper. 
I later took a photograph 
and continued working on it 
digitally.  At fi rst I thought it 
would be a horizontal work, 
but it turned out that it 
would look better in a 
vertical position.

Concept
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The idea for this project was to create an 
alien landscape. One evening I was making 
sketches on a sheet of paper when I came up 

with an idea of a deserted spaceship, or maybe only its 
engine. In fact, it looks like a skeleton of a gigantic, 
extinct animal. Was this animal specially adapted for the 
creation of a huge machine or was it a product of 
evolution? Or maybe it’s something else? I prefer viewers 
to make their own minds up. 

In this tutorial I will explain how to create an 
otherworldly landscape using only ZBrush. With this one 
program you can complete the modelling, create your 
own alphas (used to model the scene by texturing), 
create materials, set up the scene, choose an effective 
perspective and lighting, and even make your fi nal 
render. The compositing and colour correction will be 
fi nished up in Photoshop. Read on and follow the tutorial 
to fi nd out how it’s done so you can create your own. 

Create a base mesh First we will 
make a base mesh. The fi rst of these is a 

model of an exterior object similar to skeletal ribs. 
Use a torus as a base mesh, then the Clay Buildup 
brush and the DynaMesh tool in ZBrush. Try to 
make a structure similar to that of the concept. At 
fi rst it may all look clumsy, but the main idea is to 
create some base meshes that can be used later to 
construct the scene.

Shape the inner circle 
In order to get a better 3D preview, try to put 

together most of the main objects of the scene in the 
early stages. Next create the inside of the circle. Use 
the concept to create an alpha with the shape of the 
interior, then the ZBrush tool ShadowBox to get a fl at 
object, which is a great basis for further modelling 
later on.

Build the basic models Now we’ll 
create the models for the rest of the objects. 

The base of the circle is modelled with the Clay 
Buildup brush and the DynaMesh tool. Add a fl at 
box, emulating the ground. Now we need to think 
over how many parts the main model will be made 
up of and divide those models in order to get the best 
quality. It’s also crucial that the base is joined with 
the ground to have a better and smoother transition 
between the main structure and the ground.
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Secret place  2012 Photoshop, Zbrush

Work exclusively within ZBrush to build all the object 
elements, then move on to Photoshop to perfect your render

Model the foundations
Start with a very basic outline of the whole scene, using simple models
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Digital artists explain the 
techniques behind their 
amazing artwork
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Tomasz 
Strzałkowski

Personal portfolio site
www.tomstrzal.com
Country Poland
Software used ZBrush, 
Photoshop Modelling, 
texturing, lighting and 
rendering. 

Sculpt an epic 
sci-fi terrain 
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Tomasz Stralkowski Digital artist

http://www.tomstrzal.com


140  Fantasy Art Genius Guide

Landscapes

Duplicate models 
to check scale 

When we have the shapes 
we want, it’s time to copy the 
objects and put them in a scene, 
taking the perspective, camera 
and layout of the objects in 
relation to one another into 
consideration. This enables 
us to tell whether the applied 
changes are good enough and 
if the main shapes are close to 
what is needed. This is a good 
habit to adopt, particularly when 
making epic scenes like this.

Model detail and create more alphas Now 
the main shapes are sorted, it’s time to apply more detailed 

modelling. Alphas that we can extrude in the object will be very 
helpful. You can make them yourself very easily within ZBrush. All 
you need to do is model a suitable shape: go to Projection Master, 
use the MRGBZGrabber tool and you will have an alpha ready to 
add to your main model.

The mechanical inner circle After confi rming the shape of the exterior object, 
it’s time to add details to the interior object of the structure. We want the object to have the 

right thickness and for it to consist of several layers. It needs to look like a corroded and crushed 
interior of an engine. First paint a mask on this object, which is needed to extrude its thicker 
sections. Next, use the DynaMesh tool to improve the topology. Add medium and small detail 
using the prepared alpha base and hand modelling.

Landscapes
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Make broad sculpts The main element, which looks 
like a spine with ribs, needs an appropriate scale with the 

thickness of the ribs. It’s also important for it to look good in the 
target perspective. It could be that the ribs of the structure contain 
engines to propel the ancient ship, so they need to be strong and 
have a secure physical connection to the main spine.

04 05

07

06

Add some alien detail 
Distribute your key features to convey the image’s story

In all my work I keep all the used elements, such as alphas 
modelled in ZBrush, which I can use for future works. I also 
create the alpha and brush bases. I try to put together the 
scene as quickly as possible and do the rendering so I can see 
how particular shapes look. This way I can also see the details 
in the composition as a whole. In the early stages I try to put 
the camera in the right position and choose the best 
perspective in such a way that I can see how much work is 
needed for each element. Frequent rendering helps me see 
the whole picture and enables me to decide whether I’m going 
in the right direction. 

Detail, composition 
and the right view
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Unify your elements
Join your terrain and alien craft, testing all the way 

Begin to blend the sections The base will also 
need the right shape and ratio; the initial concept was to 

have the base fl atter, but as you can see both the terrain and the 
base both ended up being slightly raised. The base has to be 
constructed in a way that will enable us to join it with the rest of the 
terrain in the foreground later.

Connect the wide terrain Despite having quite a precise idea about the work 
as a whole, we should still look for the best shapes and details. Constantly make tests 

of your progress to ensure every element is working. A good example is the elements on the 
edges of the exterior objects or the details of the terrain joined to the base of the construction. 
Adding a few fi gures at the base of the object can show off its scale in an impressive way.

Test the lighting 
and colours The 

lighting and the climate of the 
work are very important, which 
is why during test rendering you 
should always consider their 
direction, colour and brightness. 
The background is also crucial, 
especially its colours and in 
this particular case the fog that 
occupies it. This fog’s thickness 
and colour has a great infl uence 
on the whole work.

09

Usually the fi rst steps go very quickly if you 
have a vision, idea and a concept you’ve 
drawn yourself. Unfortunately, making the fi nal 
decisions requires many tests and changes. 
Most diffi cult are the details and their layout. 
It’s often the case that a considerable part of 
the work is inadequate and you have to start 
all over again, but this is what the creation 
process is all about. When you fi nally achieve 
the expected outcome, it’s very inspiring and 
gives you the energy and motivation for 
further work.

Stick with the 
process
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Test BPR rendering and 
composition 

Having modelled the whole work and a 
series of initial simple renders, we now 
need a more accurate render with the 
right camera position and perspective. 
At this stage, try to choose the optimal 
direction of the main lighting and select 
the best rendering values. Thanks to the 
rendering being completed in layers, we 
can create a fi le in Photoshop where all 
the layers can be put together properly.

Begin texturing with 
the Spotlight tool When 

the objects are ready, begin to texture 
using the Spotlight tool in ZBrush. 
Obviously, even after the texturing, 
some changes will need to be made 
to the model, though hopefully these 
will be minimal. We’ll use several 
textures that will be manipulated to give 
us complete control and introduce 
some quick changes, even if there 
are changes made to the geometry.

Modify materials Now we’ll begin selecting the materials. The 
materials of the main structure, the terrain, some technological elements 

inside the main circle and on its edges are all a little bit different. In order to 
increase the details, add noise on the terrain in the foreground and try to select the 
right values, such as Specular, Ambient or Light Cavit.

11

12

13

Tomasz Strzałkowski

Tree ZBrush, Maya,
2009, Photoshop

In this image Tomasz wanted to 
combine mechanical shapes with tree 
shapes. He made the main model in 
ZBrush. After this I rendered it with a 
Displacement map in Maya

Roots ZBrush, Maya, Photoshop
2009, Photoshop

 In this image he continued the idea 
of Tree with a combination of 
mechanical and organic shapes, but 
with a different point of view. This main 
model was created in Maya

Tree Branches ZBrush, Maya
2010, Photoshop

 Tomasz had many parts and models 
from Roots that he wanted to use 
again. Here he used the same 
techniques that he learned creating 
Roots

Form the surfaces
Inject mood and atmosphere

Frequent testing in the 
target environment and the 
climate of the work is key. It 
means arranging and 
rendering layers with the 
lighting, shades, depth and 
colours in Photoshop. You 
also need to fi nd the right 
climate. It’s often the case 
that even the smallest 
changes have a very big 
infl uence on the whole 
work. When I am 
approaching the end of a 
project, I often take a long 
and careful look at the 
image, trying to fi nd 
mistakes and thinking 
about how I can improve it.

Any changes made from 
now on are very thoroughly 
thought over. It’s a diffi cult 
stage of the project 
because you have to know 
when to stop and fi nish it, 
rather than forever making 
hundreds of small 
changes.

Always 
test the 
project
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Adjust the main lights 
The primary lighting, the complementary lighting and the ambient lighting 

should all be rendered separately and only then combined together in Photoshop. 
In ZBrush you can get a very nice ambient lighting by loading an HDRI map and 
clicking the LightCap icon. This way we can get the collection of lights arranged 
in the space, the same as in the HDRI map. You can edit each one of these lights 
individually in order to get the exact mood you want.

 Begin the rendering 
step

After frequent rendering tests it’s now 
time for the fi nal rendering in high 
resolution. In order to do it, fi rst create a 
ZBrush project, save all the rendering 
values and put the camera in the right 
position with the perspective you are 
aiming for. Next, load the object. As 
mentioned before, we will render in 
layers, which enables us to put them 
all together in Photoshop. There are 
several separate layers for the lighting: 
Ambient Occlusion, Mask, Depthmap 
and fi nally the Light Cavity.

Move to 
Photoshop for 

the compositing 
Photoshop enables you to put 
all those different layers into 
one fi nal picture. Manipulation 
of the layers gives you a 
range of great composition 
possibilities. You can also 
create and add a background, 
fog effects, as well as correct 
the colours. This is the stage 
when the work acquires the 
right climate, and is fi nally 
refi ned and fi nished off.

14

15

16

The outline of a concept created by our imagination is often the right 
one, but it’s very diffi cult to fi nd the best way to implement it. On the 
other hand, it’s a very exciting process because it requires you to 
fulfi l a vision that comes from within. Until you fi nd the right version, 
use one that will make you feel satisfi ed, at least for a short while. 
Although the picture in your imagination is vague and it often 
changes, you will fi nally fi nd the right shape and you will feel it. It’s an 
inspiring moment!

As is often the case when creating original 
images, I came across many problems, and while 
I was looking for solutions I learned a lot of new 
techniques. If you want to achieve a desired 
effect, you have to go for that goal whatever the 
problems – technological or inspirational – you 
may face. With the right amount of work and 
involvement, most problems can be solved and 
each and every obstacle you overcome will teach 
you something new and increase the range of 
your skills. I hope you’ve enjoyed the tutorial and 
take some inspiration from it. 

The best shapes

Final thoughts 

Work towards rendering
Refer to your concept and refl ect on your aims
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Digital artists explain the 
techniques behind their 
amazing artwork
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Jennifer Cirpici

Personal portfolio site
www.breaking
canvas.com
Country Netherlands
Software used Photoshop
Jennifer is a self-taught 
graphic designer and 
illustrator from the 
Netherlands. She studied 
graphic design, has worked 
for several big agencies like 
Saatchi & Saatchi and Leo 
Burnett, and is currently a 
freelance digital artist.

Landscapes

http://canvas.com


Fantasy Art Genius Guide  145

Genius Guide
Fantasy Art

What you will learn in this tutorial are several 
basic but essential techniques like blending, 
colouring and painting over a scene comprising 

multiple photos. This workshop is fundamentally inspired 
by the lush mountainous scenery in the movie Avatar. The 
Zhangjiajie Mountains, located in China, inspired the makers 
of Avatar to create the fl oating Hallelujah Mountains; they 
also inspired us for this tutorial and we used stock imagery 
of this range to create this artwork. We’ll go into how you can 

combine real and painted elements (the essence of matte 
painting) in depth. 

Over the course of these steps we’ll also look at how you 
can blend stock easily and how essential colouring is when 
it comes to setting an atmosphere. This guide will not only 
help you to create these Avatar-esque fl oating mountains, 
but also to improve your future photomanipulations. Unlike 
the scenes created for the fi lm, we will only be using 
Photoshop to achieve these effects.

Stock search The fi rst step is to fi nd some high-quality 
mountain stock images to begin your piece. The sky is white 

in our image and we want to add some clouds, so we search for 
good sky photos, paste them over the landscape, then blend using 
layer masks as well as the Overlay, Multiply and Normal modes.

Bring in some colour For a green tint, create 
a new layer fi lled with #f6f6e5 and set to Multiply. 

Now create a new layer set to Multiply, but fi ll this with a bluish 
gradient at 36% Opacity. Use Curves to up the contrast and 
tweak the greens with a Color Balance adjustment.
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Fantasy World  Photoshop

Jennifer Cirpici Digital artist

Jennifer Cirpici takes you through the process of creating this 
Hollywood-inspired environment

Create a lush environment
Manage your stock, colours and blending

01

Source files
available

Use the photo set to 
create fantasy worlds

Create fantasy 
landscapes 
from photos

02

Use coloured layers to 
build up vibrant art 

Working

Step 01: Stock search

Step 08: Shadows and 
accents

Progress

Step 17: More mist
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Floating mountains With the help of CGTextures
(www.cgtextures.com), we source some free landscape 

stock images and blend them together to produce a mountain 
reminiscent of those in Avatar. This is very much a matter of 
artistic licence so you will have to decide on the scale, shape 
and which materials constitute your mountain when you come 
to constructing it. As previously demonstrated, use layer masks 
to bring elements together, as this will help to blend effectively 
using black and white brushes. Also, make sure that when you 
are using these brushes you are working with a low Flow value 
as this will help to achieve a smooth blend.

Landscapes
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03

05

06

Quick 
Tip

You may fi nd that you get 
stuck sometimes, and lose 
inspiration or motivation to 
continue with your artwork. 
Some of the best solutions 
are to either sleep on it, take 
a couple of steps back from 
your screen or, as we did in 
this tutorial, just change the 
perspective by fl ipping
it horizontally.

Depth and highlights To create depth and 
highlights, we use a small, hard brush, painting with 

black where we want to generate a bit more shadow. We set this 
layer to the Soft Light blending mode and lowered the Opacity 
to around 70% with the brush Flow at 70% too. Follow the same 
process with a hard white brush, this time creating highlights with 
the layer set to Overlay. You can use this technique with all your 
photomanipulation projects to great effect.

Gradient shading Select the fl oating mountain 
and, with a black-to-transparent gradient, create a 

shadow at the bottom of the scene, fading out towards the top of 
the image. Lower the Opacity to 28% and repeat this step. Select 
parts of the mountains from the background and paste into the 
bottom to give it more texture. We’ll go into more depth with this 
in a moment. At this stage, it’s a good idea to take a fi nal look 
and check you’re happy with the composition. To do this, go to 
Edit>Transform>Flip Horizontal.

Mountains and birds We now add in some mountains from another stock photo. 
Set the layer’s blending mode to Multiply with an Opacity of 68%, then make the mountains 

a little greyer so that they all blend well together. Blur the mountains using the Gaussian Blur fi lter 
set to a Radius of 5px because they are further away and this will create a greater sense of depth. 
Finally, fi nd some nice bird images and paste them into the composition, using the Edit>Transform 
options to match the scene’s perspective and scale.

04

http://www.cgtextures.com
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08

09

10

Add some clouds To add realism to the fl oating 
mountain and to establish its signifi cant scale and 

airborne position, we imported some clouds, placing them 
around the bottom of the mountain. Render the clouds with 
channels, put them on a new layer and then invert it (Cmd/
Ctrl+I). Now select the black parts (the clouds) with the Magic 
Wand tool and erase the rest. Blur the clouds with Filter>Motion 
Blur to lend them a greater sense of movement.

Shadows, 
accents and 
eerie mist  

As this project goes on, 
and the more that you 
work on the mountain, 
the more likely you are 
to notice that it requires 
more details. At this 
stage, for example, we 
decide that this image 
needs more shadows 
and highlights. Repeat 
step 6 and go into 
more detail using a 
smaller brush. It’s time-
consuming work, but this 
effort will pay dividends 
when it comes to the fi nal 
result. To generate a mist 
effect, take a soft brush, 
sample the colour from 
the background with the 
Eyedropper tool and 
brush over the mountain 
and background before 
switching to Soft Light 
blending.

Mountain vegetation We are now going to add 
some shady plants to the bottom of the scene and 

around the base of the fl oating mountain. You can do this very 
simply by taking the hard brush again and, with a grey colour, 
drawing in plants that are hanging down. The trick is that they 
don’t have to look exactly like plants when zoomed in, but when 
you zoom out they should look convincingly like the silhouettes 
of trees or shrubs. You only have to make these plants as 
complicated as you want to.

Add some plants In Avatar, the fl oating islands have long vine-like plants to help 
people move from one island to another, and we’re also creating these in our scene. Take a 

hard brush and draw some simple lines to get the basic plant forms from one mountain to another. 
Then, with a green colour, add more lines over the fi rst set and then a fi nal group of lines in a lighter 
tone for shading. You can also set some of the lines to Overlay.

Make the fantastical real
The secret is in the details



148  Fantasy Art Genius Guide

Landscapes

Mountain 
edges 

Because we could 
never have rendered 
the rock in a way that 
made the plants at the 
edges look good too, 
we need to add our own 
fl ora to the mountain 
edges. This will better 
blend the mountain into 
the sky and reduce that 
copy/paste feel. Again, 
you don’t have to paint 
the plants or leaves very 
realistically as they’re 
in the distance and 
shrouded by mist. Make 
sure not to use 
one colour – always add  
in highlight and 
shadow tones too.

Waterfall details With a soft brush sized around 
500px, brush once more into the waterfall, but lower the 

Opacity to 28% and set the blending mode to Soft Light. For 
details, zoom in and use a hard brush to make a couple of small 
strokes and then, on a new layer, add a series of lines. If they look 
too hard, you can blur them a bit. Add vertical lines until satisfi ed 
then apply some smoky mist underneath the cascade.

Splash out Before 
making a waterfall, 

look up some references 
to get an idea of the basic 
structure. As you will see, 
there isn’t too much detail in a 
waterfall – it’s basically a white 
cloud. Take a soft brush at 
around 150px, brush a thick 
line in white and then apply 
Soft Light blending at 25% 
Opacity. This is the start of the 
waterfall and shows how it’s 
fl oating. We now add a couple 
of fi ner lines either side of the 
waterfall to serve as edges.

Additional highlights We come again to a point 
when we’re adding more highlights – you can never get 

enough of them! The more you have, the more detail there will 
be in your scene and the better it will ultimately look. We’re also 
adding a bit of green here and there with a hard brush. By doing 
this we are giving it a more digitally painted feeling, but don’t 
forget to make sure that everything blends well together, with no 
one area stealing the show.

The final touches
Wrap up your fantasy world

Rainbow effect 
Waterfalls can often 

be seen with a rainbow near 
them due to light refracting 
through the moving water. 
Create a subtle rainbow with 
your hard brush, as per the 
screenshot, lowering the 
Opacity to 80%. Change the 
layer to the Soft Light mode 
and apply a Gaussian blur so 
that the rainbow doesn’t draw 
too much attention. With the 
soft brush set to the Soft Light 
mode, add a little more mist 
coming off the waterfall.

12

11

13

14

15
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Mountain shadow Because it’s a fl oating mountain, we need to 
add its shadow to the area it’s suspended over. We decided to put some 

shadow on the rocky column closest to it and on the ground using the soft brush 
set to black at a lowered opacity. Make sure you never do just one shadow – for 
realism, apply several layers of shadow that become darker the closer they get 
to the object. Don’t mess too much with the blending options when it comes to 
shadows, either, as they need to be almost completely black.

More mist As one of the fi nal steps, we are going to add yet more mist 
around the fl oating mountain and make the vegetation around the edges 

a little greener. The mist will help the mountain merge seamlessly with everything 
else in the scene and it also enhances the surreal and mysterious mood we want 
the image to have. Never make your mist too white, though. Instead use a colour 
in the same shade as the background, so in this case give it a green tint. Switch 
the mist layer to the Soft Light blending mode and set the Opacity to 30%.

Final touches 
Now you can play 

with Brightness/Contrast, 
Levels and Curves 
adjustment layers. To 
get focus in this artwork 
you can also create a 
black-to-white radial 
gradient on a new layer 
set to Soft Light and 30% 
Opacity. The white circle 
goes wherever you want to 
draw focus. Create a new 
layer, fi ll it with black and 
go to Filter>Noise>Add 
Noise (12.5% and 
Monochromatic). Set this 
layer to Soft Light and just 
5% Opacity. Last but 
not least, wrap up the 
image with a Smart 
Sharpen fi lter.

Quick 
Tip

Quick 
Tip

When you digitally paint, you 
can use the Rotate View tool 
to navigate your whole 
screen. This way you can 
paint more detailed elements 
without having to turn your 
head. It makes everything 
much more comfortable.

For this tutorial we didn’t just 
use Photoshop’s standard 
hard and soft brushes, but 
we also used a brush set 
from one of our favourite 
artists, Dan LuVisi, who is 
also known as adonihs. You 
can download the set for 
free from his deviantART 
gallery at tinyurl.com/
adonihs. Do read the usage 
instructions before you use 
them though. LuVisi is a 
great artist and this is a 
fantastic resource, so they’re 
worth downloading when 
working on a matte-painting 
project like this.
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152 Build fantasy architecture
158  Concept art for a heroine 

character
164 Create dramatic lighting effects
170  Sci-fi  concept art
176 Build videogame concept art
182 Build matte paintings
188 Design robot mechs

Compose magical scenes

Concept

The viewer 
should be 
convinced that 
the world could 
actually exist

176
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Source files
available

Tutorial fi les on the disc

In the fi eld of entertainment design and 
illustration, you are almost always faced with 
the prospect of creating virtual worlds that 

include some kind of architecture, or even whole 
infrastructures. Whether it is science fi ction art or a classic 
medieval fantasy image, from the very fi rst second the 
person looking at this kind of illustration should be 
convinced that the world he or she is observing could 
actually exist. Even if there is magic going on or you can see 
fl oating buildings in the air, if the artwork contains a 
consistent visual style then every kind of architecture in every 
kind of environment will work.

That is why it is so important to be inspired by actual 
civilisations, both ancient and modern. Fantasy architecture, 
for example, is often inspired by gothic elements like castles 
and cathedrals. You can create a new fantasy scenario by 
combining more than one civilisation and their architectural 

styles. As long as the elements hang together in a way that 
is physically possible (even if the physics are based on 
magic), the viewer has to believe that what he or she sees is 
real – even if it is not. Natural patterns, random abstract 
shapes or objects you might never have thought of using as 
building blocks before can also inspire a scene, but 
nonetheless physical functionality is the most important 
aspect of making fantasy scenes seem possible. 

In this illustration, we take inspiration from exotic ancient 
architecture. Old, lost civilisations like the Mayans and 
Aztecs can be truly inspiring when it comes to creating your 
own fantasy architecture. Explorers are still fi nding 
undiscovered ruins to this day, and the fact that we know 
little to nothing about their use makes the Mesoamerican 
motifs that they use a visual shorthand for mystery and 
magic, while allowing us to integrate fantasy elements into 
something that’s conceivably from the real world.

Blood Temple  2012 Photoshop, Painter

Alexander Thümler Digital artist

Alexander teaches you how real-world references can inspire 
your fantasy buildings and scenes

Build fantasy 
architecture
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Alexander Thümler

Personal portfolio site
www.minzketchbook.com
Country Germany
Software used Photoshop, 
Painter
Alexander is a concept artist 
and illustrator, studying 
design in Nuremberg. He 
does live paintings with an 
audience or on the internet 
via Livestream.
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It’s important to bring out focal points 
as soon as possible, as they lead the viewer 
through the whole image

Basic sketch Start to paint some very simple shapes and silhouettes with a big 
rough brush to fi nd a composition that works for you. It’s not necessary to care a lot 

about the architecture or even the perspective – just try to fi nd a way to place all the elements 
you want to show. 

Shapes Once the basic sketch is done, start thinking 
about the general perspective and architectural 

elements you want to use in the painting. Pick a thinner brush to 
defi ne the shapes with a bit more detail and bring a little more 
design into the abstract structure. 

Explore ancient ruins
Develop your idea from sketch to fi nished piece

01

02

During the process of creating your digital 
painting, it often happens that you get too 
used to your image and overlook mistakes 
in the composition. It’s important to fl ip the 
canvas horizontally and vertically as often 
as possible during the whole working 
process to get a renewed perspective of 
the painting.

Mirroring

Value It’s important to bring out focal points 
as soon as possible, as they lead the viewer 

through the whole image. Use a large soft brush on 
a layer set to Overlay to defi ne dark and light areas 
and work out the basic values of the painting. This will 
give the painting a visual guideline.

03

Mirror Start sketching in more details of the architecture and the plants growing around the structure 
to work out the scene. Flip the canvas horizontally and vertically in order to check out the composition 

and the general tilt of the image from time to time. 

04
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Finished thumbnail  Don’t spend too much time rendering the 
thumbnail, as this is just one of many thumbnails that you can draw 

before starting the fi nal illustration. Bring in some last-minute details to refi ne the 
composition and highlight focal elements by using fast and loose strokes.

Line art  Now that the architecture and perspective are roughed 
out, you can draw a simple perspective grid with one, two or even three 

vanishing points and begin to draw the architectural line art on a separate layer. 
Constructing three-dimensional objects is not easy, so take your time.

Fantasy Art Genius Guide  155
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06

To maintain balanced values, it’s important to hide the colour of an 
image from time to time and see it completely desaturated. The 
perception of tones is often infl uenced by colour overstimulation and 
the colour contrast.

Saturation

Colour In this step you have to think about the atmosphere and general 
lighting of the scene to fi gure out how these things affect the material the 

temple is made of. Once you’re happy with your idea, start painting in the basic 
colours of the temple and the shadows underneath the line art. 

07

Light direction Now, drop the line art onto the canvas and start to 
paint over it. Always keep the angle of the light in your mind to prevent 

mistakes from occurring. Create some rough brushstrokes as a raw base for the 
foliage of the trees and bushes growing around the temple. A low-lit, evening 
angle for the lighting adds mystery and menace. 

08
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Develop 
depth 

Continue rendering 
the architecture as 
subtly as possible 
and bring depth into 
the image by painting 
faded trees or other 
parts of the temple 
into the background. 
Make use of the lighting 
angle and atmospheric 
perspective in order 
to enhance the eerie 
atmosphere of the 
overall scene.

09

Make use of 
lighting angle and 
perspective to 
enhance the eerie 
atmosphere...You 
want the viewer to 
wonder what has 
happened here

It’s often easier to improve the composition 
of a painting by looking at the image in a 
very small format. Because there is a loss of 
information due to the scaling on the screen 
and the fi xed number of pixels, it’s 
advisable to view the image on the whole 
screen and step back from it. In this way, 
even the smallest details contribute to the 
overall image.

Step back

Destroy the temple Once you’ve rendered the 
surfaces, you can start destroying the architecture. 

Paint some debris, broken walls and statues. Add some 
colour variety to the boulders to make them look old and 
ruined. Remember, you’re aiming for the look of somewhere 
that has been lost for thousands of years.

10

Refi ne the details Use a thin brush to draw 
reliefs, gaps and cracks on the walls to make the 

whole building look ancient and ruined, and add some more 
leaves and roots to show that this is an abandoned place. 
You will want the viewer to wonder what happened to the 
original inhabitants and feel vaguely unsettled. 

11

Build up the story To help the viewer get into the scene, add some story elements. Here, 
explorers are shown making their way into the dark doorway at the heart of the image. We put them in 

with the image fl ipped to check that they read correctly. 

12
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Accents Bring more life into the scene by adding additional trees, grass, bushes, 
fl owers and ferns. Accentuate some elements of the ruined temple by adding a little bit 

more saturation if they merge too much with the whole structure.

Last-minute values  To fi nish the painting, use a Color Balance adjustment layer to make all the 
colours mesh with each other perfectly. Finally, use a layer set to Overlay to highlight the focal points once 

again, bringing out the contrast on the stairway, door, fi gures and temple artwork. 

Hint at a terrible secret  Another detail often seen 
in ancient ruins and temples is art itself. Temples often have 

a lot of murals, reliefs and statues to show rituals and other events 
that happened in the past, or prophecies that will infl uence the 
future. Draw in some relief details on the walls – these details feature 
giant, magical fi gures demanding worship and sacrifi ce from 
smaller, more human-looking ones. 

13

15

14

Use a layer set 
to Overlay to 
highlight the focal 
points, bringing 
out the contrast on 
the stairway, 
fi gures etc
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Use coloured layers to 
build up vibrant art 

Working

Step 04: Design theme

Step 11: Light in greyscale

Progress

Step 14: Render the 
character
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If you want to succeed in creating a good 
design for a female videogame heroine that 
appeals to all, there are some important 

aspects to keep in mind. First, she should look strong and 
capable of dealing with any obstacle. Second, she should 
be beautiful and sexy, though you should avoid trying to 
achieve sex appeal through too much naked skin. Strength 
and capability paired with a beautiful, stern face don’t need 
a chain mail bikini to create a sexy and believable design. Of 
course, she’s still a heroine, so may well possess a 
superhuman physique or otherworldly beauty.

More important than her physical appearance is that your 
character has a unique look that makes her memorable and 
outstanding. That look should primarily be achieved through 
a distinct and interesting silhouette and via engaging design 
of her clothes and weapons. The audience must be 
convinced at fi rst sight that they want to play as that 
character to draw them into the game.

To create such visual appeal you have to know what the 
character is about, her role in the story and her skills and 
function in the game. Another important aspect is that your 
design isn’t too diffi cult to translate into a 3D model in order 
to be animated. Thus it shouldn’t incorporate too many 
protruding and detached accessories like fl owing ribbons, 
feathers or long cloaks. The latter are particularly 
unfavourable for fi gures mostly seen from the back during 
the game, as they obscure any shape that might make the 
character unique.

Key features for the heroine in this piece are as follows; 
she will be a professional thief or mercenary, hunting 
treasure and rare artefacts in the catacombs beneath the 
surface of a steampunk-inspired world. She’s tough, agile, 
ruthless, a little bit fl amboyant and of course a radiant 
beauty. She uses a master-crafted multi-barrelled handgun, 
which needs to be loaded with power cells. With those key 
features set, we can start designing.

Look at 
references 

Before you start to actually 
design something, be 
it in a realistic or fantasy 
setting, you should 
look at photo and style 
references to gain 
inspiration, knowledge 
and understanding of the 
subject matter. For the 
steampunk setting used 
in this piece, elements like 
antique pistols, Victorian-
era clothing and jewellery 
are relevant accessories 
to the genre.

Preliminary 
sketch Begin 

with a digital sketch made 
in Photoshop, because 
this way you retain the 
possibility of making quick 
changes and don’t have to 
cope with a lot of erasing 
and smudging in a messy 
pencil sketch. You can 
also fl ip the canvas at any 
time to check that you 
have the proportions right 
which is invaluable. This 
step is very important as it 
sets your road map for the 
entire image.

Playing with Firepower  Photoshop

Simon Eckert Illustrator

Find a suitable design and create a rendered painting for a 
strong and beautiful videogame heroine

Design the heroine
Start Photoshop and sharpen your pencils

01

Concept art for a 
heroine character 

02

Source files
available

Discover the line art for 
this heroine and render 
your own

Digital artists explain the 
techniques behind their 
amazing artwork
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Simon Eckert

Personal portfolio site
www.holysquid.de
Country Germany
Software used Photoshop
I’m a freelance illustrator 
and concept artist with a 
background in graphic 
design. I live and work in 
Berlin. My expertise ranges 
from creating illustrations for 
board games and 
role-playing games to 
graphics for browser games 
and character concept art 
for MMOs.

http://www.holysquid.de
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Create a 
silhouette  Our 

videogame heroine needs 
a good and recognisable 
silhouette that makes her 
unmistakable. You have to 
consider the shape from all 
angles but especially from 
the back, as the character is 
most likely to be seen from 
that perspective while people 
are playing the game. Forms 
that are too extreme might be 
diffi cult to animate.

Design theme To give the character a consistent look, you should 
try to fi nd a theme that’s used throughout every part of the design. An 

overly eclectic look will, in most cases, result in an image that is weaker and less 
memorable. This piece encompasses a wing theme because it’s suitable for 
making variations for different shapes of the costume and fi ts her character.

0403

The inspiration for the 
accessory on her head 
came from a Victorian 
hairpin. You should 
never underestimate 
the power of using 
references.

Using a 
reference

Colourise your sketch  When you’ve completed your sketch, 
create a new layer above it in the layer stack, fi ll it with 100% cyan and set 

the blending mode to Screen. Now create a new layer under your sketch layer, 
fi ll it with white and reduce the opacity of the sketch until it’s very light and barely 
visible. Print your sketch on the drawing paper of your choice. You should now 
have a light-blue sketch that is ready to be refi ned by hand.

05

Draw the 
line art  

Though  the digital 
medium is great for its 
versatility and is ideal 
for most colour work, it 
is a good idea to make 
a traditional pencil 
drawing before starting 
to paint. By using this 
digital-traditional-digital 
workfl ow you are more 
likely to achieve an 
individual and dynamic-
looking piece. Having 
the sketch printed in 
blue will give you a solid 
basis for a clean pencil 
drawing of the details.

06

Final design Now you have to 
create the real design including all of 

the intricate elements. Refi ne the ideas you 
put down in your preliminary sketch, look at 
references again if you’re unsure about how to 
draw anything and bear in mind that someone 
will have to model your design in 3D later.

07

Scan your 
drawing 

The fi nal drawing 
should be scanned 
at 300dpi (at least) 
to retain as much 
information as 
possible. At this 
stage, fl ip the 
scanned image
and correct any fl aws 
in anatomy 
or proportion.

08
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Transparent line art  Go to the 
Channels window in Photoshop and check in 

which of the three (RGB) the image looks cleanest. 
Select that one and remove any remnants of the blue 
print using Image>Adjustments>Levels. Now copy 
that channel into the other two. Create a selection 
by clicking on the RGB channel while holding Cmd/
Ctrl. Invert that selection (using the shortcut Cmd/
Ctrl+Shift+I) and fi ll it with black on a new layer.

Shapes and selections 
Create a new layer under the line 

art layer and use the Lasso tool to select 
the shape of your character. Save the 
selection (Select>Save Selection) and 
fi ll it with grey. In this manner, you can go 
on selecting and saving the shapes you 
think could be useful later, for example the 
main colours of the clothes, to create a 
complete (if basic) value study. 

09
10

These classic games heroines 
demonstrate the visual power 
of a female protagonist 

Some classic 
CG heroines 

Style
School

Art genres in 
a nutshell

Name: Princess Zelda
Game: The Legend of 
Zelda series
Date: 1986 – present
Games Company: 
Nintendo

Named after novelist F 
Scott Fitzgerald’s wife, 
Princess Zelda has 
appeared in different 
incarnations across the 
LOZ series. The classic 
blonde, blue-eyed elven 
beauty started out as a 
princess who needed 
rescuing and has 
developed into the brains 
behind the throne of her 
kingdom, with sideline 
careers as a ninja, pirate 
and even, on occasion, as a goddess. 

Name: Samus Aran
Game:  Metroid series
Date: 1986 – present
Games Company: 
Nintendo

Nintendo’s action 
adventure had a great 
reveal at the end of the 
fi rst game in the series, 
when the exoskeleton-
clad protagonist doffed 
their robotic suit and was 
revealed to be female. 
Statuesque Samus 
Aran is arguably the fi rst 
female videogame 
protagonist. Infused with 
alien DNA and packing a 
suit that would make Iron 
Man jealous, her look is 
based on Kim Basinger.

Name: Lara Croft 
Game:  Tomb Raider series
Date: 1996 – present 
Games Company: Eidos, 
Square Enix

The curvaceous brunette Lara 
Croft was created like a female 
Indiana Jones. With her luscious 
looks, she was based on a 
combination of pop singer 
Neneh Cherry and comic-book 
character Tank Girl, designed to 
counter stereotypically delicate 
female characters. The actress, 
Angelina Jolie also played her 
twice on the big screen.

Male protagonists are common in videogames, but 
some of the most well-known and loved gaming 
characters are female. Whether they’re the main player 
character or the driving force behind the story, these 
three characters demonstrate how an iconic design 
combined with individual beauty and a sense of 
personality combine to create memorable and much-
loved characters. 

Light in greyscale Depict a lighting situation, but 
be careful not to make it too dark, as all the detail should 

be readable for later modelling. You can also defi ne the light and 
dark areas of the costume to create a unique pattern. In the case 
of this piece, this image of the character has a bit of background, 
so add backlighting to create a three-dimensional atmosphere.

11

Colour scheme One of the 
most powerful tools to make your 

character stand out is to establish and 
work within a strong colour theme. Try 
to create a working scheme using only 
one or two bright key colours and leave 
the rest unsaturated. Using too many 
bright hues will quickly result in a chaotic, 
random and cartoony look.

12 Blend the hues Colourise your 
image by using blending modes. Start 

using layers set on Soft Light to defi ne the basic 
colours and move on to Hard Light to bring out 
key colours. You can experiment with blending 
modes but try to avoid an overall look that is too 
saturated. Merge everything down before you 
start rendering.

13

Quick 
Tip

Use the Elliptical Marquee 
tool to create geometric 
things like the gun barrels. 
Such objects need to look 
correct in regards to 
perspective or they will not be 
convincing.
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Render the character Now with 
all the information set, you can start 

rendering the image. This is the most time-
consuming part, but a fully rendered artwork 
will make it easier for the modellers to translate 
your ideas into 3D and is also much more 
convincing to look at. A poor design with a 
boring shape and confusing colours won’t get 
better no matter how well it is rendered.

14 Brush techniques Create a new layer 
over your basic colours. Use the round 

hard-edged Airbrush tip (with Opacity set to 100%) 
to render most parts, and the soft-edged Airbrush 
set on low opacity to smooth down areas where 
a softer look is wanted. Try to keep your strokes 
as dynamic as possible in your line art and pick 
colours from your image, especially the halftones 
created by the line art over the colour sketch.

15 Painting surfaces Differentiate between soft 
and refl ective surfaces by painting harder highlights 

and more contrast into metallic or shiny parts and softer 
rendering for skin or leather. Avoid using pure white or black 
– you can always emphasise shadows or highlights later on. 
When I use custom brushes or textures, they only provide the 
basis for further painting, as they tend to make the artwork 
look too digital. Merge everything down again.

16

Select with paths With the main rendering done, we can make a 
fi nal selection to separate the character from the background and defi ne 

the fi nal shape. This wasn’t done earlier to retain the ability to alter the silhouette 
until the design is fi nalised. Use the Pen tool set to Paths to get a smooth look.

17

Clean the 
outlines 

Make a selection from 
the path, invert it, 
duplicate the image 
and delete everything 
around the character. 
Invert the selection 
again and fi x any small 
fl aws that you notice on 
the silhouette. You now 
should have a smoothly 
rendered character 
with transparent 
background on one 
layer and a background 
layer below.

18

Paint the 
background 

Character concept artists 
often don’t particularly 
like painting backdrops, 
but a little bit of scenery 
can really convey some 
of the background 
story and produce a 
much more fi nished 
and elaborate piece, as 
you can see here. Use 
the Gaussian Blur fi lter 
over your background 
to add a sense of depth 
to the image and to 
also achieve a more 
realistic in-game look.

19

Finishing touches The last step is to 
tweak the colour and contrast in your piece. Use 

a Soft Light layer with a warm colour (at a low opacity) 
to bring out the heroine against the background, which 
you can also make darker with Levels.

20

I used the wing design 
on the armlet as a 
means to break up the 
human silhouette and 
make it more jagged 
and dangerous 
looking. Though they 
are a decorative 
element, they still don’t 
look like they’d 
encumber the wearer.

Break the 
silhouette
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Key techniques

02

01

03

04

05

Designing details I stuck to the 
wing theme throughout the design; you 

can fi nd it on her clothes and even on the 
pistol holster. Putting thought and effort 
into such intricate details is something very 
enjoyable and ultimately leads to a more 
convincing result.

Asymmetry I chose to make her 
hairstyle asymmetric to make her 

costume more visually dynamic and to 
give her a more individual look. Asymmetry 
can be a very useful way of creating a 
distinct silhouette.

Firepower The steampunk setting 
just screams for a special and unique 

weapon. Something futuristic and powerful, 
yet keeping the antique look. When 
creating the design I drew inspiration from 
real antique pistols and Gatling guns, 
and combined them with a fantastical yet 
functional-looking aspect: the glowing 
power cells.

Dramatic tension Not amused 
at being disturbed during a successful 

raid, the heroine is reaching for her gun. 
I chose to go for a dark background with 
the eerie greenish light emanating from 
the power cell to emphasise the tense 
atmosphere.

Drop bad ideas The initial 
design incorporated a lamp hanging 

somewhere in the background to provide 
a source for the backlighting, but when 
rendering the background it was clear that 
this didn’t work. The lamp simply distracted 
too much from the character and had to be 
removed from the scene.
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It’s wise to make 
sure you have 
everything defi ned 
clearly before moving 
on. A little spontaneity 
will prove handy, but 
not as handy as a solid 
base

Digital artists explain the 
techniques behind their 
amazing artwork
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Marco Nelor

Personal portfolio site
marconelor.tumblr.com
Country US
Software used Photoshop
Currently living in Chicago, 
concept artist Marco Nelor 
spends his time listening to 
music, drawing and 
painting. 
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Fantasy paintings are ever so popular, with 
many digital artists plying a profi table trade 
from a range of different styles. With the right skill 

set and techniques, you too can create concepts for multiple 
parties within the entertainment industry. This tutorial aims to 
give you a head start.

You’ll begin with the sketch phase, drawing out some 
rough ideas in Photoshop, then you’ll discover essential 
ways to add colour, detail and cohesive lighting to your 
images. Special effects will breathe further life into these 
designs, mainly through the use of dramatic lighting effects 
that enhance atmosphere. 

Of course, this is all made possible using Photoshop tools 
and options. Custom brushes have been supplied on the 
disc so that you can make the marks seen in this tutorial. 
You’ll also discover ways to layer these new brushes, using 
the power of Photoshop’s blending modes to produce 
exciting lighting effects. 

Brushes are used to paint texture and detail, with Lock 
Layer and clipping mask controls letting you shape your 
fi nal design exactly as you want it. Ways to introduce tonality 
and colour temperature, again enhancing atmosphere, are 
also taught. By the end of it all, you’ll be able to tackle your 
very own distinctive fantasy paintings.

Start your sketch Begin sketching 
the fi gure very loosely inside Photoshop 

on a new layer. This is so that you can visualise the 
proportions and composition you need. A three-
quarter view of an owl moving towards the viewer 
has been chosen here. This example is the best 
design from a set of thumbnails, as it made sure all 
of the needs of the piece were met early on.

Vibrant Flight  Photoshop

Marco Nelor Concept arist

Learn essential brush techniques to create dramatic 
lighting and vibrant colour

Getting started
sketch within photoshop

Create dramatic 
lighting effects

01

Source files
available

On the CD, you will fi nd 
all the brushes needed to 
replicate the effects learnt 
in this tutorial. Simply 
upload the advanced 
photoshop.abr fi le by 
double-clicking it

Use coloured layers to 
build up vibrant art 

Working

Progress 1: Rough sketch

Progress 2: Add 
background

Progress

Progress 3: Create lighting

A clear course of action Begin tightening up your 
line work and organise the shadows and lights. Eliminate 

scribbled brush strokes, as a good, solid direction early on will 
dictate the diffi culty of a piece. It’s also wise to make sure you have 
everything defi ned clearly before moving on. A little spontaneity will 
prove handy, but not as handy as a solid base.

02
Separate the sketch You’ll want to make 
sure that your bird is on a separate layer without 

any loose or extra strokes. Check for such artefacts by 
creating a layer beneath the sketch layer and fi ll it with a 
pink colour. This reveals any stray white and grey brush 
strokes in and around the sketch. If there are any in your 
image, you will need to erase these.

03
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Form shadow Getting comfortable 
with the Selection tool? Good, as you’re 

about to practise that same technique here by 
carefully selecting the legs of your owl. Now press 
Cmd/Ctrl+Opt/Alt+I to invert your selection. This 
effectively lets you paint behind the selected area. 
Use another soft brush in order to paint in some 
shadow behind the legs. Again, take care not to paint 
your marks too dark.

Create atmosphere It was decided 
that the head would read better if it were in 

front of the far wing, so you need to add a little bit of 
atmosphere. Using the Marquee tool once again, 
select an area outlining the owl’s face and a portion 
of the wing behind it. Select a rounded brush with soft 
edges and begin stroking in the lighting from the top 
down, as your light will likely be a top-down lighting. 

Copy and paste A useful trick when 
creating similar features like the talons is 

to use a copy and paste. Since the shapes will be 
painted over later, you won’t run the risk of each 
talon looking too similar. Select a talon with the 
Marquee tool (L), then press and hold the Cmd/
Ctrl key as you drag the selected area to another 
location. Doing this creates a duplicate of the 
selected item. 

 Add texture Early on in a painting, it’s good to add a little texture to certain areas. Later, these earlier 
signs of texture may show through and help to pick out subtle shapes, giving the painting a bit more life. 

Upload the advanced photoshop.abr and select the brush labelled ‘20’. Paint texture near the light areas of the 
talon. Be careful to not to paint too brightly this early on, however, as increasing the contrast too soon will make 
areas seem overly bright or blown out later. 
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Quick 
Tip

The secret to applying textured brushes 
successfully is to build up gradual details using 
consistent strokes. Keep your textures and 
textured brushes from getting too messy, as 
they may begin to lay down too much texture 
and overpower the entire effect.

 Paint feathers It’s time to start painting 
feathers. To do this, select the brush labelled 

‘700’, which closely resembles the hackle you can 
fi nd in owls and other birds. Take care to not add 
strokes too wildly. Instead, apply in a uniform manner, 
tracing the existing contour in your owl’s form. This 
means you’ll create a more authentic appearance. 
Studying a real-world reference to get the right look 
isn’t cheating. 

08
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Add blacks Up until this point, the image 
will be rather grey. But this is fi ne, as it has 

allowed you to make sure that the focal point is yet 
to be decided. Usually, you’ll want your focal point to 
be your subject’s face. So it’s here that you’ll apply 
your fi rst solid black to create the owl’s eyes. Use a 
Selection tool to draw out a good shape for these, 
then fi ll your selection with a solid black. This makes 
the eyes the darkest point of your piece and therefore 
your point of focus.

 Paint long feathers Now that you’re 
done with the smaller feathers, you need to 

paint a larger one. First, create a new layer (Cmd/
Ctrl+Opt/Alt+N), then use the Marquee tool (L) 
to create a long, feather-like rectangular shape. 
Use a soft round brush to paint one side dark and 
another side a bright grey, manually creating a 
gradual gradient. This gives the illusion of a single 
feather, which is longer and thicker than the rest 
you’ve just added.
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09

13

Detailed blueprint
Lay the foundation for focal points, texture and form

Begin detailing the 
eyes, which is done 
using a soft grey brush 
on the outer area and a 
sharper white brush 
for the refl ective 
highlights

Hide selections You’ll have made 
quite a few of these by now and they can be 

distracting. With an area of your painting selected, 
in this case the eyes from the previous step, press 
Cmd/Ctrl+H to hide your selection. Sometimes 
doing so will help you see what you’re doing more 
clearly. With your selections hidden, you can begin 
detailing the eyes, which is done using a soft grey 
brush on the outer area and a sharper white brush for 
the refl ective highlights.

10 Build feather textures Continue 
painting your bird and refi ning your form and 

shapes. Uniformly paint the wings, slowly building 
colour until you create solid-looking results. Try 
to stay within the appropriate tonal range. Do this 
on a new layer (Cmd/Ctrl+Opt/Alt+Shift+N). The 
smoother you keep your forms now, the cleaner your 
painting will be later. It’s not until the very end, when 
bringing all your painting marks together, that you 
start to fashion feathers with your strokes.

11

Render feathers It’s a good idea to layer your painted feathers. Start with smaller feathers near 
the top of the wing and paint three rows. Begin with the bottom row, painting in loose feathers. Add 

a layer on top and paint values that create the shadow from the feathers that will be above that. Then paint 
those feathers in on a new layer above your shadow layer. Working backwards in this way makes the feathers 
appear to be casting shadows.

12
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Copy and paste feathers Using 
what you’ve learnt about the Marquee tool 

and the duplicate technique, you now implement a 
combination of the two. Remember the long gradient 
feather you just painted in the last step? Well, now 
you’re going to copy and paste this into a new layer 
and slightly enlarge it. Place it so it overlaps the 
original large feather layer. Continue to copy, paste 
and place a few dozen times until you have a long 
row of feathers.

14

Quick 
Tip

When painting to a Color Dodge blending mode 
layer, using a grey colour will create a very natural 
and even glow. Painting with a saturated colour 
gives a glow similar to that colour.

Render your look
Create dramatic lighting, contour and detail in your image

You’ll see that spark effects were added to 
the fi nal image. You can recreate this effect 
by using several layers and a very easy 
technique. Create a new layer, set its 
blending mode to Color Dodge and scatter 
in some simple sparks with an orange-
coloured brush. Now duplicate this layer. 
Duplicating a Color Dodge layer into itself 
will make the sparks glow even brighter 
than before. Now you must copy, paste and 
place your sparks around the image by 
selecting the Move tool, holding Opt/Alt and 
dragging them to other locations. Create 
depth of fi eld effects, making some seem 
close up, others further away.

Mastering 
sparks

Break up repetition Build upon the 
last steps by repeating their processes, 

painting and placing feathers in the owl’s opposite 
wing. Make sure you follow the right direction for an 
authentic look. To break up the monotony of some 
of these feathers, erase parts of the edges in some 
of your layers. Also elongate some of them slightly 
and skew the shape of others a bit. This allows you 
to create the beginnings of a very interesting wing 
pattern for your owl.

15 Uniform lighting Now that you’ve 
created your feathers, you will need to add 

larger shadows. First, merge down your owl layers, 
then make sure that this new layer is locked by 
clicking on the Lock icon located at the top of the 
layers tab. Now, apply a large, dark grey, soft round 
brush and lightly add some shadow to the rounded 
parts of the top of the wing. This makes sure your 
wings are being lit by the same light source as the 
rest of the image.

16

Start the background Since your 
owl is on its own layer, you can create a layer 

beneath and begin the background. This image 
will eventually reveal a bright scene with sparks 
and cinder fl ying from a fi re. However, to make 
these effects workable, you need a dark, muted 
background full of dark purples, dark browns and 
dark reds. While it seems dark now, adding your 
effects later will help keep the focus on your owl, 
rather than spreading the focus around haphazardly. 

17

Secondary light Since the plan is to 
have your main light source closer to the 

viewer, a secondary light source can be established 
– in this case, the moon behind the owl. On a 
separate layer, draw a circular selection with the 
Elliptical Marquee tool. Set this layer’s blending 
mode to Color Dodge and paint in the moon with a 
few large strokes, using a neutral grey colour. This 
gives the moon its glow effect. Also use the same 
brush around the moon to give it a halo effect. 

18
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Clip layers Back with your owl and it’s 
time to add a little colour. At this stage, it’s best 

to keep everything simple – and in this case dark. 
Create another layer above the owl layer and link 
the two by hovering your mouse between the layers 
while holding Cmd/Ctrl. Click and it links the layers. 
This will ensure that anything painted on this layer will 
only affect the layer below it, which will be your owl 
layer and not the background.

19

Quick 
Tip

Now that your major elements are completed, go 
over everything you’ve done and detail your brush 
strokes and lighting. Keep taking a step back to 
check your progress. This will ultimately help push 
the piece to fi nal completion.

 Refl ective lighting Using the same 
method outlined in the last step, create 

another layer, except this time set its blending mode 
to Color Dodge. Link the layer again. Even though 
it appears to be linked to the last layer, they’re both 
actually linked to the owl layer. Use this layer to add 
both blue rims of light in the edges of the wings and 
yellow lighting that emulates refl ection from the fi re. 
You can also erase lighting and reapply until you’re 
satisfi ed with the effects.

20 Bring it back Since the layer below this 
new light layer is a dark brown colour, it’s 

possible to bring back shadows – just erase areas 
from the Color Dodge light layer above. Create 
dramatic shadows in the feathers by using the 
Marquee tool to make selections like in the example 
shown, then delete from these. This method is much 
better than painting with more black because the 
darkest colour has been established at this point.

21

Back and forth At this point in your 
painting, it’s important that you start to fl esh 

out your colouring and continue to tweak your image 
lighting. You could also add more subtle hints of 
colour, perhaps some purple or pink hues. Always 
remember that if you want to add more lighting, then 
you do this specifi cally to your Color Dodge blending 
mode layer. You can take this away by simply erasing 
it to show the layer beneath. 

22  Add armour Now that the hard part is 
over, you can begin to make some armour 

that fi ts with your image lighting. Use a solid colour 
that outlines the entire shape of the armour on a new 
layer, then lock it. This allows you to paint evenly over 
the entire shape, rather than painting each piece 
individually. Doing the latter has a higher chance of 
throwing off the balance of the armour. Do the same 
for the armour’s trimming.

23

 Final details In the same way as you’ve 
done in previous steps, create another layer 

and lock it to the armour layer. Set the new layer’s 
blending mode to Color Dodge and choose a 
saturated orange colour. Paint this on the side of the 
armour that you feel should receive the most light, 
with the brightest parts nearest the crease. This gives 
you a balanced exposure, and good shadow and 
light separation. Repeat the same process for the 
trimming. Use the Hair brush (brush 125) to zoom in 
and add more detail to the face, working your way 
outward from the focal point and detailing as you go.

24
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Artists, in every artistic fi eld you can think of, 
have different approaches to realising ideas. 
When it comes to concept art, you have to work 

quickly to create something that mirrors the initial idea and 
creates mood and atmosphere. It’s not so much about 
creating a pixel-perfect painting. One approach would be to 
start with rough brush strokes that become more and more 
detailed over time. A different approach is to use a plate 
picture, which can be from a photo or a 3D render. In this 
case, it’s a plain 3D render. 

    The advantage to using this is that there is a lot of 
information on it. Things like highlights, shadows, colours 
and atmosphere can easily be sampled off the plate image, 
which can help you to fi nd a starting point. In this tutorial, 
there is a 3D plate that serves as a base. You will then use 
painting techniques to add more depth. You will also use 
photos, with the help of blending modes and textures, to 
suggest more detail. Last but not least, take a look at how 
fi lters can give it a stylised look. Now, it’s time to see how to 
bring some life into a dull scene!

Another World  Photoshop

Christian Hecker Concept artist Illustrator

Discover how to use a dull 3D render plate to 
create a striking sci-fi  scene

Sci-fi concept art
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techniques behind their 
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Christian Hecker

Personal portfolio site
www.tigaer-design.com
Country Germany
Software used Photoshop
For the past few years, I 
have focused on creating 
environmental concept art 
and illustrations using digital 
matte painting techniques. I 
learnt everything in an auto 
didactic way, and I now 
build my own techniques to 
create fantastic landscapes 
for practically everything, 
from book covers to games 
and movies.

Source files
available

All textures used and the 
complete PSD can be 
found on the disc. The 
PSD contains extended 
layers, showing how the 
different elements can 
be used
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The plate First, go onto the disc and gather up all of the 
resources. Load the ‘plate.psd’ fi le into Photoshop. Immediately 

take a look at all the space available to you for extensions, specifi cally in 
the sky region. That is what you should focus on right at the beginning; 
adding in a sky replacement. 

01

Use coloured layers to 
build up vibrant art 

Working

Progress 1: Room for detail

Progress 2: Create a rough 
painting

Progress

Progress 3: Build a 
dynamic scene

Masks are perfect tools for non-destructive 
work, and allow you to go back at any time to fi x or 
adjust things

Preparing the sky replacement 
Open ‘sky_a.jpg’ and load the image into 

Photoshop. Hold Cmd/Ctrl while dragging the 
picture onto the ‘plate.psd’ tab in the upper-left 
corner of the screen. Hold your mouse there until 
the ‘plate.psd’ appears. Then, move your mouse 
onto the picture and release the mouse. Repeat the 
procedure with ‘sky_b.jpg’. Double-click the layer 
name in the Layers palette to change the names of 
the imported photos to Sky_a and Sky_b and put 
them into a new folder titled ‘Sky’.

02

Channelling the sky Next, open the Channels palette. If not active 
already, it can be found via Windows/Channels. Hold Cmd/Ctrl and click 

the small preview thumbnail of the Sky channel. A selection should appear. Switch 
back to the Layers palette and click the Sky folder. To apply the selection as a 
mask, click the square and circle icon at the bottom of the Layers palette. Notice 
that the mask is inverted. Just click the mask thumbnail next to the folder and 
correct it with Cmd/Ctrl+I.

03 Fixing the mask Near the horizon, you will see a few small holes in 
the mask. First, release the selection. Hit M and click somewhere on the 

picture. With the mask still active, use the Eraser (E), Ctrl/right-click and select a 
small standard round brush to fi x the areas. The colour white closes the hole and 
black opens areas in the mask, and you can easily switch between them using X. 
Masks are perfect tools for non-destructive work and allow you to go back at any 
time to fi x or adjust things.

04

Build the plate image
Replace the sky and add detail
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Quick 
Tip

To add a little bit more detail to your brush strokes, 
open Brush Properties (F5). Check Scattering and 
set it to 133%. Transfer should also be active, with 
the Opacity set to Pen Pressure. This is an easy 
way to suggest more detail when painting simple 
things, especially if using a tablet.

Replacing the sky #1 Click on the 
eye symbol left of the Sky_b layer to toggle it 

invisible and select Sky_a. Since it’s far too big, use 
Cmd/Ctrl+T to transform it. Make the bottom part of 
the image align with the horizon. Go to the upper-left 
point, click, and move it to the upper-left corner of 
the workspace. Do the same for the right side. Use 
squashing and stretching to make the sky fi t the 
perspective and sit nicely in the scene.

05 Replacing the sky #2 Toggle Sky_b 
visible and do the same as before, but move 

the right side more into the picture. Now set Sky_a to 
Vivid Light at 66% Opacity and place the layer above 
Sky_b. This gives a bit of extra texture to the clouds. 
Now, set the Sky folder to 70% Opacity to make it 
blend a little more with the overall scene. To fi x areas 
around the sun and horizon, click on the Sky folder 
mask again.

06 Blend the sky With the mask selected, 
use the Eraser (E), Ctrl/right-click and take a 

soft round white brush at 277px and 0% Hardness. 
Now add some aerial perspective by painting along 
the horizon line as well as softly reducing the impact 
of the overlaid photo textures around the sun. Be sure 
to have Opacity set to Pen Pressure, under Transfer 
in the Brush settings (F5). 

07

Looking for detail  Now it’s time to 
focus on the city. While there is great depth 

and nice silhouettes, it could still do with a little more 
detail. For orientation, open and import ‘specular.
jpg’. Hit Cmd/Ctrl+A, switch to the Move Tool (V) and 
use the buttons in the tool bar to align it horizontally 
and vertically. Rename the new layer ‘Specular’ and 
set the blending mode to Screen or Color Dodge. 
This will give you an overview of the areas (marked 
white) that need a little extra detail. 

08 Painting detail  Painting highlights onto 
the edges of certain structures adds more 

detail and depth, but accuracy is not too important 
right now. First, make the Specular layer invisible, 
hit Cmd/Ctrl+Shift+N to create a new layer and 
name it ‘Painting’. Use a round brush at 6px Size 
and 90% Hardness and start to paint along some of 
the edges of the buildings. Hold Opt/Alt to switch to 
the Color Picker and sample highlight colours right 
off the picture.

09 City background extension  
Create a new layer via Cmd/Ctrl+Shift+N 

and name it ‘Back City’. Now create a hint of city far 
in the distance by sampling (Opt/Alt) a darker colour 
from the foreground. Again, use a hard round brush 
with a size of 22px. Hold Shift while painting short, 
straight vertical lines into the background. These 
don’t have to be accurate, since you only want to 
suggest detail. Last but not least, set the Opacity of 
the Back City layer to 75%.

10
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A plate of light #1  To bring in lights, 
create a separate picture that will serve as 

an additional plate. Cmd/Ctrl+N creates a new 
fi le. Make it 3000px wide and 1650px high. In the 
new picture, fi ll (G) the background black. Press 
Cmd/Ctrl+J and name the new layer ‘Point’. Hit the 
Marquee tool via Shift+M until the round selection 
is active. Hold Shift, draw a circle selection and fi ll 
it black as well. With Filter/Render/Lens Flare, 100 
Brightness and the 105mm Prime, try to locate the 
centre of the fl are and execute the Filter.

11

A plate of light #2  Create a copy (Cmd/Ctrl+J) of the Point layer and name it ‘Spot’. Turn the 
Point layer invisible and move (V) the Spot layer to the right. Run Filter/Noise/Median with a radius of 

24px to avoid artifacts. Hit Shift+M until the square selection tool is active again and create a selection right 
through the centre of the light. Via Cmd/Ctrl+T, stretch the light to the left. Ctrl/right-click to select Perspective, 
click the upper-left corner, drag it down and hit Enter. This results in a light beam-like shape. Save the image as 
‘light_plate.psd’.

12

Make it shine  Now it’s time to bring the 
lights into the city. Press Cmd/Ctrl+A and 

then Cmd/Ctrl+C. Switch back to the city, paste 
(Cmd/Ctrl+V) the beam in there and change the 
layer’s name back to ‘Spot’. Do the same for the Point 
layer. Put them into a folder named ‘Lights’. For now, 
toggle Spot invisible, click the Point layer and set it to 
Linear Dodge. Press Cmd/Ctrl+T, reduce the size by 
holding Shift, fi nd a spot to put it and hit Enter.

13
Adjusting the lights Scatter lights by 
holding Alt Gr. Easily vary the light sizes with 

Cmd/Ctrl+T and the colours with Hue & Saturation 
(Cmd/Ctrl+U). This results in a ton of layers. If it 
becomes too much, just hold Cmd/Ctrl, select all 
the Point layers in the Layers palette and press 
Cmd/Ctrl+E. Set the blending mode back to Linear 
Dodge. The same procedure can now be used for 
the spotlights. Playing with parameters like size, 
colour and opacity help to add variation to the lights.

14 Texturing #1 First, create a new folder 
and name it ‘Textures’. Open ‘IMG_1561.jpg’ 

into your project, put it into the Textures folder, name 
the layer ‘Lights’ and set its blending mode to Lighter 
Colour. With Cmd/Ctrl+T, reduce it to a third of its 
original size and turn it 90 degrees. Now place it on 
the facade of the right building. To remove unwanted 
parts that still are visible, go into Levels (Cmd/Ctrl+L) 
and change the middle value to 0.75.

15
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Texturing #2 Detail is all about variation. 
Load ‘IMG_0903.jpg’ and treat this texture the 

same way as in the previous step. Press Cmd/Ctrl+J 
to create a copy. Name one copy ‘Lights B’ and the 
other copy ‘Facade’. Toggle Facade invisible and 
click the Lights B layer. Press V and move the layer 
to the right building again. Use 28% Opacity and 
the Color Dodge blending mode. Different blending 
modes help to create variation in the lights.

16

Playing with parameters like size, 
colour and opacity help to add variation 
to the lights

Quick 
Tip

If you are working in a newer version of Photoshop, 
you can easily import images by dragging the fi le 
from your desktop into the Photoshop workspace 
of your current open project. It will automatically 
create a new layer. Be sure to uncheck ‘Place or 
Drag Raster Images as Smart Objects’ in the 
Photoshop Preferences.

Make it sit While you are allowed to be a 
little sloppy, you should still keep perspective 

in mind, especially when applying textures to 
buildings. The lines of light in the Lights B layer do 
not exactly match the building. To fi x that, use Cmd/
Ctrl+T again to go into transform mode. Reduce the 
size and make it sit better by adjusting the upper and 
lower-right corner points. Hold Cmd/Ctrl+Shift while 
dragging the points up and down.

17
The other side Now, toggle the Facade 
layer visible again. Select the layer, hold 

Cmd/Ctrl and move it to the tower on the left side. 
Again, transform (Cmd/Ctrl+T) this texture, make 
it smaller and turn it 90 degrees. Set it to blending 
mode Lighter Color and 24% Opacity. Create a copy 
(Cmd/Ctrl+J), transform to squash it a little and 
move it down. Now you have a few textures to copy 
and paste onto other elements. Use the Eraser (E) to 
remove parts you don’t need.

18

Sampling details These textures can 
also serve as plates. For example, to get more 

detail into areas that still look a bit empty, just click 
the Lights B layer and choose the Clone Stamp (S). A 
simple round brush does the job fi ne. Be sure to have 
‘Current Layer’ active. Check and uncheck ‘Aligned’, 
depending on whether you want to sample a light 
over and over again or if you want to paint an area. 
This is an easy way to duplicate windows and lights.

19

Additional touches After adding/extending textures and lights with the techniques explained 
above, it’s time for the additional touches. Hold Cmd/Ctrl, select all layers, press Cmd/Ctrl+J and 

Cmd/Ctrl+E to create a copy and merge them down. In Filter/Filter Gallery/Artistic, select Poster Edges. Use a 
Thickness, Intensity and Posterization of 2. However, art is all about personal preference. If you wish to create 
a more realistic image, as seen on the fi rst pages of this tutorial, don’t apply the fi lter and instead add in detail 
like the lighting bolts.

20
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Photoshop has forever changed the landscape of 
possibilities for artists. The software provides an 
ever-increasing toolset that has a wide range of use. As 

digital painters and illustrators, we use a focused bandwidth of 
tools on a daily basis to create new worlds and ideas. 
Sometimes we’re asked to create a unique piece that has a 
specialised goal and in this tutorial you will see just that, as we 
take you on an unorthodox yet simple path to the fi nal product. 
Here we’ve frozen a moment in time in a pre-alpha Skyrim 
scene and then painted over it to visualise what we really 
wanted it to look like. This painting was originally designed to 
be video-captured, used as inspiration for, as well as part of, 
an internal sizzle reel for our company, then later released to 
the public for marketing.  

Concept
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Troll  Photoshop

Ray Lederer Concept artist

Learn how to paint a Skyrim scene using Photoshop tools with 
Ray’s easy-to-follow tutorial

Digital artists explain the 
techniques behind their 
amazing artwork
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ray lederer

Personal portfolio site
www.raylederer.com
Country USA
Software used Photoshop
Ray is a concept artist at 
Bethesda Game Studios in 
Rockville, Maryland USA. 
He began using Photoshop 
professionally in 1998 for his 
fi rst videogame job as a 
character modeller/texture 
artist/animator. Since then 
he’s learned to use 
Photoshop as an 
indispensable illustration 
tool for the entertainment 
industry, as well as books 
and other projects.

Build videogame 
concept art

http://www.raylederer.com
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Get started Sometimes in concept art you are asked to do a paint 
over, which if you haven’t guessed already is a painting over a pre-

existing image to further visualise an idea for the rest of the team. Photoshop is 
the perfect tool for this kind of work as it enables you to iterate on top of source 
images to create anything you like, without some of the headaches of having to 
start from scratch. 

Adjust the fi gure Painting 
on layers can be an essential 

method for composing an image. Don’t 
be afraid to use your Free Transform tool 
(Cmd/Ctrl+T) for quick adjustments to 
your fi gures. You can use the Lasso tool to 
select portions of pixels to move or rotate. 
You may also need to scale a hand that’s 
too big or a leg that’s at the wrong angle.

Block in forms Begin with your source image pasted on its own layer 
separate from the backdrop, leaving the Background layer neutral. Start 

roughing and blocking in your subject with your choice of brushes. Here we’re 
using a round brush set to 60-80% Edge Hardness with Opacity set to 80%. You 
can use the lighting in the scene to guide your tonal choices or come up with a 
new scheme.

Adjust the foreground character Don’t neglect certain tools 
for the sake of artistic purity, as you can bet da Vinci would’ve been all 

over these tools if he lived in our time. Experiment by roughing in quick studies 
of fi gures in separate layers to see what works. Use sloppy brushes to fi ll in large 
spaces and capture the energy of the pose.

01

03

02

04

Quick 
Tip

A general rule of thumb is 
that objects in shadow or 
intense brightness tend to 
lose defi nition and edges, so 
play with soft edges and low 
detail in the shadowed areas.

Lay the foundations
Block in forms and establish a base
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Commit to a shape Once you have 
gone through several iterations of fi gures, it’s 

time to decide which is going to work best. Now you 
can start lighting and detailing your fi gure. Create 
a new layer to paint on top of so you can make 
mistakes freely. It’s advisable to keep your layers 
minimal, as it’s easy to get lost and forget which 
layers have what information in them. Failing to 
organise layers will result in more maintenance and a 
prolonged painting process. 

Apply selections Select your canvas, 
hold Ctrl then press the left arrow key once. 

This will snap your selection around every pixel on 
that layer. It will also move everything over one pixel 
to the left. While still holding Ctrl, press the right arrow 
key once to return everything to its original position. 
Now you have just the pixels of that layer selected 
to do whatever you like with. This may sound 
complicated but after repeating the method you’ll 
quickly adapt.

Work out the details Now it’s time 
to become a leatherworker, armourer and 

seamster. We want to sell the world of Skyrim as a 
tangible experience for the player, so it’s time to start 
painting details. Once the basic forms are laid out 
you can start focusing on the details like studs, fur 
and engraved designs. Use a combination of hard 
round and chalk brushes with varying opacities and 
Edge Hardness settings. There’s no right way to do 
this, so just experiment.

06 07 08

Make loose sketches Try drawing your fi gure naked and then 
drape it with clothes. This will give you the topology to know where 

clothes fold and fall away from the body. Understanding anatomy is essential to 
achieving realism, especially if you’re working from your imagination. Try using 
Photoshop to display all of your reference images on a second monitor, so as 
to leave your primary monitor free to paint with. You can arrange your images 
separately or within a single layered fi le to maximise your workspace, without 
sacrifi cing space for tools.

05
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Begin unifying your values  Don’t worry about the extremes of your value and colour gamut 
yet. Let’s get your elements feeling like they’re occupying the same atmosphere and light, even if it’s 

not correct yet. You can use a variety of tools in Photoshop to achieve this. Cmd/Ctrl+L will bring up your Level 
graph, which is quite useful for crushing ranges of value into just a few manageable key values. You can also 
rein in hotspots and black shadows by using the Dodge & Burn tool (Cmd/Ctrl +O).

Take stock of your progress  
Spend some time looking at your image 

objectively. Write notes to yourself in a separate layer 
if there are areas in your picture that need addressing 
later. It’s easy for things to fall by the wayside if 
you’re not careful. Now it’s time to start painting your 
background on a single layer with simple hard round 
and soft round brushes.

Bring in colour  Create a new layer, 
fi ll (Shift+F5) a single tone to be your base 

atmosphere and set this to Multiply. This is why you 
want to keep your value range in the midtones, as 
if you stray too far out to the extremes, the Multiply 
setting will blow them out even further. The further 
you are away from a neutral value (50% grey) the 
more exponentially blown-out your values will be.

Paint details Get in tight and start 
fl eshing out details on the troll. Try to hint at 

blood vessels around the soft thin skin, particularly 
in the eyes and mouth. Using clipping masks, you 
can paint roughly around the edges and not worry, 
because you’re under painting will act as a mask.

Add tones to the fi gures Now it’s time to start colouring the fi gures. If you have crushed down 
the B/W paintings into single layers, you can use clipping masks to paint on top of your individual B/W 

layers. Clipping masks are extremely powerful and you can layer many of them on top of a single raster layer. If 
you’ve never tried it, simply create an empty layer above the layer you wish to paint on, Ctrl/right-click that layer 
and select Create Clipping Mask. Set your clipping mask layer to Multiply (or whatever suits your needs) and 
start painting on top of your B/W layer. 

09 10

11

1312

Build up the details
Add more features to your character concept
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Insert adjustment laye  You can 
use adjustment layers to affect any part of 

your Layer Hierarchy you like. Now can be a good 
time to place one on top of your layers and adjust 
with the sliders to balance your Hue, Saturation and 
Lightness. You’ll also need to bump your Saturation 
up to +20 or so. 

Chip away to refi ne There’s really 
no secret sauce here, it’s all about picking 

colours and chipping away at the image. Use a 
chalk-style brush for applying, pushing out fl inty 
shapes and contours like rivet highlights and seams. 
The way light catches those details in your image will 
help to sell the 3D effects.

Polish and tweak  Most of the hard 
work is done in the B/W value study, so now 

it’s time to enjoy tweaking and wrapping up. Use 
your adjustment layer to settle on what you feel is a 
well-balanced picture, then paint in your highlights 
and dark shadows on a separate layer on top of 
everything else.

Print ready  Sometimes it’s good 
to use a Gamma and Exposure 

adjustment to correct for printing or different 
temperature qualities on cheaper screens. Go to 
Image>Adjustments>Exposure and use the slider 
bars to correct as needed for whatever output 
you are targeting. You will fi nd that every printer is 
different but a general rule of thumb is to print the 
correct gamma right around 1.10-1.20. Bumping 
up the Exposure setting by around 20% can help 
increase the saturation without crushing your high-
value fi delity, but make sure to save multiple versions 
just in case.

Final touches  Now it’s time to commit. Flatten your image, copy and paste it onto a separate 
layer and paint any tweaks or experiments with Dodge & Burn for even higher-contrast highlights and 

shadows. This is also a great way to get even more subtle lighting cheaply onto your picture. You can paste a 
fl attened version of your image on top, then change its Hue/Saturation or any other values to create hotspots 
or focal points by erasing away pieces of the altered top layer.

14 15 16

18

17 Quick 
Tip

Flip your canvas often to check if your composition 
is working. If it feels balanced when reversed, it’s 
likely a good composition. You can set this up as a 
hotkey using Actions. Go to Window>Actions and 
create a new Action, press the Record icon at the 
bottom of the Action window, then open 
Image>Image Rotation>Flip Canvas Horizontal. 
Toggle the recording off by pressing the Stop 
button at the bottom of the Action window. Assign 
a hotkey to that action and you’re good to go.

Complete your concept
Add more features to your character concept

    
Crush the B/W paintings into single layers so you can 
use clipping masks to paint on top of your individual B/W 
layers. You can layer multiple clipping masks on top of a 
single raster layer. Create an empty layer above the layer 
you wish to paint on, Ctrl/right-click on that layer, select 
Create Clipping Mask and start painting on top of your 
B/W layer. You can treat your clipping mask like the layer 
beneath and it’ll mask any other layer you create.

Clipping masks 
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Dark Hoffman

Personal portfolio site
www.darkgrafi x.com
Country USA
Software used Vue Infi nite, 
Photoshop
Concept art, designing 
props, environments, matte 
paintings

Neverland  2013  Photoshop, Vue Infinite

Dark Hoffman Concept artist

Here we will look at how Vue and its various 
options can be used to create matte paintings for 
fi lm or TV

Build matte 
paintings
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Source files
available

I’ve used all different types of software for my digital 
matte paintings, but Vue is the go-to program that I use 
when I can’t fi nd the right landscape, mountains, skies 

or foliage. The image of Neverland is an 
iconic one used in fi lm, 
television and on the stage. 
The purpose of this exercise is 
to create a look for the island 
that can be used as a matte 
painting for a blockbuster or a 
TV series. First we will create 
the look of the island in Vue 
and then take it into 
Photoshop for post-
production work.

Concept
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Set up the building 
blocks To help with the 

render time and to work with the 
scene in an easier fashion, we will 
open a default scene before we 
add an atmosphere. In our scene 
we’ll start by bringing in a simple 
procedural terrain.

03

Design the layout
Establish the broad shapes of the new island

Create a new world The fi rst thing that is needed to create an 
environment is an idea. Usually the production designer gives the art team 

the proper artwork to show what the world looks like. Colour, layout and a theme 
are very important to start a matte painting. Also we are normally given a plate or a 
frame of the fi lm to start with, but sometimes we have to start from scratch, which 
is what we will be doing here in Vue. We’ll lay in terrains from the Vue Library and 
edit them so they represent islands and mountains.

01

Find reference To make an impressive island you need to know 
what it looks like in terms of shape, texture and colour. You also need to 

decide what the look of the environment is, which includes atmosphere, time of 
day and where the ice will be placed in the scene. In our case, the script calls for 
‘an overall aerial view of Neverland as we fl y towards it through the clouds. It’s a 
tropical-looking island with coves, waterfalls and a snow-covered mountain in the 
centre. Captain Hook’s ship sits silently in Cannibal Cove.’ We can start creating 
the terrains by bringing in set terrains from the Vue library. We will then start laying 
out the central mountain and background with the terrain tools.

02

To make an 
impressive 
island you 
need to know 
what it looks 
like in terms of 
shape, texture 
and colour
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Set the scene
Unlock the beauty of Vue’s evolution

Group the shapes With the structure of the rock built, hit the 
Hyperblob button. This will group your shapes and create a blobby 

shape, one that looks closer to an actual rock shape. Double-click the Material 
Editor and hit the Bump tab. Select the ball and another box will open, which 
offers options relating to which Bump map you can use. Here we’ll use Complex 
Sedimentary Layers, although you can try all the options if you wish. With your 
Bump map applied, change the scale so the arch appears larger and closer to 
the scale we need.

05

If there are certain areas that need to be populated with plants, you can just paint 
them in. Painting the fl ora will create a separate layer so it won’t be attached to the 
terrain. Hit the Eco Paint button and choose which plants you want to paint. You 
can change the size of the brush and the scale of the plants to suit. The brush 
paints directly on any areas of the terrain, no matter its shape. This is a great way to 
add exactly what you need, where you need it.

Painting with plants

Work with Hyperblobs The next stage in the new version of Vue 
is building with Hyperblobs and Hyperterrains. You can stack these in 

any formation and any confi guration of simple geometrical shapes and then 
simply select the Hyperblob tool. Pick the right Bump map and you have yourself 
a realistic-looking rock structure. Any material can be added for an even more 
photorealistic feel. You don’t have to follow this shape exactly to build the rocks, 
but make as close a match as you can.

04

Apply materials The centre of Neverland has a mountain with snow that goes down to 
grass and rock using a mixed material. You can play with which material you want to be used 

most. Here I made one island that I then used for various areas of the main island, meaning I didn’t 
have to populate the main terrain with an EcoSystem and slow down the render. I named this island 
‘Neverland Cove’ and saved it as a separate scene so when I need it, I can merge it into the main 
scene. Be sure to delete the Sun and ground that won’t be needed.

07

Shape the mountain Start adding terrain from 
the Terrain Library. When you’ve brought one into your 

scene, double-click the object and a new window will open 
where you can edit the terrain model. Click the left-hand buttons, 
jumping from dunes to mountains until you get a good shape. 
In the EcoSystem editor I also added three default plants – date 
palm (25% Presence) old eucalyptus tree (25% Presence) and a 
coconut tree (50% Presence).

06
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Include MetaWater and scenic beaches  
Adding an ocean is just a click away in Vue and editing it 

is now even easier. Essentially we want shoreline foam, so start 
by selecting a MetaWater with Foam. To add a beach, select a 
simple terrain and fl atten it, then add a sand material and make 
sure it comes through just enough to form a beach before sinking 
into the water. You can adjust how much of a beach you want, but 
in this example we just want the most sandy areas around the 
cove. Duplicate this and add it around the perimeter of the island 
where you want to see beaches and have them trail out into the 
ocean, so there’s some overlap. This may take a bit of adjusting, 
but the results are fantastic and will really help to sell the realism of 
the scene. 

08

The ocean and beach
Build up a tranquil ocean and a sandy shore

Add planets This is probably the easiest part of the 
process and a lot of fun. On the left of the interface, in the 

menu bar, you’ll fi nd a thumbnail of Saturn. This is the Planets 
button. Click it and a planet will be added into the sky automatically. 
To edit this, go to the top-right of the screen and you’ll fi nd a drop-
down menu from which to choose the planet you want, as well as its 
phase, colour and brightness.

09

Render time Now we’re into the fi nal stage of the Vue 
process. To keep the render time down to a minimum, turn 

off anything you don’t really need, as well as anything that can be 
completed in post-production using Photoshop. Try to maintain a 
good balance between keeping render times down, while hanging 
on  to everything you need.

10
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Add Hook’s ship For the pirate ship I added a model 
of The Golden Hind from Poser. You can use any ship from 

Cornucopia 3D or Poser, or any 3D model you have access to. 
I brought it in with textures and baked it, so it was compressed, 
then placed it in the cove. This is the only element in the scene that 
wasn’t created in Vue. It can also be added later with Photoshop.

Take the image into Photoshop Now you can bring in the image rendered 
out from Vue and do some retouching in Photoshop. First let’s play with the levels to 

bring some of the blacks in and help with the contrast. Desaturate the image a little, about 25%, 
then add a bit of colour back, mainly the blues. Following this, add a dark vignette around the 
image to add some depth and make it feel like it’s out in another universe. All this will help sell the 
fantasy element of your image.

Final details For the fi nal touches I added foam 
around the shores, as well as little waves. Vue can add 

these to the scene for you, but since our camera angle is so high it 
would be hard to see. I also added some small waterfalls around 
the island as a nice fi nishing touch. There you have it: a realistic 
image of Neverland.

Place more elements Since we can see planets 
surrounding the island, we also need stars in the sky, 

which will be refl ected in the ocean. I have a personal collection of 
starfi elds, but you can grab plenty for free online or paint them in 
yourself. I recommend you download a few and try them out. Pop 
them in the fi le and screen, then add a layer mask and paint out any 
stars over the island and the planets.

11 12

14

13
creation time

Resolution:
5,500 x 3,700

40 hours

Final touches
Input the fi nishing elements and move to post-production
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I draw some mech sketches, giving them a Western look, sometimes even 
pursuing a direction I didn’t have in mind initially

The fi rst thing I always ask myself 
when creating a sci-fi  illustration is 
how I can make this stand out from 

the other work that’s out there. Mixing two 
themes is a great way to create something familiar 
but unique at the same time. For this sci-fi  
illustration I’m going to add robot mechs to the 
Wild West. Both of these genres are popular at 
the moment and both have strong good-versus-
evil narratives.

When I think about Western movies, the classic 
scene where the good and the bad (and 
occasionally the ugly) face each other before they 
pull out their guns comes to mind, with plenty of 
tension and expectation. But another inspiration 
for this piece comes from the classic sci-fi  scenes 
of giant robots fi ghting or a huge creature 
attacking a city – think of Transformers, Godzilla 
or Thor versus The Destroyer. 

I have three main elements then; the hero, the 
villain and the town where the action takes place. 
First I paint thumbnails in Photoshop to explore 
different compositions. During the development 

Composition studies are sometimes drawn as just linework, but I fi nd that using values 
makes them easier to read

process, my hero goes from a human or a cyborg 
to another big mech controlled by a human 
inside, and the enemy appears in different sizes, 
too, with the bigger version more intimidating. 
There are different possible moments of action 
and storyline here. Did the attack over the town 
start fi rst, so we can see people running away? 
Or are the two robots fi ghting and the town’s just 
unlucky enough to be in their way? I prefer a 
deserted street anticipating the action as this 
creates more tension so the viewer can imagine 
what is going to happen later.

Once I know what I want for the illustration I 
start the research for the mechs. I know I don’t 
want anything too stylised with curves or organic 
shapes, as I want to keep them a big mass of 
metal with straight shapes and old, rough 
textures. To understand the functional part of the 
robots, it is very important to look at the real world. 
Segmented insects or other animals can provide 
great references for the way robots and imagined 
machines might move. A spider excavator, for 
example, is a fantastic reference. I also take a look 

at the book Mechanika by Doug Chiang, one of 
my favourites for this subject. 

Looking at how other designers solved 
problems like joints and weapon integration is 
useful as well. Classic Japanese mechs are a big 
inspiration for this particular piece, but they have a 
very unique style so I also look at mechs from the 
West to make sure my image has a unique twist. 

For the fi nal illustration I start the sketch by 
looking at my favourite composition thumbnails. 
To add more dynamism, my composition has a 
rotated horizon so the verticals are rotated too. I 
keep the grid on a layer to check it if necessary 
and I even rotate the image to bring it back to 
horizontal if I fi nd the angle of my composition too 
awkward to draw something correctly or in a way 
that’s comfortable. I then quickly add some more 
values at this stage too.

For the hero design I go with a light body, 
humanoid on top but with an animal aspect to the 
legs to make it more interesting and robotic. I add 
the holster for the gun on the right leg. For the 
head I draw a shape to remind the viewer of a 

Design robot mechs
Tex Mechs  2012 Photoshop

Israel A Carrion Illustrator

 Israel A Carrion paints a sci-fi  mech illustration, taking inspiration 
from classic Western movies
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Digital artists explain the 
techniques behind their 
amazing artwork

A
rt

is
t i

n
fo

Israel A Carrion

Personal portfolio site
www.isrartistic.com
Country Barcelona
Software used Photoshop
I live in Barcelona but 
frequently work for 
companies in other 
countries, specialising as a 
concept artist for the 
entertainment industry or as 
an illustrator telling stories 
through my work.
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cowboy hat. I place its legs on either side of some 
houses to give a sense of proportion and scale. 
Showing a mech alongside humans and 
human-sized structures instantly shows the viewer 
how big it is, making it even more impressive and 
intimidating.

The design of the enemy is harder; it has more 
prominence so it must be even more visually 
interesting and lead the viewer’s eye up to his 
head. At fi rst I think a robot with a scorpion look 
would be cool, to represent the desert and totally 
contrast with the hero, using a big cannon on the 
tail to shoot. But the sketch doesn’t convince me 
so I go for a four-legged, two-armed robot 
holding a giant Gatling gun. 

I start colouring the background on a new layer. 
To emphasise the drama I set the scene just 
before sunset with the warm colours of twilight, 
really bringing out the Wild West landscape. 
Monument Valley in Colorado is a good reference 
for this. The colour variation in the sky is 
challenging, but I can use a very common 
custom brush to paint in the clouds. I add a big 
moon to give a sci-fi  look. 

I can now add the main colours to the rest of 
the piece with Color or Overlay layers, then 
continue painting on normal layers. I paint with a 
Charcoal, a Chalk and a ragged custom brush 90 
per cent of the time. The Size Jitter is set to Pen 
Pressure for the Charcoal variant, but for the other 
two it’s set to Opacity Jitter. 

I use 10-20 layers and frequently merge them 
as this keeps my workfl ow organised and also 
keeps the fi le size down, but complex pieces like 
this can require me to use quite a lot at one time.

I paint the mech in the foreground mainly with 
red and add some colour variation with warm 
hues keeping the values dark to give it impact. 
For the town environment, fi rst I paint the basic 
shapes of the buildings and then add some 
textures of wood on Overlay layers and desaturate 

them if necessary. Then I add another one for the 
road. Make sure the textures match the 
perspective by using the Transform tool to warp 
them into place. The design of the town is fairly 
standardised, based on my research of real 
Western towns, to avoid distracting the viewer 
from the two mechs. The cast shadows and the 
values over the walls are very important here to 
get the mood of the piece right. 

Then I work on the giant mech. The process 
here is similar to the hero’s mech, but this design 
is more complex. As I work it up I add some fog 
and use lighter values to give a sense of depth. 
The light source is on the right of the scene so, 
with Overlay and Color Dodge layers, I highlight 
the right side of the mechs, especially the faces, 
arms and weapons, because those are the focal 
points. After a break to refresh my eyes, I notice 
the big robot’s silhouette is not interesting enough. 

This is the sketch with values, before adding colours 
giving the structure and distribution of tones

Israel A Carrion’s shows 
us his other masterpieces

Living Statues, Fighting Statues
2012, Photoshop

 An illustration for a Crimson Daggers 
challenge with ‘living statues’ as the theme. I love 
the statues you fi nd in Asian temples so I painted 
a little fantasy story with the main creature being 
a hybrid inspired by these. 

City Attack
2012, Photoshop

 This environment design was painted for a 
course instructed by James Paick. Sci-fi  is one of 
my favourite subjects and adding some 
storytelling with the huge creature made it an 
even more fun process.

Goldilocks
2011, Photoshop

 I made my own version of the tale of the three 
bears set in the future with robot bears and an 
adult Goldilocks. This painting is going to be 
included in an art book featuring Spanish artists.

I want my mechs to look worn out as if they were 
built from scraps of old metal found in the desert 
long ago. If you don’t feel comfortable painting a 
specifi c surface, you can make studies from the 
real world. I paint with dirt and rust brushes in 
desaturated colours on an Overlay layer. The metal 
should shine where the light hits, so I paint on a 
Color Dodge, Overlay or a Curves adjustment 
layer. I use a soft brush for large areas and a hard 
brush for tiny highlights. I paint some scratches on 
a Normal layer and add the last details.

Create metallic effects and paint 
realistic surfaces

It’s good to be open to changes in your work so if 
there is something wrong or something you don’t like 
you can just redo it
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I keep adapting the big villain robot, 
looking for a bigger and more dynamic 
design. It’s always good to be fl exible

To add more depth, I paint in fog or smoke (with a 
cloud brush or soft brush) between the objects in the 
distance

The shotgun on the left shoulder emphasises 
the vertical lines in my composition, but I 
lighten the values so I don’t distract the 
viewer with such a strong shape

Develop 
the body

How to render the larger 
mech, from sketch to 
detailing

01 Rough sketch First I draw a rough 
sketch to defi ne the basic lines of 

the robot. If I have problems drawing in this 
perspective I rotate the image.

Add details In this sketch I use lines 
again to draw the new shapes and start 

adding design elements. It is exactly the same 
process for the gun.

Block colours I paint the very 
basic shapes over the lines; it gives a 

3D aspect when working with cubes. I clean 
the contours and erase outlines.

Push the design I look at old 
locomotives and include iconic 

elements like the cylindrical shape and the 
lights. I add the cables to create scale.

04

03

02

It’s too static, so I start thinking logically about it 
and how I can improve him. He is holding a huge 
Gatling gun that looks hard to reload once it is out 
of ammo, so what will he do with such a big, 
useless thing? It’s good to be open to changes in 
your work so if there is something wrong or 
something you don’t like you can just redo it!

I draw a new sketch over the big robot, change 
the pose to give it a more interesting silhouette 
and integrate the Gatling onto the arm, which is a 
common design in sci-fi  pieces, but works better. 
With the right arm I balance the contrast for the 
heavy weapon, and now the four legs are more 
visible. One of the reasons I failed with the 
previous version is because I was too concerned 
with the strict perspective. Now I try to be more 
fl exible and go with what looks best. I pick the 
colours from the previous mech and keep 
painting with my three most-used brushes on just 
a couple of layers.

I add textures to both mechs using custom 
brushes I have created for dirt and rust. For me 
the best way to do this is to paint sporadically 
here and there without fear on a new Overlay 
layer, then add a mask, invert it and paint with my 
Charcoal brush on the areas where I want the 
texture to be added.

To fi nish the design of the mechs, I add a few 
more elements to give a sense of scale and detail, 
like labels and stickers on a new Overlay layer. It is 
important to keep the worn-out look to tie in with 
the overall theme and really nail the concept.

With the design fi nished, I work on the sense of 
depth and atmosphere. I make a Levels 
adjustment on the big robot to lower the contrast, 
add more fog between the different elements on 
the sky and the road and add a few more 
highlights with a Curves adjustment and a Color 
Dodge layer. 

To give a greater sense of depth, mood and scale, the 
robot needs to be lighter. Use the Navigator and a 
Saturation layer fi lled with black

In order to understand how to build a robot 
and make it functional, it’s good to think in 
the most basic shapes – cubes, cylinders 
and spheres. 

Once it works you can add designs to 
those shapes. Action fi gures or model kits 
can be helpful, too, as they can help you to 
understand how they are articulated.

Make it work
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